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Important Safety Instructions 

Warning 

Exposure to excessive sound pressure levels can lead to 
impaired hearing and cause damage to the ear. 

Please read and observe ALL of the following notes: 

 Check all of the hardware devices for transport damage.  

 Any devices showing signs of mechanical damage or 
damage from the spillage of liquids MUST NOT be 
connected to the mains supply or disconnected from the 
mains immediately by pulling out the power lead. 

 All devices MUST be grounded. Grounding connectors 

are provided on all devices. In addition, all low-voltage 
devices external to the system must also be grounded 
before operation. 

 For Scandinavian countries, ALWAYS use a grounded 

mains connection, to prevent the device from being 
grounded through Ethernet or other signal connections. 

 All devices MUST be connected to the mains using the 

three-cord power leads supplied with the system. Only 
supply electrical interfaces with the voltages and signals 
described in these instructions. 

 Do NOT use the system at extreme temperatures. 

Proper operation can only be guaranteed between 

temperatures of 10 C and 35 C and a maximum 
relative humidity of 85%. 

 Neutrik PowerCon and Harting connectors must NOT be 

disconnected under load. 

 Only service staff may replace batteries. 

 Servicing of components inside a device MUST only be 

carried out by qualified service personnel according to 
the following guidelines: 

o Before removing parts of the casing, shields, etc. the 
device MUST be switched off and disconnected from 
all mains. 

o Before opening a device, the power supply capacitor 
MUST be discharged with a suitable resistor. 

o Components that carry heavy electrical loads, such 
as power transistors and resistors, should NOT be 

touched until cool to avoid burns. 
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 Servicing unprotected powered devices may only be 
carried out by qualified service personnel at their own 
risk. The following instructions MUST be observed: 

o NEVER touch bare wires or circuitry. 

o Use insulated tools ONLY. 

o DO NOT touch metal semi-conductor casings as they 
can bear high voltages. 

Defective Parts/Modules 

Warning 

The control surface panels, and individual card components 
contain no user-serviceable parts. Therefore do not open the 
devices other than to perform the procedures described in this 
manual. 

In the event of a hardware defect, please send the system 
component to your local service representative together with a 
detailed description of the fault. We would also like to remind 
you to please check carefully whether the failure is caused by 
erroneous configuration, operation or connection before 
sending parts for repair. We recommend contacting our service 
department before sending parts for repair. 

First Aid (in the case of electric shock): 

Warning 

 DO NOT touch the person or his/her clothing before 

power is turned off, otherwise you risk sustaining an 
electric shock yourself. 

 Separate the person as quickly as possible from the 
electric power source as follows: 

o Switch off the equipment. 

o Unplug or disconnect the mains cable. 

o Move the person away from the power source by 
using dry insulating material (such as wood or 
plastic). 

 If the person is unconscious: 

o Check their pulse and reanimate if their respiration is 
poor. 

o Lay the body down and turn it to one side. Call for a 
doctor immediately. 

 Having sustained an electric shock, ALWAYS consult a 

doctor. 
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About This Manual 

How To Use This Manual 

This manual covers the hardware installation, servicing and 
software configuration of Lawo‟s MKII mc266 mixing console. 

Before reading this manual, it is strongly recommended that you 
review the mc266 Operator‟s Manual for an overview of console 
operation.  

Chapter 1 introduces the technical components of the system 
with an overview of the HD Core, DALLIS and Console control 
surface.  

Chapter 2 covers installation of the hardware. 

In Chapter 3 you can learn about the AdminHD software which 
is used to configure, control and diagnose HD Core systems. 

Chapter 4 covers system servicing, including details on 
servicing hardware components and software diagnostics tools. 
At the end of the chapter you will also find a Trouble Shooting 
section to help fault find any problems. 

Use the Table of Contents at the beginning of the manual or 
Index Directory (Page 300) to locate help on a particular topic. 
Appendices, Technical data, a Glossary of terms and the Index 
Directory are provided at the end of the manual. 

Note that further technical data may be found in the Lawo Data 
Sheets produced for each hardware component. These contain 
a full specification for the component: dimensions, weight, 
power, spare parts, etc. To help locate the relevant data sheet, 
you will find a list of part numbers for the principle system 
components in Appendices A, B and C. 

You can also access more information by registering on the 
Lawo website at http://www.lawo.de. By registering you will be 
kept up to date with the latest news and releases for your 
product. You can also download software updates and 
documentation. 
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Conventions 

Throughout this manual we will be using a number of 
conventions: 

Topics 

Every new topic or subtopic is clearly identified in large, bold 
font. 

Specific procedures are written as a sequence of numbered 
instructions which guide you through the task. The result of the 
operation is written in italic letters giving you the chance to 
identify errors at an early stage. For example: 

 Replacing a Power Supply Unit 

1. On the rear of the DALLIS, disconnect the mains from 
either the PSU 1 or PSU 2 IEC mains connector as 
appropriate: 

2. Unfasten the two screws on the right hand side of the 
hinged PSU cage door. 

The door will swing open providing access to the PSU docking 
bays. 

3. Remove the relevant power supply unit and replace with 
the spare. 

4. Replace the cage door and fasten the two screws. 

5. Re-apply the mains to the PSU IEC mains connector. 
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Marginal notes  

The following marginal symbols are used to draw your attention 
to: 

 

User Tips – useful tips and short cuts. 

 

Notes - useful points or cross references which apply to an 
operation. 

 

Warning 

Warnings – alert you when an action should always be 
observed. 

Software Functions 

When working with the AdminHD software application on your 
computer, windows are referred to inside single quotation 
marks, while actions are written in bold. In addition assume that 
you use the left mouse button to click or select a button/menu 
option unless otherwise stated – for example, to view the „Core 
Browser‟ window, click on Window from the main menu bar 
and select Core Browser from the drop-down menus. 
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Chapter 1: System Overview 

Introduction 

This chapter introduces the technical components of the MKII 
mc266 mixing console with an overview of the principal 

hardware components.  

Hardware Overview 

The system consists of three principal components:  

 Console control surface - operator interface. 

 HD Core – DSP/routing matrix core with integrated 

control system. 

 DALLIS I/O interfaces – offering a range of input and 

output cards which may be connected remotely to the 
system (up to 2km from the core using multimode fibre 
or 8km using single mode fibre). 

The exact hardware specification of your system will define how 
many analogue and digital connections are available for 
external equipment, and how much DSP processing is available 
for input channels, monitor return channels, groups, sums (main 
mix outputs) and auxiliary sends.  
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Console Control Surface 

The mc266‟s control surface is constructed in 8-fader sections, 
with sizes scaling from 16 channel faders + 8 masters up to 96 
channel faders + 8 masters. The example below is a 16+8+16 
configuration: 

Within each channel section, you will find 8 dedicated fader 
strips providing level, mute and AFL/PFL monitoring. Four 
assignable rotary controllers (free controls) offer additional local 
channel control to adjust EQ, Dynamics, auxiliary sends, etc. 
The lower free control (FC4) may be switched to control level 
and mute for the second layer of channels. A fifth upper 
controller is dedicated for input gain. In addition, every 8-fader 
channel section houses a high resolution TFT display providing 
feedback on channel metering and bus assignments. 

The centre section houses the central control screen with space 
on the right of the overbridge for external metering (optional). 
Around and below the control-screen, the Central Control 
Section offers direct control of all settings for the selected DSP 

channel – input control, equalisation, dynamics processing, 
panning, auxiliary sends, etc.  

On the right is the Monitoring touch-screen with source 
selection, level control and other monitoring functions. The area 
below offers space for up to 3 user panels. Options include 
Dynamic Automation Control, Machine Control and a range of 
User Button or Intercom panels.  

At the bottom of the centre section are 8 main fader strips ideal 
for master VCAs, groups, etc. And on the right, a range of 
controls for bus and fader strip assignment, layering access, 
joystick panning and SCREEN CONTROL navigation. 

 

 

  

Monitoring touch-screen 

  

Access/Assign and Screen Control 
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Console Power Supply 

The control surface power is provided by an external PSU. As a 
result there are no fans within the control surface. 

The external power supply unit is normally sited within the same 
19” rack as the HD Core: 

The maximum cable run from the surface is 10m. 

The PSU has two mains supply terminals at the rear. It is 
recommended that each terminal be connected to a different 
phase to realise phase redundancy. 

Internally, the PSU is equipped with three power supplies 
running in parallel. For correct operation, only two supplies are 
required; the third is for redundancy.  

For more details on installing or servicing the console and its 
power supply, see Chapters 2 and 4.  
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HD Core 

The HD Core forms the central routing matrix for the system 
and, within the mc266, contains the DSP for the console‟s 
signal processing.  

The core is a 10RU, 19” rack mounted unit designed with 
modular card slots and dual redundant power supplies. All 
modules are hot-pluggable.  

Front 

The front of the frame houses the: 

 Router Module (MKII) - two central slots are available 

for a main and redundant Router Module. The Router 
Module (MKII) contains the router and console Control 
System. Two TCP/IP Ethernet ports are provided: port A 
connects to the control surface; port B can be used to 
connect a network or external PC for configuration, 
maintenance or remote control. 

 I/O and DSP Modules - 16 slots, 8 either side of the 

Router modules, are available for plug-in I/O or DSP 
modules. I/O options include AES/EBU, MADI and ATM. 
Further formats can be realised by connecting MADI or 
ATM to remote DALLIS or 3rd party I/O interfaces. 

 Power Supply Units - 2 slots are available for main and 

redundant power supply units. 

Rear 

The rear of the frame houses the: 

 Synchronisation Ports -  accepting: 

o Word clock 

o AES/EBU (AES3-id) 

o Video Black Burst - PAL or NTSC. 

 Alarm and control contacts – including the global 

alarm. 

 AES3 breakout panels – up to 8 connector panels 

(depending on the format – D-Sub or BNC) may be fitted 
for direct access to front mounted AES3 module signals. 

 5 cooling fans - hot-pluggable and easily accessible 
from the rear of the frame. 
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The Router Module (MKII) 

The MKII Router Module (980/33) contains the summing matrix 
for the HD Core and console Control System. Every HD Core 
must be fitted with a main Router Module. A second module 
may be fitted for redundancy. 

The Router Module defines the capacity of the routing matrix: 

 980/33 - 8k2 capacity router offering 8192 x 8192 matrix 

crosspoints (at 48kHz). 

Note that when running at 96kHz, the system uses twice as 
much resource as lower sample rates, therefore the capacity of 
the router is halved. See Page 22 for more details. 

The Control System controls the functionality of the entire 
system. It runs on an embedded Linux operating system for 
speed and increased reliability. For increased security, two 
compact flash cards are used to store the application software 
and user data separately enabling system recovery from data 
corruption. 

All system connections, other than sync, are made to and from 
the Router Module via Ethernet (TCP/IP): 

 Ethernet A – connects to the mc256 control surface.  

 Ethernet B – can be used to connect to a larger system 

network or external PC for configuration, maintenance or 
remote control. 

For a quick reference guide to all the connections and LEDs on 
the Router Module, please see Page 34. 
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HD Core Module Options 

16 slots, 8 either side of the main and redundant Router 
modules, are available for plug-in I/O or DSP modules: 

 AES/EBU (AES3) – providing AES inputs and outputs 

directly from the core saving valuable space within the 
installation. Input and output D-Sub or BNC connections 
are directly accessible from the rear of the core. 

 MADI (AES10) – front connections to external 

equipment or DALLIS I/O interfaces. A range of module 
options are available offering different numbers of ports 
and multimode or single mode fibre. 

 ATM – front connections to external equipment or 

DALLIS I/O interfaces. A range of module options are 
available offering different numbers of ports. 

 DSP – up to 8 DSP boards may be fitted providing DSP 

resources for the mc266 console, and/or the routing 
system. 

Further I/O formats can be realised by connecting MADI or ATM 
to remote DALLIS or 3rd party I/O interfaces. 

All plug-in modules are hot-pluggable enabling individual I/O 
modules to be replaced without affecting other aspects of the 
system. Each module includes an ACTIVE LED to help identify 
any faults. 

For details on HD Core module options, see Appendix A. For 
details on installing or servicing the HD Core, see Chapters 2 
and 4.  
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DALLIS 

To expand the I/O of the system and create remote I/O 
breakout units, the system utilises Lawo‟s DALLIS (Digital And 
Line Level Interface): 

Each DALLIS may be either 3RU (shown above) or 6RU in 
height and provides up to 60 (MADI) or 80 (ATM) channels of 
audio. Each unit houses: 

 DALLIS I/O cards – up to 18 slots are available for 

Lawo‟s tried and tested DALLIS interfacing system 
offering a range of input and output cards for connection 
to external equipment. 

 DALLIS Master Board – 2 slots are available for a main 

and redundant master board. There are different master 
board options providing single fibre or redundant fibre 
MADI or ATM connections to the HD Core. Also within 
the master board, is an amount of DSP. This may be 
utilised for additional DSP resources such as matrix 
summing within a Nova 73. 

As for the HD core, all cards are hot plug-able, with the 
exception of Phantom Power; and each unit can be fitted with 
redundant power supplies. 

Please note that the maximum analogue level of the whole 
system is defined by the DALLIS card with the lowest GDA 
(General Device Address) – this is the DALLIS card with the 
lowest address fitted to the DALLIS frame connected to the 
lowest port number of the first HD Core. Consult the Operator‟s 
Manual for more details on operating levels. 
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Front 

The 19” rack mounted DALLIS frame is available in 3RU or 
6RU heights, each of which may house up to 18 I/O cards (Slot 
1-18) plus main and redundant DALLIS master boards (Slot M1 
and M2): 

Within a 3RU frame, shown above, 18 single width card slots 
are available. Double width I/O cards (8GU) occupy two slots; 
single width I/O cards (4GU) occupy one slot. 

Within a 6RU frame, shown below, 18 double width card slots 
are available plus a dedicated slot for phantom power. Double 
width I/O cards (8GU) occupy the whole slot; single width I/O 
cards (4GU) must be fitted on the left of the slot and a dummy 
plate fitted to the right to close the gap. 

All available plug-in cards may be used in both frames. 
However, for systems using large numbers of double width 
cards (8GU), you will achieve a greater I/O capacity from a 6RU 
frame. 
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Rear 

The rear of the frame provides access to power and alarm 
connectors: 

1 PSU 1 

IEC Power 
Connector 

Main power supply unit fitted as standard 
on all systems.  

2 PSU 2 

IEC Power 
Connector 

Redundant power supply unit (optional). 

3 CASE 

Grounding 
Screw 

Use the M4 screw to ground the DALLIS 
Unit. The DALLIS must be on the same 
potential as all other system devices. 

4 ALARM 
FORCE M2 

15-pin D-Sub connector – carrying the 
global alarm signal. (The Force M2 signal 
is unused within mc266 or Nova 73 
systems, and is included for compatibility 
with Lawo‟s zirkon or Nova17 systems). 

5 FORCE M2 BNC connector – unused within mc266 or 
Nova 73 systems. 

6  ALARM BNC connector carrying the global alarm 
signal. 
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DALLIS I/O Interfaces 

A wide range of I/O plug-in cards are available for connecting to 
external audio equipment including the following options: 

 Analogue Mic/Line, electronically or transformer 
balanced 

 Analogue Line In/Output, electronically or transformer 
balanced 

 AES - inputs with switchable SRC; outputs optionally 
with SRC. 

 HD/SD SDI (audio embedder/de-embedder). 
Embedding/de-embedding of 1 or 2 groups, 4 channels 
each. Controllable delay up to 240ms. HD formats are 
supported. 

 GPI (opto-coupler, VCA-inputs and relays) 

 Data transfer RS422, RS232, MIDI 

 Intercom (BNC) for Riedel Artist connection 

 ADAT 

 TDIF (with external MADI converter). 

All plug-in cards are hot-pluggable enabling individual I/O cards 
to be replaced without affecting other aspects of the system. 
Each card includes an ACTIVE LED to help identify any faults. 

For more details on DALLIS card options, see Appendix C. 

For details on installing or servicing a DALLIS, see Chapters 2 
and 4.  
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Configuration: AdminHD 

In addition to physical components, every mc266 system 
requires a system configuration.  

The configuration is an essential part of the system as it is this 
which defines the hardware and sets default parameters. If a 
hardware component is not defined within the configuration, 
then it will not be visible to users even if it is powered and 
connected. In other words, the configuration is always the 
„master‟ of the system, regardless of what physical components 
are added or removed. 

Configuration files are created offline as follows: 

 Console Control Surface – due to the flexibility of the 

66‟s control surface, this part of the system is factory 
configured. 

 HD CORE and DALLIS – these components are 

configured using a software application called 
AdminHD. Once programmed, the configuration can be 
uploaded to the console‟s Control System, via Ethernet, 
where it is stored within the Control System (on the 
Router Module). 

AdminHD is used when a system is first installed to configure 
the cards and settings within the HD Core and DALLIS I/O 
units. It can also be used at any time to update the system. For 
example, if a DALLIS Stagebox is hired in for a production, then 
the unit can be added to the configuration.  

In addition to configuration, AdminHD may run online to control 
matrix cross points, adjust signal labels or I/O parameters. For 
example, you could use AdminHD to control the mic preamp 
gain on a mic input within a DALLIS Stagebox. You can also 
reset connections and I/O parameters by saving and loading 
snapshots from your computer. 

Finally, AdminHD provides a number of useful tools for system 
diagnostics and documentation. 

For more details on AdminHD please refer to Chapter 3. 
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Offline Setup/Remote Control (mxGUI) 

Lawo‟s mxGUI (Matrix GUI) is a software programme which 
can run the mc2 graphical user interface on an external 
computer. The programme may be run either on or offline with 
any mc2 system (mc256, mc266, mc290) or Nova73 to provide: 

 Offline Setup - mxGUI allows you to prepare mc2 

settings ahead of an event. Productions, Presets and 
Custom Function assignments can be stored on your 
mxGUI computer and then transferred to the console at 
a later date; thus saving valuable setup time before a 
show. 

 Remote Operation - mxGUI can run online by 

connecting to the mc2 Control System via its control 
network (Ethernet). This may be used to provide 
additional screen displays, or remote operation for a 
second engineer. 

Whereas AdminHD is used to prepare the system configuration, 
mxGUI is an operational tool which can prepare Productions 
(including snapshots or automation mixes), Presets and 
Custom Function Assignments.  

If you wish to prepare a complete system ahead of an event, 
then you can connect AdminHD to mxGUI. This allows you to 
configure the system hardware using AdminHD, transfer the 
configuration files to an mxGUI, and then prepare console 
settings within an mxGUI production. 

For more details on mxGUI, please refer to the “mc266 
Operator‟s Manual”. For information on connecting AdminHD to 
mxGUI, see Chapter 3. 
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Internal Sample Rate 

The mc266 may operate at a choice of internal sampling rates 
including 96kHz, 88.2kHz, 48kHz and 44.1kHz.  

The option to run at higher (96kHz or 88.2kHz) or lower (48kHz 
or 44.1kHz) sample rates is defined within the system‟s 
AdminHD configuration. There are 2 different options available: 

 HD Core 8k (48kHz) - 8k capacity router operating at 

sampling frequencies up to 48kHz. 

 HD Core 4k (96kHz) – 4k capacity router operating at 

sampling frequencies up to 96kHz. 

Note that having defined the maximum sampling frequency, it 
may be adjusted, for example to 44.1kHz, from the console‟s 
System Settings display: 

For more details on configuring lower or higher sample rate 
operation, see Chapter 3: AdminHD. 

For details on changing the sample rate from the console‟s 
System Settings display, please refer to the mc266 Operator‟s 
Manual. 
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System Clock 

The HD Core offers a fully redundant clock source structure 
with two independent clock inputs, an internal sync generator 
and the ability to lock to sync from an incoming multi-channel 
signal. This allows the console to be clocked from a variety of 
sync sources and recover from loss of external sync.  

The sync source selection is defined from the console‟s 
System Settings display: 

Here you can define a main clock source (Source Priority 1) 
and a redundant one (Source Priority 2) from any of the 
following options: 

 Input 1 – HD Core Sync Input 1 (Wordclock, Video or 

AES3) 

 Input 2 – HD Core Sync Input 2 (Wordclock, Video or 

AES3) 

 Multichannel Sync - ATM or MADI as defined within 

the system configuration using AdminHD. 

If sync is lost or a signal of an incorrect frequency appears on 
Source Priority 1, the system automatically switches to Source 
Priority 2. Similarly, if sync is lost on Source 2, the system 
automatically switches to internal sync.  

In addition, you can activate the Return Mode option so that 
the system will switch back to Source Priority 1 sync when it 
returns. The system even checks whether the return sync is 
valid and will not switch until the sync source matches the 
chosen operating frequency of the console. 

For more details on Sync, please see Chapter 2: Installation.  
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Redundancy 

One of the strengths of the mc266 system is its ability to 
withstand component failures, and every component is 
designed with fault tolerance in mind. 

Star
2
 Technology 

All components within the system utilise Lawo‟s Star2 
technology: 

 Point-to-point connections – with point-to-point 

connections, a fault will only affect that part of the 
system, unlike a TDM bus architecture where a fault 
may disrupt everything connected to the bus!  

 Dual star topology – with redundant Router Modules 

fitted to the HD Core, and redundant Master Boards in 
every DALLIS, then components connect in a dual „star‟ 
mode. This protects signal paths from any single point-
of-failure. All I/O Modules/Cards connect to both main 
and redundant boards simultaneously. In the event of a 
failure, the system automatically switches to the 
redundant path.  

 Hot-swappable Modules/Cards – every plug-in card or 

module can be hot-swapped without affecting the rest of 
the system enabling online maintenance of the system. 

 Redundant Power Supply Units – both HD Core and 

DALLIS units can be fitted with dual redundant power 
supplies which can be isolated and exchanged from the 
front or rear.  

 Passive backplanes – the frame backplanes are 

entirely passive. With no active components, this 
increases reliability. 
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Redundant Router Module/DALLIS Master 
Board 

When fitted, you will see the status of the redundant Router 
Module or DALLIS Master Board on its front panel. The spare 
board is shown in Standby. 

In the unlikely event of a failure, the system automatically 
switches all routes from the faulty board to the spare; the faulty 
board may then be safely removed and replaced. The replaced 
board will now act as a spare until further action is taken. 

You can force a module takeover manually from the front panel 
by pressing the Module Takeover depressed button. 

Note that a brief interruption to audio will occur while routes are 
reconfigured. When you switch to the redundant Router Module, 
you also switch to the redundant Control System. 

Fibre Redundancy and Port Redundancy 

For crucial interconnections between DALLIS and HD Core 
units, you can specify: 

 Fibre Redundancy – two fibre connections are made 

between the DALLIS and HD Core to provide a main 
and redundant fibre link. 

 Port Redundancy - alternatively, you can specify port 

redundancy, where the main and redundant fibre links 
from the DALLIS connect to a different port (preferably 
on a different Module) within the HD Core: 

Port redundancy enables the system to recover from an error 
with the master board of the interface system, a defective fibre 
link, or a failure of the HD core interface card. The system will 
switch automatically to the redundant signal path if there is a: 

 Malfunction of the HD Core Module (or port). 

 Failure of the active fibre link. 

 Malfunction of the active DALLIS master board. 
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Control System 

The console‟s Control System is integrated within the MKII 
Router Module of the HD Core. This means that the console 
surface may be powered off without loss of user data or audio! 
This is also where all user and system data are stored. 

Following switch-off, power is provided to the Control System 
for a further 18 seconds in order to save all current settings to 
flash memory. This is called the console‟s warm start data. You 
will hear eight tones signaling that the shutdown operation has 
been successfully completed. The system is shutdown when 
the blue LED of the trackball is off. This warm start data is 
automatically loaded when the system restarts. 

Note that the Router Module MKII also contains a backup 
power unit which provides up to 3 seconds of backup power to 
deal with short interruptions to mains (AC) power. 

Data Recovery 

To increase the fault tolerance of the system, the mc266 
includes the ability to recover from corrupted data.  

Within the Control System, two flash cards are used to store the 
system‟s application software (System Flashcard) and user 

data including AdminHD configuration, warm start data and 
productions (Data Flashcard): 

As the console‟s application software is stored separately from 
the user data, this allows you to boot the system without loading 
user data if there seems to be an error with the stored 
production, configuration or warm start data.  

For more details, see Chapter 4: Service and Maintenance. 
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Control System Redundancy 

In order to provide Control System redundancy, your HD Core 
must be fitted with two MKII Router Modules (980/33): one main 
and one redundant.  

The redundant Control System is automatically activated if, 
internally, a loss of connection is noticed by the redundant 
system. This could be due to a software failure, hardware error 
or reboot of the main Control System.  

Note that if the Ethernet connection between the control surface 
and Router Module fails, then an automatic takeover does not 
occur, as the failure may be deliberate (e.g. you disconnect the 
Ethernet cable). Instead the operator is presented with an error 
message allowing them to decide whether to switch to the 
redundant control system. 

A manual takeover can be initiated from the System Settings 
display, or by pressing the Module Takeover button on the 
front of the redundant Router Module. 

For more details on configuring a redundant Router Module, 
see Chapter 3: AdminHD.  

For further details on how Control System redundancy is 
managed, see Page 262. 
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DSP Redundancy 

Any number of DSP modules fitted to the HD core may be 
reserved to provide redundant processing in the unlikely event 
of a DSP module failure. You can investigate whether you have 
a redundant board from the console‟s DSP Config display: 

If, for example, your HD core is fitted with 3 DSP boards and 
the Active Configuration uses 2 DSP-Boards, then the third 
board will provide redundancy in the event of a failure.  

This can also be seen on the HD core front panel where the 
spare board is shown in Standby. Note that the system uses 
boards from right to left across the HD core. 

In the unlikely event of a failure, the system automatically 
switches all DSP resources and settings from the faulty board 
to the spare; the faulty board may then be safely removed and 
replaced.  

Note that the replaced board now acts as the spare board either 
until the HD core is restarted or a new DSP configuration is 
loaded. Following the reconfiguration, boards are utilised from 
right to left across the HD core. 
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Console Surface Redundancy 

Within each channel or centre section bay, individual panels 
connect via USB to an Ethernet Bay Server. Each Bay Server 
then connects back to the Control System within the HD Core in 
a „star‟-like architecture. Each TFT display connects via LVDS 
to its Ethernet Bay Server for high resolution graphics. 

Point-to-point Ethernet connections provide fault tolerance, and 
allow any channel or centre section bay to be remote from the 
main console if desired. All control surface panels are hot-
pluggable making them easy to service. 

The external power supply unit provides n+1 redundancy for the 
control surface. 
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Remote Operation 

For any HD Core system, settings within the matrix may be 
controlled remotely from:  

 an external PC running either the ControlHD or 
AdminHD software programmes. 

 an external PC running the mxGUI software programme. 

 a 3rd party control system using Lawo‟s Remote MNOPL 
protocol. 

ControlHD/AdminHD 

ControlHD is a subset of the AdminHD configuration software, 
and is used to ControlHD Core systems from remote PC. 

Up to eight clients may be connected to the system via TCP/IP 
Ethernet and may control all, or a subset, of the matrix: 

Once running online, you can use ControlHD‟s „Connect 
Manager‟ to: 

 Set Matrix crosspoints – connections from any system 

input to any system output. 

 Edit signal labels – online renaming of signal labels. 

 Control I/O parameters – for example, to adjust 

microphone preamp gain, high pass filter switching, etc. 

 Save and recall snapshots – to reset any number of 

signals, with partial or global recalls. 

For details, please refer to the “ControlHD Operator‟s Manual” 
or Chapter 3: AdminHD. 
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mxGUI 

mxGUI is a software programme which runs the mc2 graphical 
user interface on an external computer. It can be used for 
remote control of virtually all console settings. 

One mc2 system is able to support up to 16 mxGUI clients 
simultaneously.  

For details, please refer to the “mc266 Operator‟s Manual”. 

3
rd

 Party Control Systems 

In addition, the system supports 3rd party matrix control via 
Lawo‟s Remote MNOPL protocol.  

A typical application is to provide 3rd party matrix control so that 
crosspoints within the mc266 routing matrix can be controlled by 
external control systems such as VSM and Jupiter. Note that if 
your preferred supplier does not support the protocol, then 
please ask them to contact Lawo for further details. 

Within your AdminHD configuration, each signal may be given a 
mapping address; up to 16 different mapping tables can be 
defined so that different control systems can be supported 
simultaneously. 

For details on implementation, please refer to Chapter 3: 
AdminHD and to your 3rd party controller‟s documentation. 
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Networking 

mc
2
 and Nova73 

Two or more mc2 consoles may be networked to distribute I/O 
resources. In addition, the mc266 may be networked with the 
Nova73 Routing matrix: 

In our example above, a Nova73 and two mc² series desks are 
networking together to share all parameters within the Network.  

Each „Netlink‟ is an audio connection which may be MADI, ATM, 
AES or Analogue audio, and signals are dynamically allocated 
as each operator makes routes from the Signal List display. 

The Nova73 is almost identical to a mc266 system, with the only 
differences being that it has no control surface. Routes within 
the Nova73 matrix can be controlled in a number of ways: 

 From a remote PC running ControlHD or AdminHD 
software. 

 From a remote PC running mxGUI software. 

 From an external control system using Lawo‟s Remote 
MNOPL protocol. 

Any number of sources may be distributed depending on the 
physical limitations of your network. 

For more details on operating with shared and imported 
sources/destinations, please see the “mc266 Operator‟s 
Manual”. 
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Nova73 Dual Self-Healing Star 

Taking our redundant signal path a stage further, the Nova73 
can be implemented in a dual star topology to form a self-
healing architecture. This type of system is known as the 
Nova73 DSHS (Dual Self-Healing Star): 

In this example, one HD core is active and the other passive. In 
the case of a component failure, the system will switch to the 
redundant signal path.  

Product Compatibility 

From version 4.0.2.2 onwards, all Lawo products have adopted 
a consistent software release numbering system to indicate 
networking compatibility: 

The first three digits of the software revision number must be 
identical to ensure networking compatibility. 

For example, a Nova73 running Version 4.0.2.2 can be 
networked to a mc266 running Version 4.0.2.4. However, if the 
software revisions were 4.0.2.2 and 4.0.4.0, then they are not 
network compatible. 

For more details on networking of Lawo systems, please 
consult your local Lawo representative. 
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Quick Reference Guides 

MKII Router Module:  

The MKII Router Module (980/33) provides the following front 
panel connections and functions. Please refer to the data sheet 
for further details. 

ACTIVE LED Flashes green when the control system is 
running. The ACTIVE LEDs across all 

modules should flash in sync with each other. 
If an LED is out of sync, then the module is 
not synchronised to the rest of the system. 

STANDBY 
LED 

Illuminates in yellow when the module is 
running in redundant mode.  

CHARGE 
LED 

Illuminates when the backup power unit is 
charging. Off = unit is fully charged. 

ALARM LED Illuminates in red when the global alarm is 
triggered. See Chapter 4 for more details. 

SYNC LEDs These four LEDs indicate the current sync 
source (flashing green) and available 
redundant sync sources (solid green). 

PREPARE 
COLDSTART 

Press this button (the LED illuminates) to 
prepare a cold start. Having activated the 
button, the system will cold start on the next 
power cycle or restart. 

LAMP TEST Press this button to test all the LED lamps 
within the HD Core modules. 

MODULE 
TAKEOVER  

Press this button to force a takeover from the 
Active Router Module. (Functions only when 
two Router Modules are fitted.) 

ETHERNET A 

ETHERNET B 

Connects to the mc266 control surface. 

Connects to a system network or external PC 
for configuration, maintenance or control. 

Both connections are RJ45. 

The ACTIVITY LEDs flash green when data 
is being transferred. 

POWER 
Button 

This recessed button will power on or off the 
module (and Control System).  

Note that this button should only be used as 
a last resort if all other restart methods fail. 
Please see Page 250 for recommended 
shutdown and restart procedures. 
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DALLIS Master Board:  

A choice of DALLIS Master boards are available determining 
the type of connection to the HD Core (MADI or ATM, 
multimode or single mode fibre) and whether the connection 
has redundancy. All versions of the board provide similar 
functions: 

ACTIVE 
LED 

Flashes green when the card‟s internal control 
system is running. The ACTIVE LEDs across all 
cards should flash in sync with each other. If an 
LED is out of sync, then the card is not 
synchronised to the rest of the system. 

WCLK OK Illuminates in green when the system is receiving 
a valid Wordclock sync signal, and the fibre 
connection to/from the HD Core is valid. 

POWER 
OK 

Illuminates in solid green when the DALLIS PSU 
is running normally; flashes if there is a PSU 
error. 

ALARM Illuminates in red when any of the following error 
conditions are triggered: PSU error; internal 
health error (such as high temperature); sync 
error; MADI (or ATM) link error; rack 
configuration error. 

WCLK The DALLIS may be synchronised to an external 
wordclock reference connected to the WCLK 
BNC.   

MADI or 
ATM Ports 

A range of the DALLIS master board options are 
available: 

 947/05 (shown opposite) – Provides a 
single MADI port connection using 
multimode fibre. 

 947/07 – Provides one main (MADI A) 
plus one redundant (MADI B) port using 
multimode fibre. 

 947/15 – Provides a single MADI port 
connection using single mode fibre. 

 947/03 – Provides a single ATM port 
connection using multimode fibre. 

On some cards, LEDs show the status of the 
signals arriving at the connection. 

CTRL 
(RS422) 

Serial connection to PC for Lawo service. 
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Chapter 2: Installation 

Introduction 

This chapter deals with the hardware installation of the system 
components, starting with the HD Core, DALLIS, mc266 control 
surface and console power supply unit. 

Installing the HD Core 

The HD Core is designed to be mounted in a 19” rack. 

All plug-in connectors are located at the front or rear of the unit. 
Therefore, when using 19‟‟ racks with front doors please leave 
enough room for the cables. 

Cables plugged into the front of the unit can be ducted 
backwards underneath the unit for distribution within the rack. 

Warning 

Use the rack-rails supplied to mount the HD Core. The 19” 
frame MUST NOT carry the complete weight of the unit. 

Dimensions and Weight 

HD Core: Frame 

Width 19” 

483mm (front plate) 

440mm (body) 

Height  10RU 

Cable Duct 1RU below the frame is required 
for cable ducting and ventilation. 

Depth (including rear 
connectors and system 
locking devices) 

510mm 

Weight (without cards) 11.5 Kg 
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Ambient Conditions  

Proper operation of the HD Core can only be guaranteed at an 

ambient temperature between 10 C and 35 C and a relative 
humidity between 15% and 85% (not condensing). 

When the HD Core is out of action, it can be stored at a 

temperature between 0 C and 40 C and a relative humidity 
between 10% and 85% (not condensing). 

Air Conditioning 

The HD Core is cooled actively by built-in fans. The housing of 
the HD Core is perforated at the top and at the bottom to guide 
air flow in and out of the unit; the air stream is guided from 
bottom front to top rear. Ensure that the cooling air stream is 
guided to cool the unit efficiently. 

The air-flow rate depends on the mounted components. To 
calculate the air conditioning required, assume a maximal air-
flow rate of approximately 200 m³/h. 

The life cycle of a fan is typically 70.000 operating hours (at a 
maximum ambient temperature of 40° C). For details on fan 
replacement, please see Chapter 4: Service and Maintenance. 

Warning 

When mounting the HD Core, take care that no devices or 
cables obstruct the flow of air thereby hindering cooling. 
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Frame (980/02)  

 

 

 

Frame 980/02, front view  

 

 

 

 

 

 

 

 

 

 

Frame 980/02, side view 
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Grounding 

Although operator protection is guaranteed (the HD Core is 
connected via the IEC Power Connectors to the ground of the 
power supply system) it is best to establish an additional ground 
for EMC reasons.  

1. Fasten the grounding cable to the M4 CASE grounding 
bolt on the rear panel: 

 

Warning 

The HD Core must be on the same potential as all other system 
devices/modules. 

For Scandinavian countries, ALWAYS use a grounded mains 
connection, to prevent the device from being grounded through 
Ethernet or other signal connections. 

 

HD Core Frame, rear view 
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Power 

The HD Core frame offers two slots for the installation of power 
supply units. To operate the HD Core, one PSU is sufficient. 
Optionally a second PSU can be fitted for redundancy, in which 
case the load is shared between the two supplies.  

The PSUs are hot pluggable. See Chapter 4 for details on 
changing a PSU.  

Warning 

All devices MUST be connected to the mains using the three-

cord power leads supplied with the system. 

When running with two mains supplies (PSU 1 and PSU 2), 
make sure that both circuits lie on the same ground potential. 
Otherwise, an internal bridge of two ground wires will lead to a 
ground loop! 

For air conditioning reasons, a HD Core in operation requires 
both PSU slots to be occupied. If you do not wish to have a 
redundant PSU, then please insert a dummy housing 
(Type 980/21). 
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Power Consumption 

The power consumption of the HD Core varies from a minimum 
of 60W to a maximum of 1000W, depending on the voltage and 
the amount of modules and PSUs fitted. 

Electrical Voltage 

PSU specification (type 980/25): 

 Input: 100-240 VAC (PFC)/ 47–63 Hz/ max. 8,2 A 

 Output: 48 VDC / 23 A 

 

For further details on the HD Core frame or power supplies, 
please refer to the relevant data sheet. 
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Mounting the Plug-in Cards and Connector 
Panels 

Normally the HD Core will ship with the plug-in modules and 
rear connector panels fitted within the chassis. However, if you 
need to fit additional cards or re-arrange the layout for any 
reason, follow these instructions. 

Rear Frame Connector Panels 

Before mounting plug-in cards at the front of the frame, you 
must fit any connector panels required. For example, modules 
such as AES3, require breakout connector panels fitted to the 
rear of the HD Core frame: 

Depending on their width it is possible to insert between 4 and 8 
connector panels. The following connector panels are available, 
and can be mixed: 

 Type 980/14 D-Sub, 8HP - for connection of AES3, 
balanced 110 Ω 

 Type 980/15 BNC, 16HP - for connection of AES3-id, 
unbalanced 75 Ω 

Warning 

Where no connector panels are required please cover the rear 
of the frame with dummy plates of the type 980/13. 

 

 



 
Installation 

Installing the HD Core 

mc266 MKII Technical Manual V4.10/2 43/ 303 

 Mounting the Rear Connector Panels 

Mount the connector panels progressing from right to left (seen 
from the rear), filling up any empty slots with dummy plates: 

1. Establish the first free slot (seen from the right) at the 
rear of the frame. 

2. Remove the existing dummy plate if fitted. 

Note that dummy plates are 8HP wide. If you want to mount a 
connector panel with a width of 16HP you will need to remove 
two dummy plates. 

3. Position the connector panel so that the inscription is 
legible! 

4. Fasten the connector panel with its 4 screws. 

5. Repeat for every connector panel/dummy plate. 

For further details on specific connector panels, please refer to 
the relevant data sheet.  
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Equipping the Front of the Frame 

All modules are hot-pluggable enabling individual I/O or DSP 
modules to be replaced without affecting the rest of the system. 

 Plugging in the Modules 

Warning 

The HD Core plug-in Modules carry highly sensitive electronic 
components, and therefore should only be handled by 
authorized personnel, and with the utmost care.  

ALWAYS observe the following procedures: 

1. Discharge yourself before touching a plug-in card. 

2. Wear conductive safety-shoes and grounding 

wristbands to reduce the risk of electrostatic charging. 

3. DO NOT bend the cards. 

4. Make sure that all rear connector panels are mounted 
before inserting the respective plug-in card. 

5. When fitting a new card, make sure that it glides 
smoothly into the top and bottom guide-rails.  

When fitted correctly, it will lock into place. 

6. ALWAYS fasten the front panel screws in order to fix the 

card in place. This protects the operator from contact 
with live parts; protects the card from being pulled out 
unintentionally; and reduces the emission of electro-
magnetic radiation. 

Tighten the screws carefully to a maximum torque of 0.25 Nm; 
we recommend using a dynamometric screwdriver. 

7. When you have fitted all the plug-in cards for your 
system, close any empty slots with dummy plates. 
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 Module Order 

18 module slots are available within the HD Core frame: 

 Slot A – fit the main Router Module MKII (part number 
980/33) here. 

 Slot B – reserved for a redundant Router Module.  

Note that the HD Core will only work once slot A is fitted with a 
Router Module. When fitting a redundant Router Module, it 
must be of the same type fitted to slot A. 

 Slots 1-16 – used for I/O interface and DSP cards. 

To ensure efficient cooling, you should spread the modules 
evenly within the HD Core. 

Warning 

Not every I/O or DSP module can be used in every slot so it is 
best to check your configuration with AdminHD before fitting the 
physical modules.  

Also: 

1. Mount any modules of type 981/02 AES3 from left to 
right filling up the slots predetermined by the rear 
connector panels – i.e. mount each module so that it is 
right-aligned to the rear connector panel (view from 
front). 

Note that if a module has been fitted incorrectly, then you may 
see its AES3 LOCK 1 LED blink. If this is the case, check you 
selected the correct slot to match the rear connector panel. 

 

 

 

 

1 3 5 7 A 9 11 13 15

2 4 6 8 B 10 12 14 16

HD Core /  Slot No.
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2. Insert DSP modules of type 983/02 or 983/03 from right 
to left filling up the odd slots 15, 13, 11, 9, 7, 5, 3, 1. 

Note that the logical numbering of the DSP cards follows the 
mounting order described above (DSP card 1 in slot 15, DSP 
card 2 in slot 13, etc.): 

A 983/03 DSP module can be configured as a mxDSP card by 
updating the system configuration and the module‟s firmware. 
Please see Page 218 for details. 

For more details on the available plug-in module options, 
please refer to Appendix A.  

 

 

 

8 7 6 5 4 3 2 1

Logical Numbering of DSP Boards
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Installing the DALLIS Unit(s) 

Each DALLIS is designed to be mounted in a 19” rack and 
comes in a choice of frame heights: 3RU or 6RU.  

All plug-in connectors, with the exception of power and alarm, 
are located at the front of the unit. Cables can be ducted 
backwards underneath the unit for distribution within the rack. 

Dimensions and Weight 

DALLIS: 3RU Frame 6RU Frame 

Width 19” 

483mm (front plate) 

440mm (body) 

19” 

483mm (front plate) 

440mm (body) 

Height  132.5mm 265mm 

Cable Duct 1RU below the 
frame is required 
for cable ducting 
and ventilation. 

1RU below the 
frame is required 
for cable ducting 
and ventilation. 

Depth (of unit) 433mm 433mm 

Weight (without 
cards) 

7.15 Kg 11 Kg 

Air Conditioning 

The DALLIS needs a constant air stream with a maximum 

exhaust air temperature of 32 C. Thus installation in a 19” rack 
is recommended.  

The housing of the DALLIS is perforated at the top and at the 
bottom to guide air flow in and out of the unit. Ensure that the 
cooling air stream is guided to cool the unit efficiently. 

To calculate the air conditioning required, assume a power 
consumption of 200 Watts. 

Warning 

Use the rack-rails supplied to mount the DALLIS. The 19” frame 
MUST NOT carry the complete weight of the unit. 

ALWAYS leave IRU below the DALLIS frame for ventilation and 
cable ducting. Take care that no devices or cables obstruct the 
flow of air thereby hindering cooling. 

ALWAYS observe the minimum distances at the front and rear 
of the unit to allow for ventilation and cable ducting (see next 
page). 
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Minimum Distances for DALLIS Installation 
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3RU Frame (940/03)  

 

 

 

Cable Duct 

Frame 940/03, front view 
(cards fitted as example) 

 

 

 

Frame 940/03, rear view 

 

 

 

 

Frame 940/03, side view 
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6RU Frame (940/06)  

 

Cable Duct 

Frame 940/06, front view 
(cards fitted as example) 

 

 

 

 

 

 

 

 

Frame 940/06, side view 
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Grounding 

Although operator protection is guaranteed (the DALLIS is 
connected via the IEC Power Connectors to the ground of the 
power supply system) it is best to establish an additional ground 
for EMC reasons.  

1. Fasten the grounding cable to the M4 CASE grounding 
bolt on the rear panel: 

Warning 

The DALLIS must be on the same potential as all other system 
devices/modules. 

For Scandinavian countries, ALWAYS use a grounded mains 
connection, to prevent the device from being grounded through 
Ethernet or other signal connections. 

Grounding of Audio Interfaces 

For compliance with AES3, digital interfaces should be 
connected to a field ground. 

For connecting microphones, guide the ground connection from 
the DALLIS to the microphone directly via the cable shielding, 
otherwise phantom power cannot be transferred. Take care that 
the shielding does not lie on the field ground. This way you will 
prevent interference and loss of signal quality. 

DALLIS Frame, rear view 
(close up of PSU panel) 
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Power 

Depending on your system specification, each DALLIS may be 
delivered with single or dual redundant power supply units 
(PSUs). When a redundant PSU is fitted (type 940/16), the load 
is shared between the two supplies. The PSUs are hot 
pluggable. See Chapter 4 for details on changing a PSU.  

Warning 

All devices MUST be connected to the mains using the three-

cord power leads supplied with the system. 

When running with two mains supplies (PSU 1 and PSU 2), 
make sure that both circuits lie on the same ground potential. 
Otherwise, an internal bridge of two ground wires will lead to a 
ground loop! 

 

1 PSU 1 

IEC Power 
Connector 

When running with a single PSU, connect 
mains to the PSU 1 IEC power connector 
according to the electrical input voltage 
specified overleaf.  

2 PSU 2 

IEC Power 
Connector 

When running with main and redundant 
power supplies, feed the PSU 1 and PSU 
2 mains inputs from separate circuits 

taking care that they both lie on the same 
ground potential! 

3 CASE 

Grounding 
Screw 

Use the M4 screw to ground the DALLIS. 
The DALLIS unit must be on the same 
potential as all other system devices. 

For details on the ALARM and FORCE M2 connectors, see 
Chapter 4. 
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Power Consumption 

The power consumption of the DALLIS varies from a minimum 
of 70W to a maximum of 180W, depending on the amount and 
type of I/O cards fitted, and whether there are dual power 
supplies. 

Electrical Voltage 

3RU frame, PSU specification: 

 Input: 100-240 VAC (PFC)/ 48-62 Hz/ 1.6-2 A 

 Output: 12 VDC / 8.3-11 A 

6RU frame, PSU specification: 

 Input: 100-240 VAC (PFC)/ 48-62 Hz/ max. 2A 

 Output: 12 VDC / 11 A 

 

For further details on the DALLIS frame, please refer to the 
relevant data sheet. 
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Mounting the Plug-in Cards 

Normally the DALLIS will ship with the plug-in I/O and master 
board cards fitted within the chassis. However, if you need to fit 
additional plug-in cards or re-arrange the layout for any reason, 
follow these instructions. 

 Plugging in the Cards 

With the exception of the Phantom Power card, all cards are 
hot-pluggable enabling individual I/O cards to be replaced 
without affecting other aspects of the system. 

Warning 

To avoid any unpleasant clicks or pops, the system resets when 
a Phantom Power card is replaced. Therefore, you should only 
perform this operation when off air! 

Warning 

The DALLIS plug-in cards carry highly sensitive electronic 
components, and therefore should only be handled by 
authorized personnel, and with the utmost care.  

ALWAYS observe the following procedures: 

1. Discharge yourself before touching a plug-in card. 

2. Wear conductive safety-shoes and grounding 
wristbands to reduce the risk of electrostatic charging. 

3. DO NOT bend the cards. 

4. To remove an existing card, unfasten the front panel 
screws and pull out the card.  

Note that some DALLIS I/O cards include DIP switches to set 
certain features of the cards. Therefore, when replacing cards, 
check the DIP switch settings before inserting the new card! For 
details on these settings please consult the relevant data sheet. 

Note also that the DALLIS master board provides a switch to 
set whether the board performs a cold or warm start when 
powered on. You may need to set this switch to cold start to 
initialise the system. For details please consult the relevant data 
sheet. 

5. When fitting a new card, make sure that it glides 

smoothly into the top and bottom guide-rails.  

When fitted correctly, it will lock into place. 

6. ALWAYS fasten the front panel screws in order to fix the 
card in place. This protects the operator from contact 
with live parts; protects the card from being pulled out 
unintentionally; and reduces the emission of electro-
magnetic radiation. 
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7. When you have fitted all the plug-in cards for your 
system, close any empty slots with dummy plates (For 
single width slots use part number 940/31, and for 
double width slots use 940/33. Use part number 940/32 
to blank the second master board slot). 

Equipping the 3RU Frame 

18 single width DALLIS I/O card slots are available within the 
3RU frame. Double width I/O cards (8GU) occupy two slots; 
single width I/O cards (4GU) occupy one slot. 

Depending on the specification, each DALLIS can provide up to 
60 channels of audio. The plug-in cards should be fitted as 
follows: 

 Slot M1 – fit the main master board here. 

 Slot M2 – reserved for a redundant master board. 

Note that the DALLIS will only work once the M1 slot is fitted 
with the master board. 

 Slots 1-18 – used for interface cards: 

Warning 

Not every interface card can be used in every slot. As a general 
rule, if an interface card is permitted within the AdminHD 
configuration software, then it can be fitted to your system. See 
Chapter 3 for details on AdminHD.  

For details on the available plug-in card options, please refer to 
Appendix C.  

Remember to fit a phantom power card if you have specified a 
transformer balanced mic card. 
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Equipping the 6RU Frame 

18 double width DALLIS I/O card slots are available within the 
6RU frame plus one single width slot reserved for Phantom 
Power. Double width I/O cards (8GU) occupy the whole slot; 
single width I/O cards (4GU) must be fitted on the left of the slot 
and a dummy plate fitted to the right to close the gap. 

Depending on the specification, each DALLIS can provide up to 
60 channels of audio. The plug-in cards should be fitted as 
follows: 

 Slot M1 – fit the main master board here. 

 Slot M2 – reserved for a redundant master board. 

Note that the DALLIS will only work once the M1 slot is fitted 
with the master board. 

 Slot 19 – reserved for Phantom Power – if specified, fit 
the Phantom Power card (part number 947/10) here. 

 Slots 1-18 – used for interface cards: 

Warning 

Not every interface card can be used in every slot. As a general 
rule, if an interface card is permitted within the AdminHD 
configuration software, then it can be fitted to your system. See 
Chapter 3 for details on AdminHD.  

For details on the available plug-in card options, please refer to 
Appendix C.  

Remember to fit a phantom power card if you have specified a 
transformer balanced mic card. 
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Installing the Control Surface 

Overview 

Each control surface consists of the following components: 

 Frame (with extender if required)  

 Stand (for studio versions) 

 Crossbar (inserted in the stand)  

 Control Surface Panels 

 Overbridge fitting (optional) 

 Integrated keyboard (for chosen language) 

 Integrated headphone and USB connections 

 Manuscript tray (optional) 

The size of the frame determines the appropriate profile 
(crossbar) for the stand. Large consoles require an additional 
middle stand. 

For specific details please refer to the “HTML-Documentation 
mc266” guide which contains mechanical drawings, data sheets 
and information on all console, HD Core and DALLIS options. 
You can download the “HTML-Documentation mc266” guide by 
registering at http://www.lawo.de/en/website/login.html and then 
following the links to the Download Centre -> mc266. 

Console Options 

The main options include: 

 Frame Size 

The mc²66 control surface comes in a range of frame sizes 
scaling from 8+8+8 (16 channel plus 8 main faders) up to 
48+8+48 (96 channel plus 8 main faders): 

The position of the central control section may be freely 
specified.  

Any frame may be expanded by fitting a stand-alone extender 
(8, 16 or 24 faders). This allows the console to take more 
faders, or to be divided into separate sections for easy 
transportation. 

Note that expansion bays (extenders) support 8-fader decentral 
panels only. Centre section panels (962/10, 962/11, 962/12 or 
962/13) cannot be fitted into an extender.  

Extenders are available for both studio and OB frame versions. 

Large consoles with a frame extension require an additional 
middle stand. 

 

 

http://www.lawo.de/en/website/login.html
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 Frame Version 

Different frame versions are available for: 

 Studio Installation - comes with detachable legs and 

stand allowing it to be free standing. Two different stand 
heights are available (European and Asian). 

 OB Installation - designed for mounting onto a cross 

bar (not supplied) to save weight. 

 Dummy Panels 

You may order a larger frame and fit dummy panels to allow for 
future expansion. 

For a list of control surface panels, please see Page 284. 

Note that you must order at least as many Fader panels as 
Free Control Panels because the Free Control panels are 
controlled via the Fader panels.  

 User Panels or 19” Integration 

To the right of the FC PRESET and SNAPSHOT/SEQUENCE 
controls is an area which may house up to three user panels or 
a 19” integration kit: 

The options include: 

 40 USER KEYS - 40 additional user buttons (one slot). 

 80 USER KEYS - 80 additional user buttons (two panel 
slots). 

 INTERCOM - talkback speaker and microphone (one 
slot). 

 AUTOMATION - dynamic automation controls (one slot). 

 8 ROTARY CONTROLS – 8 assignable rotary controls 
(one slot). 

 REMOTE MACHINE CONTROL panel (two panel slots). 

 19” integration kit (occupies all three user panel slots).  

Note that only one 40 User Key panel may be fitted; for more 
keys, use the 80 User Key panel. 

User buttons can be factory-configured or edited from the 
Custom Functions display. 
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 Overbridge Metering  

The overbridge may be fitted with an external meter or a 
dummy panel. The components of the overbridge fitting are 
delivered with the relevant cabling. 

 Console Keyboard   

The console keyboard is available in English or German – see 
Page 65 for details on how to change the language version. 

 Cables 

Ethernet and the PSU connecting cables are available in a 
variety of lengths and must be ordered separately. 

 Script Tray  

One or more removable script trays may be ordered separately. 

 Headphone Connections 

To use the headphone jacks mounted in the arm rest of the 
console frame, you must order one DALLIS 942-61 card, 
connected via D-Sub (37 pin), to provide the audio feeds. 

 Monitor Outputs 

For monitor section outputs you must order one of the following 
transformer-coupled DALLIS I/O cards depending on the 
required level and connector type: 

Part 
Number 

Revision Outputs Level Connector 
Type 

942/02  294.2020 4 x Line out  15dBu D-Sub 

942/04 294.2040 4 x Line out  24dBu D-Sub 

942/06 294.2060 4 x Line out  18dBu D-Sub 

942/12  4 x Line out  15dBu XLR 

 Operating Level 

Please note that the maximum analogue level of the whole 
system is defined by the DALLIS card with the lowest GDA 
(General Device Address) – this is the DALLIS card with the 
lowest address fitted to the DALLIS frame connected to the 
lowest port number of the first HD Core. 
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Dimensions and Weight 

 Studio Version (with stand): 

Frame Spec & 

(Part Number) 

Width Height  Weight  

(fully fitted) 

24-8-24 

(962-70) 

2454.9 mm  1029 mm 150.50 Kg 

24-8-16 

(962-71) 

2174.9 mm  1029 mm 146.87 Kg 

16-8-16 

(962-72) 

1894.9 mm  1029 mm 135.03 Kg 

16-8-8 

(962-73) 

1614.9 mm  1029 mm 122.66 Kg 

8-8-8 

(962-74) 

1334.9 mm  1029 mm 110.30 Kg 

 OB Version (no stand): 

Frame Spec & 

(Part Number) 

Width Height  Weight  

(fully fitted) 

24-8-24 

(962-70) 

2316 mm  364 mm 132.55 Kg 

24-8-16 

(962-71) 

2036 mm  364 mm 119.67 Kg 

16-8-16 

(962-72) 

1756 mm  364 mm 107.83 Kg 

16-8-8 

(962-73) 

1476 mm  364 mm 95.46 Kg 

8-8-8 

(962-74) 

1196 mm  364 mm 83.10 Kg 

 Extenders: 

Frame Spec & 

(Part Number) 

Width Height  Weight  

(fully fitted) 

8 (OB Version) 

(962-75) 

280 mm  364 mm 13.11 Kg 

16 (OB Version) 

(962-76) 

560 mm  364 mm 26.82 Kg 

24 (OB Version) 

(962-77) 

840 mm  364 mm 39.93 Kg 
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For dimension drawings and details on panel options please 
refer to the “HTML-Documentation mc266” guide. 

Ambient Conditions 

Proper operation of the control surface can only be guaranteed 

at an ambient temperature between 10 C and 35 C and a 
relative humidity between 15% and 85% (not condensing). 

Air Conditioning 

The control surface is convection cooled; there are no fans 
within the surface. Ensure that the cooling air stream is guided 
to cool the unit efficiently. 

Installing the Frame 

When installing the console, note that all plug-in connectors are 
located at the rear of the frame. 

For the OB frame version, please ensure that you have ordered 
the relevant cross bar mounting kit. Note that the cross bar is 
not included and must be supplied by the customer. 

For the studio frame version, the console is normally shipped 
separately from its stand.  

When installing the console, note that all plug-in connectors are 
located at the rear of the frame. 

Warning 

ALWAYS observe the minimum distances around the console 
frame to allow for ventilation and cable ducting (see next page). 
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Minimum Distances for mc266 (Studio Frame) 
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Minimum Distances for mc266 (OB Frame) 
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Power 

The console control surface power is provided by the external 
console PSU (see Page 68).  

A single PSU can power up to 48 fully fitted channels 
(24+8+24). Extender frames share the power from the external 
PSU using daisy-chain wiring. Therefore, depending on the size 
of your console and the number of extender frames, you may 
require multiple PSUs (up to 4). 

Warning 

Harting power connectors must NOT be disconnected under 
load. 
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Console Keyboard Driver Installation 

The console keyboard is available in different language layouts. 
To change the keyboard driver from say German to English, 
you will need to open a Telnet session to the console‟s control 
system. We recommend using Tera Term Pro Web 3.1.3, a free 
telnet client for windows, which can be downloaded from 
http://www.ayera.com/teraterm/ 

1. Open the Tera Term Pro telnet client.  

To configure the IP Address of your console open TCP/IP from 
the Setup menu, and add the TCP/IP address of your console 
to the host list: 

The default TCP/IP address of a mc266 system is 
192.168.102.65. 

2. Now set up a new telnet connection using File -> New 
connection: 

 

 

 

http://www.ayera.com/teraterm/
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3. Choose the TCP/IP Host address of your desk: 

4. Enter the login name: root  and the password: hong  

Tera Term PRO opens a telnet session to the console’s control 
system: 

All parameters in the mc²66 are administered from here. 

5. Now type: cd /data/config/sysconfig into the Tera 
Term Pro window, and press Enter. 

Note that the string must be written in lower case letters. 

You are now in the correct directory to change the keyboard 
configuration. This is done by opening the keyboard 
configuration file with a little text editor called joe, as follows: 

6. Type joe keyboard and press Enter: 
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The following should appear: 

7. Choose the parameter by typing KEYMAP=”ENGLISH” 
(or KEYMAP=”GERMAN”) as required. 

8. Then close the editor and save the file by pressing 
CTRL + K + X on the keyboard. 

The new Keyboard driver is now configured, and after the next 
reboot will be active. 

9. You can reboot from the telnet client by typing reboot.  

The console reboots, and the keyboard will be available in your 
configured language. 
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Installing the Console Power Supply 
Unit 

The control surface power is provided by an external PSU with 
n+1 redundancy.  

A single PSU can power up to 48 fully fitted channels 
(24+8+24). Extender frames share the power from the external 
PSU using daisy-chain wiring. Therefore, depending on the size 
of your console, and the number of extender frames, more than 
one external PSU may be required. 

The external PSU is normally sited near the console surface. 
The maximum cable run from the surface is 10m. 

Dimensions and Weight 

External PSU: Frame 

Width 19” 

Height  3RU 

Depth  (including 
handles and connectors) 

Additional rack space 
required for power 
cables  

500mm 

 

 

150mm 

Weight 9.25 Kg 

Ambient Conditions  

This PSU works with convection cooling (no fans) if the ambient 

temperature is below 25 C and the load does not exceed 25 A 
at the mains supply lines. For temperatures or loads exceeding 
these conditions, the unit‟s fan will be started once the internal 

temperature exceeds 56 C. The fan will continue to operate 

until the internal temperature falls below 42 C when it will 
switch off.  

Note that if only two of the three internal supplies are active, 
then the fan will operate once the ambient temperature exceeds 

25 C. 

A yellow LED on the front of the unit illuminates when the fan is 
active. 
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Air Conditioning 

The PSU is convection cooled providing that the ambient 

temperature is below 25 C and the load does not exceed 25 A 
at the mains supply lines. 

The housing of the PSU is perforated at the front and rear to 
guide air flow in and out of the unit; the air stream is guided 
from bottom front to top rear. Ensure that the cooling air stream 
is guided to cool the unit efficiently. 

Warning 

When mounting the PSU, take care that no devices or cables 
obstruct the flow of air thereby hindering cooling. 

Grounding 

Although operator protection is guaranteed (the PSU is 
connected via the IEC Power Connectors to the ground of the 
power supply system) it is best to establish an additional ground 
for EMC reasons.  

1. Fasten the grounding cable to the M4 CASE grounding 
bolt on the rear panel: 

Warning 

The PSU must be on the same potential as all other system 
devices/modules. 

For Scandinavian countries, ALWAYS use a grounded mains 
connection, to prevent the device from being grounded through 
Ethernet or other signal connections. 

 

PSU Frame, rear view 
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Connections 

The PSU has two mains supply terminals at the rear. Therefore, 
it is possible to realise phase redundancy if each terminal is 
connected to a different phase. Only one mains input is 
required to operate the system. However, if you intend to use 
only a single phase, then it should be connected to both mains 
terminals in order to avoid system error messages and a red 
LED on the front panel. 

A single cable runs from each PSU to the control surface. The 
bay server to the right of the GUI display usually contains the 
direct connection to the PSU.  

Warning 

All devices MUST be connected to the mains using the three-
cord power leads supplied with the system. 

Harting power connectors must NOT be disconnected under 
load. 

Make sure that ALL circuits lie on the same ground potential. 
Otherwise, an internal bridge of two ground wires will lead to a 
ground loop. 

Status Monitoring 

Internally, the PSU is equipped with three power supplies 
running in parallel. For correct operation, only two supplies are 
required; the third is for redundancy. If more than one of the 
internal supplies fails, then the complete PSU rack must be 
replaced. Please send the defective rack to Lawo for repair. 

LEDs at the front of the unit indicate the status of each mains 
connection and internal supply. From Version 4.8 software 
onwards, the console GUI also offers status monitoring for the 
external PSU. See Chapter 4 for details on status monitoring. 
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Power Consumption 

The maximum power consumption for an external PSU rack is: 

 Current (max): 8 A 

 Power consumption (max): 528 Watts 

 Power dissipation: ca. 60 Watts 

 Inrush current (max): 40 A 

These figures apply to a fully fitted 24+8+24 frame layout. 
Consoles with fewer panels requires less current and power.  

Consoles with larger frame configurations require more than 
one external PSU. 

Electrical Voltage 

PSU specification: 

 Input: 100-240 VAC (PFC)/ 47–63 Hz 

 Output: 13 VDC / 33 A (max)/ 468 Watts (max) 

For further details, please refer to the relevant data sheet. 
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System Connections 

Having installed the HD Core, DALLIS units, control surface 
and its power supply, it‟s time to connect up the system. 

Wiring from the Console 

A single Ethernet connection and power are required to run the 
mc266 as a stand-alone system: 

1. Connect one of the console‟s ETHERNET ports to the 
HD Core Router Module (ETHERNET A) using a 

straight (1:1) network cable: 

If two Router Modules are fitted to the HD Core, then run a 
second Ethernet connection to the redundant module 
(ETHERNET A). 

2. Connect power from the external PSU using the cable(s) 
provided.  

A single power cable connects each external PSU to the 
console; multiple PSUs may be required for larger frames. 

Wiring from the HD Core 

All essential system connections come to and from the HD 
Core‟s Router Module: 

 ETHERNET A – connects to the mc266 control surface. 

 ETHERNET B – connects to the control network for 

configuration, maintenance or remote control. 

If two Router Modules are fitted to the HD Core, then run 
Ethernet connections from both the main and redundant 
modules (ETHERNET A to the console surface; ETHERNET B 
to the control network). 
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Ethernet B (Control Network)  

The ETHERNET B port, on the MKII Router Module, can 
connect directly to a configuration/service PC. However, more 
commonly a network switch is used, in order to connect to a 
wider control network. (A 3com network switch is provided with 
every system on delivery.) 

1. Connect the ETHERNET B port to the control network 

(TCP/IP Ethernet) to support the following applications: 

 Control from an external controller system. 

 Control or configuration from an AdminHD, ControlHD or 
mxGUI PC. 

 Networking with other Lawo systems. For example, 
additional mc2 consoles or Nova73 routing matrices. 

 Support of the „dial-up router‟ option for remote 
maintenance. 

Connect each device‟s ETHERNET port to the network switch 

using a straight (1:1) network cable (STP-CAT 5 with RJ45 
connectors on both sides). 

Warning 

Only use the network switch provided; do not connect via a 
network hub. Keep your Lawo network separate from other 
network traffic within your installation.  
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2. To establish communication between the devices, you 
may need to configure the TCP/IP settings.  

We recommend using the default IP addresses where possible 
as this will simplify remote maintenance:  

Device Port IP Address Notes 

Router Module Slot A ETHERNET A 192.168.105.1 Fixed address. 

Router Module Slot A ETHERNET B 192.168.102.65 Default address of the mc
2
66 

Control System.  

This address can be modified 
(e.g. to network multiple 
consoles). 

Router Module Slot B 

(redundant Router 
Module, optional) 

ETHERNET A 192.168.106.1 Fixed address. 

Router Module Slot B 

(redundant Router 
Module, optional) 

ETHERNET B 192.168.102.66 This address is always one digit 
higher than that of the main 
Control System, and is set 
automatically by AdminHD. 

Ethernet Switch - 192.168.102.250 Default address. 

ISDN Dialup Router 
(optional) 

- 192.168.102.200 Default address. 

 

You can find more information on changing system component 
TCP/IP addresses in Chapter 3: AdminHD. 

Warning 

Where fitted, a redundant Router Module must have a different 
IP address to the main Router Module. This is set automatically 
by AdminHD when a redundant router module is configured. 

If you having problems establishing a network connection 
please follow the trouble shooting tips in Chapter 4: Service and 
Maintenance. 
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Connecting I/O 

Connect your I/O devices to the HD Core via the I/O modules 
fitted to the system. I/O options include AES/EBU, MADI and 
ATM. Further formats can be realised by connecting MADI or 
ATM to remote DALLIS or 3rd party I/O interfaces. 

For details on the breakout connections to and from HD Core 
I/O Modules, please refer to Appendix B. 

For details on DALLIS I/O cards, please refer to the relevant 
data sheet as listed in Appendix C. 
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Switching on the Power 

Having installed and connected all the essential system 
components – Ethernet, Power and I/O - the system can now 
be switched on.  

To start the system, turn on the external PSU unit and HD Core. 
Note that you may power the console and HD Core before other 
interfaces if desired. This enables you to begin setting up the 
console before your remote Stageboxes are connected. 

At the end of the boot-up, the control system normally loads the 
console‟s warm start data; this is the status of the console as 
stored when the system was last shut down. This means that 
when you turn on the power you will get back to wherever you 
were when the console was last shutdown.  

Note that the system can be set to cold start on boot-up from 
the console‟s System Settings display. See Page 250 for more 

details. 

To check that the HD Core and DALLIS units are operating 
normally, you can look at the console‟s Signal Settings display 
– all cards should be grey: 

Or check the status LEDs on each unit‟s front panel. Within the 
HD Core and DALLIS, the ACTIVE LED on each module or 
card should blink in time with all other ACTIVE LEDs, at 
approximately 1Hz. This shows that the card is synchronous to 
the rest of the system.  

For more details on these LEDs or for tips on fault finding, 
please see Chapter 4: Service and Maintenance. 
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Switching off the Power 

The system should be shut down by powering down the 
external PSU unit (control surface) and the power to the HD 
Core. 

Warning 

NEVER disconnect Harting power connectors from the control 
surface before switching off the external PSU. 

Following switch-off, power is provided to the Control System 
for a further 18 seconds in order to save all current settings to 
flash memory. This is called the console‟s warm start data. You 
will hear eight tones signaling that the shutdown operation has 
been successfully completed. The system is shutdown when 
the blue LED of the trackball is off. 

You may switch off the power to other system components – 
the DALLIS units - at any time.  
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Other System Connections 

Connections on the rear of the HD Core frame are also 
provided for: 

 Synchronisation -  options include: 

o Word clock 

o AES/EBU (AES3-id) 

o Video Black Burst - PAL or NTSC 

 Alarm and control contacts – including the global 

alarm. 

System Clock 

The HD Core offers a fully redundant clock source structure 
with two independent clock inputs, an internal sync generator 
and the ability to lock to sync from an incoming multi-channel 
signal. This allows the console to be clocked from a variety of 
sync sources and recover from loss of external sync. 

The sync reference options are: 

 Wordclock – connected to the INPUT 1 or INPUT 2 

ports on the rear of the HD Core. 

 AES3-id – connected to the INPUT 1 or INPUT 2 ports 

on the rear of the HD Core. 

 Video black burst – connected to the INPUT 1 or 

INPUT 2 ports on the rear of the HD Core. The system 
supports either PAL 625 lines/50Hz or NTSC 525 
lines/59.94Hz. 

 ATM - incoming ATM assigned within the system 

configuration using AdminHD.  

 MADI - incoming MADI assigned within the system 

configuration using AdminHD. 

For more details on configuring an ATM or MADI multi-channel 
sync reference, please see Chapter 3: AdminHD. 
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Synchronisation Ports 

Connect your Wordclock, AES or Video sync source to the 
INPUT 1 or INPUT 2 ports at the rear of the HD Core: 

INPUT 1 

and INPUT 2 

Sync inputs accepting Wordclock, AES3-id or 
Video black burst as described above. 

THRU 1  

and THRU 2 

Use the THRU ports to distribute the sync 
signal supplied at INPUT 1 or INPUT 2 to other 
equipment. Note that this provides a looped-
through signal and does not follow the sync 
switching of the system. 

WCLK OUT The current system clock can be picked up at 
the WCLK OUT (word clock) output. This 
follows the redundant sync source switching of 
the system. 

Warning 

 The HD Core supports only one video format at a time. 
Thus, if both inputs are supplied with video signals, only 
signals of the same type will be used (either PAL or 
NTSC). 

 When running the system referenced to Wordclock, the 
frequency of the sync source must match the internal 
operating sample rate of the system. 

 When no further component is connected to THRU 1/2 it 
is essential to terminate the THRU ports using a resistor 
of 75 Ω. Terminating resistors designed as BNC 

connectors are included in delivery. 

A star-like clock distribution via a distribution amplifier offers 
better signal quality and should be preferred to that of a passive 
daisy chaining. 
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Selecting the Clock Source 

Within the mc266 you may define a main clock source (Source 
Priority 1) and a redundant one (Source Priority 2) from the 
console‟s System display. These settings are then stored within 
the console‟s Production. 

Select the System Settings display and focus on the 
Wordclock topic: 

 Source Priority 1 and 2 

These two options allow you to select the main and redundant 
clock source for the system. If sync is lost or a signal of an 
incorrect frequency appears on Source Priority 1, the system 
automatically switches to Source Priority 2. Similarly, if sync is 
lost on Source 2, the system automatically switches to internal 
sync. 

You can set each of the options to: 

 Input 1 – HD Core Sync Input 1 (Wordclock, Video or 

AES3) 

 Input 2 – HD Core Sync Input 2 (Wordclock, Video or 

AES3) 

 Multichannel Sync - ATM or MADI as defined within 

the system configuration using AdminHD. 

 Active Synchronization Source 

This option displays and sets the active sync source for the 
system:  

 Src Prio 1 – the input selected as Source Priority 1. 

 Src Prio 2 – the input selected as Source Priority 2. 

 Internal. 

If sync is lost or a signal of an incorrect frequency appears on 
Source Priority 1, the system automatically switches to Source 
Priority 2. Similarly, if sync is lost on Source 2, the system 
automatically switches to internal sync. 
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 Return Mode 

This option activates a return mode so that the system will 
switch back to Source Priority 1 (or 2) when it returns. The 
system even checks whether the return sync is valid and will 
not switch until the sync source matches the chosen operating 
frequency of the console. 

 Return Mode (On) - activates the return mode. 

 Return Mode (Off) - deactivates the return mode. 

To force the system to run on internal sync, deactivate the 
return mode and set the Active Source to Internal. 

 Alarm when internal  

This option activates an alarm when the system is running on 
internal sync: 

 Alarm when internal (On) -  activates the alarm. 

 Alarm when internal (Off) -  deactivates the alarm. 

The alarm triggers on-screen Warning flag and illuminates the 
red LED on the front panel of the HD core router card. 

 External Sync Input Status  

The next five options are for display purposes only and show 
the status of the external and multi-channel sync signals.  

The example above shows that a valid Wordclock signal is 
connected to external inputs 1 and 2, and the Active 
Synchronisation Source is Src Prio 1 = Input 1.  
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Alarm Messaging System 

Various alarm contacts are provided on both the HD Core and 
DALLIS rear panels.  

HD Core Alarm Contacts 

On the rear of the HD Core are two GPI 25-pin D-Sub 
connectors carrying input and output alarm messaging signals. 
In addition, a single BNC outputs the GLOBAL ALARM: 

 Inputs 

The GPI inputs are opto-couplers; accept voltages of 
5 V…24 V; draw current of typically 3 mA; and are floating and 
galvanically isolated. 

 ROUTER TAKEOVER – use this input to force a 

takeover to the redundant Router Module, if fitted. The 
takeover is triggered by a positive edge at the input. 

 PREPARE COLDSTART – this input can be used in the 

same way as the front panel Prepare Coldstart button. 
When turning on the HD Core, supply a voltage at the 
input to perform a cold start. 

 ALARM IN 1-4 - these inputs may be used to monitor 

peripheral equipment such as devices from other 
manufacturers. Within the AdminHD configuration, you 
can assign an error message (text) for each input and 
define whether the input will activate the global alarm. 
Predefined standards are: 

o ALARM 1 IN - failure of the external clock supply  

(activating the global alarm). 

o ALARM 2 IN - failure of the external power supply  
(activating the global alarm). 

o ALARM 3 IN - failure of the external I/O system  

(activating the global alarm). 

o ALARM 4 IN – the external device exceeds its 
operating temperature (activating the global alarm). 

The alarm is triggered by an applied voltage. When the input is 
open or grounded, the alarm is cancelled. 

 GENERAL PURPOSE IN 1-2 – these inputs may be 

used for project-specific applications.  

 

 1
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 Outputs 

The GPI outputs are relays; output a maximum of 30V/500mA; 
and are floating and galvanically isolated. 

 CTRL LIFE WATCH – this is a project-specific contact 

which can be used to report the loss of a connection to 
another control system. Please contact your local Lawo 
representative or email service@Lawo.de for more 
details. 

 2nd ROUTER ACTIVE – this contact reports the 

activation of the redundant Router Module, if fitted. 
(closed status) 

 PSU ALARM – this contact reports the failure of the 

PSUs (closed status). 

 GLOBAL ALARM – this is a collective alarm contact 

which signals the occurrence of any failure (closed 
status). 
The contact is output in parallel via BNC and D-Sub. 

 GENERAL PURPOSE OUT 1-2 – these outputs may be 

used for project-specific applications. Please contact 
your local Lawo representative or email 
service@Lawo.de for more details. 

Note that the Global Alarm state is triggered when any of the 
following conditions are satisfied:  

Within the HD Core: 

 Malfunction of a Router module. 

 High temperature on a Router module – triggered if the 

temperature exceeds 45 C. 

 Too high or too low a voltage to a Router module. 

 Malfunction of an I/O module in the HD Core. 

 Malfunction of a PSU. 

 Malfunction of a fan. 

 Active External Control Input – the global alarm can be 
triggered by a control input (e.g. GPI). 

From an I/O Port (e.g. DALLIS): 

 If the port is not supplied with a valid signal. 

 Malfunction of a DALLIS master board. 

 Malfunction of a DALLIS I/O card. 

 Malfunction of a DALLIS PSU. 

 Voltage feed 

At the GPI 1 and GPI 2 D-Sub connectors it is possible to pick 
up +5V with a maximum current of 150mA. (short-circuit proof). 
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DALLIS Alarm Contacts 

The DALLIS offers two rear panel connectors for transmitting 
alarm signals: 

 ALARM FORCE M2 15-pin D-Sub - outputs a number of 

alarm contacts allowing you to distinguish between a 
system and PSU failure. 

 ALARM BNC – triggered by the global alarm only. 

 The ALARM FORCE M2 Connector 

The following contacts are accessible via the ALARM FORCE 
M2 (15-pin D-Sub) connector: 

 Global Alarm (Pins 7&8) - this contact is open when the 

DALLIS is running normally, and closes in the event of a 
DALLIS error.  

 Global Alarm Inverted (Pins 5&13) – this contact is 
closed when the DALLIS is running normally, and opens 
in the event of a DALLIS error. 

 PSU 1 (Pins 3&11, Pins 2&10) – these contacts are 

closed when PSU 1 is active and open if PSU 1 fails. 

 PSU 2 (Pins 1&9) – this contact is closed when PSU 2 is 

active and opens if PSU 2 fails. 

 Force second masterboard (M2) (Pins 14&15) – can 

be used to force a takeover to the redundant master 
board, if fitted.  

 The ALARM Connector 

The ALARM (BNC) connector also carries the Global Alarm 
signal (in parallel with the ALARM FORCE M2 D-Sub 
connector) described above. 
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Chapter 3: AdminHD 

Introduction 

Having installed the physical hardware components of the 
system, the next task is to programme and upload the system 
configuration. 

AdminHD is the software application used to configure all HD 
Core systems including the Nova73 routing matrix, Nova73 
Dual Self Healing Star (DSHS) and mc2 mixing consoles. This 

chapter is written to cover all products so look out for notes 
relating specifically to your system. 

AdminHD is used when a system is first installed to configure 
the cards and settings within the HD Core and DALLIS I/O 
units. It can also be used at any time to update the system 
configuration.  

In addition to configuration, AdminHD may run online to control 
matrix cross points, adjust signal labels or I/O parameters. You 
can also reset connections and I/O parameters by saving and 
loading snapshots from your computer. 

AdminHD  also provides a number of useful tools for system 
diagnostics and documentation. 

AdminHD and mxGUI 

From Version 4.8 software onwards, another programme – 
mxGUI – is available to complement AdminHD. The two 
programmes should be used as follows: 

 AdminHD – to prepare and upload system configuration 

files (i.e. define the hardware). 

 mxGUI – to control or prepare user settings. 

Both programmes can run online to remotely control a real 
system. AdminHD offers control of matrix cross points, signal 
labels and I/O parameters only. mxGUI emulates the GUI 
displays of the mc2 consoles, and therefore provides control of 
virtually any user parameter. 

Both programmes can also run offline to prepare a complete 
system ahead of an event. Use AdminHD to define the system 
configuration and transfer the configuration to the mxGUI 
control system on your computer. Then use mxGUI to prepare 
and save user settings by saving productions. Once connected 
to the final system, you can use mxGUI to transfer the 
AdminHD configuration and any productions from your PC to 
the mc2/Nova73 system. 

For more details on mxGUI, please refer to the “mc2 Operator‟s 
Manual” or “mxGUI User Guide for Nova73”. This chapter deals 
with AdminHD. 
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Topic Finder 

To find information on a particular topic, use the following links: 

 Overview – Page 87.  

 Software Installation - Page 96. 

 Getting Started 

o Basic Operation – Page 102. 

o Files & Organisation – Page 113. 

o Connecting to the System – Page 118. 

o System Configuration – Page 121. 

 Signal Lists – Page 159. 

 The „Connect Manager‟ – Page 177. 

 Systems Diagnostics – Page 180. 

 Documenting Your System – Page 187. 

 System Configuration: Reference Section – Page 191. 

 Nova73 DSHS Configuration: Additional Notes - Page 
207. 

 mc2 Configuration: Additional Notes – Page 212. 

 AdminHD Preferences – Page 227. 

 AdminHD Quick Reference Guide – Page 233. 
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Overview 

AdminHD and ControlHD 

When you install the AdminHD software, you may choose to 
install either of two applications – AdminHD and/or ControlHD. 

AdminHD is the administration programme and has three 
primary uses: configuration, control and system diagnostics. 

ControlHD is a subset of the AdminHD software. It looks and 
operates in an identical manner, but can only be used for 
control and system diagnostics. So, for example, users can 
adjust settings such as matrix cross points or I/O parameters 
using ControlHD, but they cannot modify the hardware 
configuration. 

By choosing to install only ControlHD on some computers and 
AdminHD on others, you can set up different computers for 
different users within the facility. 

Note that all the operations of ControlHD are available from 
AdminHD. For details, please see the “ControlHD Operator‟s 
Manual”. 

AdminHD Modes & Compatibility 

AdminHD is used to configure all HD Core systems including 
the Nova73 routing matrix, Nova73 Dual Self Healing Star 
(DSHS) and mc2 mixing consoles. 

To ensure that you are not able to configure HD or DALLIS 
cards which are not released for your product, the programme 
works in one of three modes: 

 mc2 console – mc256, 66 and 90 consoles. 

 Nova73 HD – Nova73 stand alone routing matrix. 

 Nova73 DSHS – Nova73 Dual Self-Healing Star system. 

When new hardware options or software features are released 
for any of these systems, then a new version of AdminHD is 
issued to enable their configuration. 

Note that configurations created for one type of system are not 
compatible with another. For example, you cannot open a mc2 
configuration with an AdminHD working in Nova73 HD mode. 
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Advantages of AdminHD 

The configuration files created by AdminHD are an essential 
part of the system. If a hardware component is not defined 
within the configuration, then it will not be visible to users even 
if it is powered and connected. In other words, the configuration 
is always the „master‟ of the system, regardless of what 
physical components are added or removed. 

This brings a number of advantages to the systems engineer: 

 The configuration is always controlled by AdminHD.  

 You can configure components which may not be 
permanently connected (e.g. Stageboxes) so that routes 
can be made to/from these devices without relying on a 
physical hardware connection. 

 You can easily test changes to the configuration offline. 
If a component or parameter is not available within the 
AdminHD software, then it is „illegal‟. This allows you to 
prepare configuration updates offline, and upload them 
to the system with confidence. 

 AdminHD allows you to upload configuration changes in 
one of two ways – either permanently to the cold start 
data (requires a system restart), or temporarily to the 
online system (no restart required). This allows you to 
make temporary changes online, and then later perform 
a cold start to reset the system for its normal 
configuration. 

 AdminHD can connect to the control system of mxGUI. 
This allows you to open mxGUI using a pre-prepared 
configuration in order to create user settings ahead of an 
event. 
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What Can Be Configured? 

AdminHD is used to create two separate configuration files: 

 config.tcl  

This is the main system configuration. It defines: 

 The System – the individual hardware components of 

the system such as the HD Core, DALLIS Units, etc.  

 System Parameters – system-wide parameters such as 

the sampling frequency of the HD Core, analogue and 
digital reference levels and synchronisation options. 

 Signal Parameters – for each individual signal, the 

Lawo system address (HLSD), signal name, signal label, 
I/O DSP and silence detect settings, and Group/Map 
settings (for use with external controller systems).  

 gui_config.tcl 

This is the Signal List configuration. It defines the organisation 
of signals within the Directories and Subdirectories of the 
system‟s Signal List display: 
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Uploading Configuration Data 

Having programmed a configuration on your computer, data is 
uploaded to the mc2, Nova73 or mxGUI control system via 

TCP/IP Ethernet:  

Configuration data may be uploaded in one of two ways: either 
permanently to the cold start data (requiring a system restart), 
or temporarily to the online system (no restart required): 

Cold Start Data 

To change the cold start configuration, you must upload the 
new configuration files (config.tcl, gui_config.tcl) from AdminHD. 
Then cold start the system for the changes to take affect. 

Cold start data is designed to reset the system back to a default 
state. i.e. with no user data loaded or latest settings. The 
configuration files stored within this area of the system should 
be used as the default configuration. This is the configuration 
which you can revert to at the end of a production to refresh the 
system for a “clean” setup. 

Warm Start Data 

Alternatively, temporary changes can be made to the online 
configuration without a restart. This method updates only the 
online configuration (held in memory) and does not affect the 
cold start data described above. 

If the system shuts down, then the online configuration is stored 
as part of the system‟s warm start data. (Warm start data is 
what is normally loaded following a power on or reboot.) This 
means that providing you do not cold start the system, any 
changes made will remain intact. 
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Cold Start vs Online Configuration 

When choosing which method to use, bear in mind the following 
points: 

Warning 

Warm start data is temporary. Therefore, if the system is „cold 
started‟, any updates to the online configuration are lost. 

Only the system configuration can be modified online. To 
modify the Signal List configuration, a new gui_config.tcl file 
must be uploaded and a cold start performed.  

As a result we recommend the following: 

 ALWAYS upload to the cold start data for permanent 

changes to a system configuration. 

 To modify the GUI‟s Signal List, you must upload a new 

gui_config.tcl file and perform a cold start. Therefore, any 
accompanying system configuration changes should be 
made to the cold start data (by uploading a new config.tcl 
file). 

 If the system configuration is updated online (without a 
restart), then any new signals can be controlled from the 
Connect Manager or remote MNOPL, but not from the GUI‟s 
Signal List (see above). 

Downloading Configuration Data 

To help modify existing configurations, you can also transfer 
files in the opposite direction – from the system to AdminHD. 
This process is called a Download.  

If you are updating an existing configuration, it is good practice 
to download the existing configuration to your AdminHD 
computer, and then modify it. This way you can be sure that 
you are editing the latest data.  

Within a networked installation, you can upload to or download 
from any system on the network, providing convenient control of 
updates from any network access point. 

Working with mxGUI 

You may also upload or download files to or from the local 
Control System of mxGUI. This allows you to transfer 
configuration data to mxGUI so that you can prepare user 
settings to match. 

Make sure that any productions you create are stored together 
with the accompanying AdminHD configuration data in mxGUI‟s 
shared folder. For more details on mxGUI, please refer to the 
“mc2 Operator‟s Manual” or “mxGUI User Guide for Nova73”. 
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Online Control – The ‘Connect Manager’ 

In addition to configuration, AdminHD can be used for control: 

The AdminHD computer must be connected to the system via 
TCP/IP Ethernet. Once you have downloaded the system‟s 
configuration and switch to online mode, you may use the 
„Connect Manager‟ window to control: 

 Matrix crosspoints – from any input to any output. 

 Edit signal labels – online renaming of signal labels. 

 Control I/O parameters – for example, to adjust 

microphone preamp gain, high pass filter switching, etc. 

 Save and recall snapshots – to reset any number of 

signals, with partial or global recalls. A snapshot stores 
connections to or from a signal, the signal‟s label and 
I/O parameter values. 

Note that the features of the „Connect Manager‟ are covered 
separately within the “ControlHD Operator‟s Manual”. 

Note also that from Version 4.8 software onwards, mxGUI 
provides an alternative interface for these parameters and 
more. Please refer to the “mc2 Operator‟s Manual” or “mxGUI 
User Guide for Nova73”.  
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Signal Lists 

Within AdminHD, you can choose whether the „Connect 
Manager‟ has access to all signals within the system, or a 
subset. For example, you may wish to provide different 
ControlHD users with access to different parts of the routing 
matrix. This can be achieved by creating a signal list for each 
ControlHD client. 

A signal list is an AdminHD file which orders source and 
destination signals into Directories and Subdirectories. It can be 
used for one of two purposes: 

 In AdminHD or ControlHD, a signal list can be opened 
within the „Connect Manager‟ in order to view signals in 
custom named Directories and Subdirectories, or to limit 
the signals to a subset of the matrix. 

 In mc2 or Nova73 systems, the signal list configuration 
(gui_config.tcl) generates the GUI‟s Signal List display. 

Signal lists are created by the „Signal List Editor„ and stored as 
separate .slx files to the main configuration (.csv file): 

You may create multiple signal lists which all relate to the same 
configuration if you wish. For example, you may issue different 
signal lists to different ControlHD clients around the facility. 
Each ControlHD client can then open their signal list within the 
„Connect Manager‟ to control a subset of the matrix. 
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System Diagnostics 

When running online, AdminHD can also help monitor the 
status of the hardware within a system. 

Note that this feature is also available in ControlHD. 

The AdminHD computer must be connected to the system via 
TCP/IP Ethernet and operating in online mode. Once online, 
you can use the „Core Browser‟ and „Graphic View‟ windows to 
monitor the actual status of hardware components within your 
system: 

Components in red are faulty; components in green are 
operating normally. 
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Documenting Your System 

Finally, AdminHD can help you document your system once 
you have programmed your configuration. 

Save Images 

You can save the „Graphic View‟ of system components such 
as the HD Core and DALLIS units. In mc266 mode, you can 
also copy the „Console Panel‟ which shows the layout of the 
control surface. These images can then be distributed to other 
users or staff within the facility: 

Export a Component Parts List  

You can export a component parts list as a .csv file. This can 
be opened in a 3rd party editor, such as MS Excel, to produce a 
parts list of all system components: 
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Software Installation 

This section describes the system requirements for your 
AdminHD/ControlHD computer, and guides you through the 
software installation process. 

Note that when you install the software, you may choose to 
install ControlHD, AdminHD or both. This allows you to set up 
different computers for different users within the facility. 

System Requirements 

The software is designed to be used with a PC. To install and 
run the software, your computer must meet or exceed the 
following requirements: 

 Hardware: Pentium® -PC 500MHz or higher 

 Operating System.: Windows XP, Vista, Windows 7 or  

 MAC OS X 

 Hard Disc:  200 MB free space 

 Operation: Keyboard and mouse 

 Interface:  Ethernet 10/100Mbit 

Installing the Software 

AdminHD is delivered in a compressed format. In order to run 
the programme, the Installation Wizard installs the programme 
files on your PC.  

Warning 

Before you start the installation, make sure the system 
requirements mentioned above are met. 
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To install the programmes onto your computer: 

1. Insert the Software CD into your CD-ROM drive. 

2. In the file system, open the AdminHD folder. 

3. Double click on the application “install.exe” (Windows) 
or “install.bin” (Linux) to start the installation. 

The Installation Wizard is decompressed and starts as follows: 

4. Read the on-screen instructions and proceed by clicking 
on Next. 

5. Choose whether you wish to install AdminHD, 
ControlHD or both programmes by making a selection – 
in our example, AdminHD - and click on Next: 
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You are now asked to choose an install folder: 

By default, files are installed in the location: „C:\Program 
Files\Lawo/AdminHD‟.  

6. Select Choose if you wish to select a different install 
folder, or click on Next to continue. 

Next you are asked to select a location for the programme 
shortcut: 

By default, the programme will be added to a new Program 
Group called AdminHD. Note that for the remainder of this 

manual, we will assume that you have chosen the default 
location. 

7. Choose one of the alternatives if you wish, or click on 
Next to continue. 
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The Install Wizard gives you an overview of the specified data: 

Select Previous if you want to change any of these settings. 

8. Click on Install to confirm your settings and start the 

installation. 

The software is installed on your PC. This may take a few 
minutes: 
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When the installation is complete, the following window 
appears: 

9. Click on Done to exit the Install Wizard. 

Your selected programme is completely installed and ready to 
use. There is no need to restart your computer. 

If you have any problems installing the software, then please 
contact your local Lawo representative or email 
service@Lawo.de. 

Uninstalling the Software 

If you wish to uninstall AdminHD or ControlHD, then use the 
“Add or Remove Programs” option within the Control Panel of 
your operating system. 
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Getting Started 

The next four sections will guide you through: 

 Basic Operation – how to start AdminHD and navigate 

around an existing configuration. 

 Files & Organisation – how to organise the files 

created by AdminHD and where they are stored. 

 Connecting to the System – how to connect your 

AdminHD computer to the system or mxGUI. 

 System Configuration – how to download, edit, and 

upload a system configuration. 

Note that these sections apply to all Lawo products (Nova73, 
Nova73DSHS and mc2) and aim to get you using the software 
as quickly as possible.  

For further details, please see: 

 System Configuration – Page 191 – reference section 

covering all system configuration parameters. 

 Nova73DSHS Configuration - Page 207 – additional 

notes for DSHS users. 

 mc2 Configuration – Page 212 – additional notes for 

mc256, mc266 and mc290 users. 

If you already have a system configuration and want to learn 
more about the following applications, then follow these links: 

 Signal Lists – Page 163 – how to create a signal list 

using the „Signal List Editor‟. 

 Systems Diagnostics – Page 180 – how to fault find 

components online, use the „Remote Log‟ window, and 
download system message logs. 

 Documenting Your System – Page 187 – how to copy 

images of the system or export a parts list. 

 Online Control – Page 177 - how to use the „Connect 

Manager‟. 

For an overview of all AdminHD‟s menu options and Toolbars, 
see the Quick Reference Guide at the end of the chapter - Page 
233. 
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Getting Started: Basic Operation 

Starting the Programme 

1. Start the software, by selecting START -> Program 
Files -> AdminHD -> AdminHD, or clicking on the 

shortcut icon. 

The ‘Operating Console’ opens. This is the main operating 
window for the AdminHD software and will appear blank until 
you open a configuration: 

The „Operating Console‟ consists of: 

 Main Menus - access to the File, Remote, Extras, 
Window and ? menus. 

 Toolbar – fast access to the programme‟s most 

common functions and sub windows. Note that many 
functions are not available until you have opened a 
configuration; some functions are only available once 
AdminHD is running online. 

 Sub Window Area - beneath the Toolbar is the main 

area of the Operating Console in which you can open a 
variety of sub windows such as the „Core Browser‟, 
„Remote Log‟, etc. 

 Status Bar - at the very bottom of the display you will 

see the Status Bar. This shows information relating to 
the programme such as the AdminHD mode and 
whether AdminHD is online or offline.  

Note that depending on the settings within the Extras -> 
Preferences -> Startup pop-up, the „Core Browser‟ or „Remote 
Log‟ sub windows may open automatically when you start 
AdminHD. See Page 227 for details. 

 

 



 
AdminHD 

Getting Started: Basic Operation 

mc266 MKII Technical Manual V4.10/2 103/ 303 

Opening a Saved Configuration 

Many of the menu and Toolbar functions remain unavailable 
until you have opened a configuration. 

If you don‟t have a configuration on your computer, then go to 
Page 121 for details on programming your first configuration. 

1. Click on the Open existing config button from the 
Toolbar. 

Alternatively, press CTRL + O on your computer keyboard, or 
select the File -> Open option from the main menu bar. 

2. Choose the filename of your configuration – in our 
example TVProduction_Config.csv. 

The configuration opens and you will see the structure of the 
system appear within the ‘Core Browser’ on the left hand side of 
the display; the AdminHD mode is shown within the Status bar: 

3.  If you can‟t see the „Core Browser‟ then open it by 
clicking on the appropriate button from the Toolbar. 

Rather than File -> Open, you can use File -> Open recent to 

select a recently opened configuration: 
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The System 

Within the „Core Browser‟, the hardware of your system is 
represented using a tree-like structure: 

1 System At the top of the tree is the System. Each 
configuration consists of a single System 
which contains all the hardware 
components for your installation. 

2 Core Within the System, you may define the 
type of HD Core.  

Note that in Nova73 or mc266 mode, each 
system consists of a single Core. In 
Nova73 DSHS mode, you can add up to 
two Cores representing one side of the 
„star‟. 

3 Modules Next, you fit the Core with Modules. In 
the example opposite, Core 1 is fitted with 
an AES 3 Module in slot 2, a MADI 
Module in slot 4, etc.  

Note that any standard components, such 
as the Router module, main PSU and 
Redundant PSU are added automatically 
when you define the Core. 

4 Ports Each Module can then be opened to view 
its I/O Ports.  

In the case of an AES 3 Module, this 
provides access to the AES inputs and 
outputs on the module.  

In the case of a MADI or ATM module, 
then the ports can be connected to 
ancillary devices, known as Super-
Devices, such as a DALLIS unit.  

5 Cards Super-devices, such as the DALLIS, are 
fitted with Cards. In our example, Card 1 
is a Mic/Line card providing 4 signal 
inputs. 

6 Signals At the lowest level of the system tree are 
the signals themselves – in our example, 
Signal In 1 to 4. 

The component options which can be added to the system are 
governed by the AdminHD software release and the AdminHD 
mode. This ensures that you can never add or configure „illegal‟ 
components or parameters! 
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The ‘Core Browser’  

The „Core Browser‟ is used to navigate around, and add 
components, to your configuration: 

1. To show or hide the „Core Browser‟, click on the 
appropriate button from the Toolbar, press Ctrl + SHIFT 
+ B on your computer keyboard, or select the Window -
> Core Browser option from the main menu bar. 

Note that the „Core Browser‟ may be set to open automatically, 
when you start AdminHD, within the Extras -> Preferences -> 
Startup menu. See Page 227 for details. 

Depending on how the configuration was last saved, some of 
the System branches may already be open. 

2. Click on the + sign next to an entry to open up a branch 
of the system. 

The sub components within that branch become visible. 

3. Click on the – sign next to an entry to close the branch. 

The branch collapses condensing the overview. 

4. Click on the Collapse or Expand buttons, on the „Core 
Browser‟ toolbar, to show or hide entries within a branch. 

You can also navigate around the system tree using the arrow 
keys on your computer keyboard: 

 Up arrow = up 

 Down arrow = down 

 Left arrow opens a branch 

 Right arrow closes a branch 

 Adding System Components 

When programming a configuration, you can use the Core 
Browser to add components as follows: 

1. Select a component – e.g. System – and right-click. 

A drop-down menu appears listing the available options. In our 
example, we can select the type of HD Core we wish to add to 
the system. 

2. Make the selection. 

The Core is added to the System tree. 

For more details on using the „Core Browser‟ to configure a 
system, see Page 121.  

For a quick guide to the „Core Browser‟ Toolbar, see Page 233. 
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 Signal Summary 

1. If you open up all the branches of the system tree you 
can view the signals.  

2. Point your mouse over a Signal In or Signal Out and a 
summary will appear showing all the parameters for that 
signal: 
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The Operating Console Sub Windows 

The „Core Browser‟ is just one of seven sub windows which can 
be opened from the Toolbar, from the Window main menu, or 

using a keyboard shortcut.  

1. Click on Toolbar buttons 7 to 13 to open or close a sub 
window as follows: 

7 

 

Core Browser - here you can navigate around 
the system and add system components. 

8 

 

Parameter Box - this window is used to display 

or enter settings for the component or signal 
selected within the „Core Browser‟. 

9 

 

Graphic View - this window shows a graphical 
representation of the hardware component 
selected within the „Core Browser‟. 

10 

 

Console Panel – only available in mc266 mode, 
this window is used to configure the console 
control surface. 

11 

 

Signal List – here you can create signal lists 
for use with the „Connect Manager‟ or mc266. 

12 

 

Connect Manager – here you can control the 
system online to set matrix cross points, edit 
signal labels, control I/O parameters or 
save/recall snapshots. 

13 

 

Remote Log - this window logs all the 
messages generated by AdminHD or the HD 
Core. 

Note that some of the Toolbar buttons may be unavailable 
(greyed out). For example, „Graphic View‟ is not available 
unless a suitable hardware component, such as a Core or 
DALLIS, is selected within the „Core Browser‟, while the 
„Console Panel‟ is only available in mc266 HD mode, etc. 

Toolbar buttons 1 to 6 are used for file management and 
upload/download functions. See Page 236 for details. 
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The seven sub windows are rarely used in isolation and tend to 
be used in different combinations depending on the application.  

For example, during configuration you will most likely work with 
the „Core Browser‟, „Graphic View‟ and „Parameter Box‟: 

To control the system online, you might combine the „Connect 
Manager‟ with the „Remote Log‟: 
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Arranging the Sub Windows 

AdminHD allows you to close, minimize, resize or move 
windows as follows.  

Note that not all options are available for all windows. For 
example, the „Core Browser‟ cannot be minimized or moved, 
while the „Graphic View‟ cannot be resized. 

1. Click on the  button to close a window: 

2. Click on the  button to minimise a window. 

Minimized windows are reduced to a button, for example: 

3. Click on the button to restore the window to its original 

size and position. 

4. To change the width of a window, point to the left or right 
margin of the window. When the pointer is displayed as 
horizontal double-headed arrow you can drag the 
margin to the left or right.  

5. To change the height of a window, point to the upper or 
lower margin of the window. When the pointer is 
displayed as vertical double-headed arrow you can drag 
the margin up or down.  

6. To change the height and width at the same time, point 
to one of the corners of the window. When the pointer is 
displayed as diagonal double-headed arrow you can 
drag the margin in any desired direction. 

7. Some windows can be moved within „Operating Console‟ 
– for example, the „Graphic View‟. To do so, place the 
mouse pointer over the title bar of the window, left click 
and hold the mouse button down while you drag the 
window to its new position. Release the mouse button to 
release the window. 

Let‟s take a closer look at some of the sub windows: 
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‘Graphic View’ 

The „Graphic View‟ window shows a graphical representation of 
the hardware component selected within the „Core Browser‟, 
and can display any type of HD Core or DALLIS unit:  

1. To show or hide the „Graphic View‟, click on the 
appropriate button from the Toolbar, press Ctrl + SHIFT 
+ F on your computer keyboard, or select the Window -
> Frame editor option from the main menu bar. 

Note that the „Graphic View‟ cannot be opened unless a valid 
hardware component is selected in the „Core Browser‟ – in 
other words, you MUST select a component within the HD 
Core, or within a DALLIS, before the „Graphic View‟ becomes 
available.  

2. As you navigate around the system configuration using 
the „Core Browser‟, the „Graphic View‟ updates to show 
the selected component. 

If you select an entry in the „Core Browser‟ for which no 
graphical view is available (e.g. System), then the „Graphic 
View‟ closes automatically. 

 Fitting Modules or Cards 

When programming a configuration, you can use the „Graphic 
View‟ to add modules to a Core or cards to a DALLIS as 
follows: 

1. Select a card slot and right-click. 

A drop-down menu appears listing the available options. In our 
example, we are selecting an analog mic card for the DALLIS. 

2. Make the selection. 

The card is added to the DALLIS within the ‘Graphic View’ and 
‘Core Browser’ on the left of the display. 

For more details on using the „Graphic View‟ to configure a 
system see Page 121. Or for system diagnostics see Page 180.  

 

 

 

 



 
AdminHD 

Getting Started: Basic Operation 

mc266 MKII Technical Manual V4.10/2 111/ 303 

The ‘Parameter Box’ 

The „Parameter Box‟ is used to display or enter settings for the 
component or signal selected within the „Core Browser‟: 

1. To show or hide the „Parameter Box‟, click on the 
appropriate button from the Toolbar, press Ctrl + SHIFT 
+ P on your computer keyboard, or select the Window -
> Parameter Box option from the main menu bar. 

The „Parameter Box‟ can also be opened directly from the „Core 
Browser‟ by double-clicking on the component.  

2. Now navigate through the system components using the 
„Core Browser‟ and note how the „Parameter Box‟ 
updates to show the settings for the currently selected 
component. 

Note that for some components, there are multiple pages of 
parameters – in our example, Data, System Settings and Map. 

3. Click on the tabs at the top of the „Parameter Box‟ to 
change between pages. 

Grey parameter fields (e.g. Router module type) are for 
information purposes only and cannot be modified. 

White parameter fields can be edited and saved within the 
configuration.  
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The Remote Log 

This window logs all the messages generated by AdminHD, and 
the system when AdminHD is running online. It is normally used 
to check for errors but can also be useful for confirmation of 
operations such as uploads or downloads: 

1. To show or hide the „Remote Log‟, click on the 
appropriate button from the Toolbar, press Ctrl + SHIFT 
+ L on your computer keyboard, or select the Window -
> Remote Log option from the main menu bar. 

Note that the „Remote Log‟ may be set to open automatically, 
when you start AdminHD, within the Extras -> Preferences  -> 
Startup menu. See Page 227 for details. 

The „Remote Log‟ logs all messages while AdminHD is running. 
If you exit AdminHD and re-open it, then the previous log is lost. 

You can save the „Remote Log‟ at any time as a text file. For 
example, you may be asked to do this by a Lawo service 
engineer. You can also choose to clear the „Remote Log‟ to get 
a better overview of an event or operation. See Page 183 for 
details. 

 

That completes our tour of the main configuration sub windows. 
Follow these links for details on: 

 The Console Panel Configurator – Page 213. 

 The Signal List Editor  – Page 163. 

 The Connect Manager –  Page 177. 
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Getting Started: Files & Organisation 

AdminHD can be used to create a number of files relating to the 
system. This section looks at how these files are created and 
where they are stored. 
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Files Stored on the System 

Depending on whether your product is a Nova73 or mc2 
console, each control system holds a number of configuration 
files within its cold start data: 

 config.tcl - this is system configuration file and is what 

defines the HD Core, DALLIS and their signal 
parameters. This file can be edited by AdminHD. 

 gui_config.tcl – this is the Signal List configuration file 
which defines the GUI‟s Signal List display. This file 

can be edited by AdminHD. 

 console_config.tcl – this is the console configuration 

file which defines the layout of the control surface. In 
MKI mc266 consoles, this file can be edited by 
AdminHD. For all other systems, it is factory-configured. 

 custom.tcl – this file stores customer-specific functions 
such as fader starts, etc. It is factory-configured and 
must be edited by the Lawo configuration team.  

 Custom_template_instances – this folder stores the 
custom functions programmed from the GUI‟s Custom 
Functions display. Each function is stored as a 
separate .tcl file within this folder. The Custom 
Functions display can be accessed from the console 
GUI or mxGUI providing the display is enabled. Please 
refer to the “mc2 Operator‟s Manual” or “mxGUI User 
Guide for Nova73” for more details. 

All settings stored within the system configuration (config.tcl) 
may also be uploaded to the online configuration. However, if 
the system is “cold started”, then this data is lost and you will 
need to upload the data again from AdminHD. 

Note that the Signal List configuration (gui_config.tcl) can 
ONLY be uploaded to the cold start data. Therefore, to update 
the Signal List display, you must be prepared to cold start the 
system. 
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Files Stored on Your AdminHD Computer 

AdminHD creates a number of files which you will need to 
organise on your computer: 

If you are working within a networked installation and have 
different configurations for the different studios/OBs, then you 
should create a separate folder for each system on your 
computer. This will help keeps all files relating to each individual 
system together in one location. 

Config.csv 

This file is created when you save the current AdminHD 
configuration on your computer (using File -> Save or File -> 
Save As). It is a .csv file which can be opened by AdminHD, 
ControlHD or imported into a 3rd party editor such as MS Excel.  

You can give this file any name as long as it keeps the .csv 
suffix, so choose something descriptive – e.g. OB1Config.csv. 
It is a good idea to keep the word Config in the name to 
distinguish this file from other AdminHD .csv files. 

Remember to save all your configurations as config.csv files so 
that they may be opened and uploaded at a later date. 

.tcl Files 

The config.tcl and gui_config.tcl files are exported from 
AdminHD before you upload them to the system. This ensures 
that you keep a backup copy of all .tcl files on your computer. 

DO NOT rename the files, otherwise they cannot be read by the 
system! DO NOT edit the .tcl files under any Windows 
application except AdminHD as this may damage the files.  

You should only ever have one current cold start configuration 
for each system as this is your default system starting point. 
However, it is a good idea to keep backup copies of „older‟ 
configurations, especially your factory configuration, on your 
PC. So store them in a subfolder or change the filename. 
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Signallist.slx 

This file is created when you save a Signal List within the 
„Signal List Editor‟. It is a .slx file which can only be opened by 
AdminHD or ControlHD. You will need to copy this file to other 
AdminHD or ControlHD computers if you wish to open the 
Signal List within the „Connect Manager‟. 

You can give the file any name you like as long as it keeps 
the .slx suffix. If you are creating multiple signal lists for different 
ControlHD/AdminHD users, then choose something descriptive 
– for example, AudioControl.slx, VideoGallery.slx.  

The GUI_Config.tcl file is created by exporting the signal list. 

Systemlist.csv  

This file can be exported from AdminHD and saved on your 
computer if you wish to generate a parts list for all the hardware 
within your configuration. Having exported the file, you can 
open it within a 3rd party editor such as MS Excel, in order to 
print or view all the components. 

Connectionlist.csv  

This file can be exported from AdminHD‟s „Connect Manager‟. 
Having exported the file, you can open it within a 3rd party editor 
such as MS Excel, in order to print or view all matrix crosspoints 
set within the system. 

Config.bfe  

This file can be exported for use with a BFE controller system. 
This feature is project-specific, so please contact your local 
Lawo representative or email service@Lawo.de for more details. 

Remote.log 

This file can be exported if you wish to save a copy of the 
„Remote Log‟ window (system diagnostics) as a text file: 

You may be asked for this file if you request assistance from 
the Lawo service department. 

 

mailto:service@Lawo.de
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System_log_message.log 

In addition to AdminHD‟s Remote log, the system itself 
generates and stores error messages. These can be 
downloaded from the system and saved on your computer as a 
text file.  

SnapX.lsn 

You can save and recall snapshot files from your AdminHD or 
ControlHD computer in order to reset matrix crosspoints or I/O 
parameters online via the „Connect Manager‟.  

If you are creating snapshots for multiple systems, then store 
them within separate folders on your computer. 



 
AdminHD 
Getting Started: Connecting to the System 

118/ 303 V4.10/2 mc266 MKII Technical Manual 

Getting Started: Connecting to the 
System 

When you programme a configuration, you do not need to be 
connected to the system. However, to upload or download 
configuration data, or to control the system online, you will need 
to connect to the Control System of your console or Nova73. 

Note that you can upload or download data to/from mxGUI by 
starting the mxGUI programme on your computer, and entering 
its virtual IP address (192.168.56.101) during the upload or 
download procedure. See Pages 122 and 153 for details. 

For mc2 or Nova73 systems, connect your AdminHD computer 
to the system‟s Ethernet network, and configure its TCP/IP 
settings as follows: 

Network Connection 

Your AdminHD computer must be connected to the ETHERNET 
port of the control system. Depending on your product, the 
control system may be located on the Router Module of the HD 
Core, within the console control surface or within an external 
matrix control server (ripper PC). For specific details, please 
refer to Chapter 2: Installation: System Connections. 

For connection to multiple computers via a network switch, use 
a straight (1:1) network cable (STP-CAT 5 with RJ45 
connectors on both sides). 

Note that you must use a network switch (included with the 
system) and NOT a Hub. 
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TCP/IP Configuration 

To establish communication, you will need to configure the 
TCP/IP settings for your computer‟s Network Interface card.  

You can find information on configuring TCP/IP settings within 
Windows from www.microsoft.com. 

For a direct connection, set the IP Address and Subnet Mask as 
follows: 

IP Address 

Depending on your Lawo product, the default TCP/IP address 
of the system varies as follows: 

 Nova73 = 192.168.102.1 

 mc256 = 192.168.102.56 

 mc266MKI = 192.168.102.65 

 mc266MKII = 192.168.102.65 

 mc290 = 192.168.102.90 

If a redundant control system is fitted then its address will be 
one digit higher than that of the main control system. 

The IP Address of your computer‟s Network Interface card must 
be unique, and set within the same range as that of the system. 
So, for example, to connect to a new mc266, you could set the 
computer‟s IP Address to 192.168.102.69. 

Take care when setting the IP address of the system. If there is 
an IP conflict within the network, then the Nova73 or mc2 
system may not operate correctly. 

Subnet Mask  

The Subnet Mask of your computer‟s Network Interface card 
should be identical to that of the system. For all products, the 
default Subnet Mask is 255.255.255.0. 

 

In a networked installation, it is likely that you will be connecting 
via an Ethernet switch, so please consult your network 
administrator for further details. 

 

http://www.microsoft.com/
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Checking the Connection 

If you are new to AdminHD and have no configuration loaded 
within the programme, then the easiest way to check your 
network connection is to download the configuration from your 
system. Details on this operation can be found on Page 122. 

Alternatively, if you have a configuration for the system open, 
then you can simply enable online mode as follows: 

1. Click on the appropriate button from the Toolbar, or 
select Remote -> Online to remote system from the 
main menus: 

AdminHD connects to and synchronises with the system. The 
online status is displayed in the Status bar: 

If there is a problem with the connection, check the „Remote 
Log‟ as this will show that the connection has timed out. 

If this occurs, check your connections and the TCP/IP settings.  

Note that you may need to disable your computer‟s firewall to 
make the connection. 

You can also test your network connection to the system using 
a „Ping‟ command – see Chapter 4 for details. 

 

 

 

 

 



 
AdminHD 

Getting Started: System Configuration 

mc266 MKII Technical Manual V4.10/2 121/ 303 

Getting Started: System Configuration 

In this section you will learn how to download, edit, and upload 
a new configuration. 

There are two approaches you can take when creating a new 
configuration: 

The easiest method, if you can connect to your system, is to 
download the existing configuration data from the system and 
then edit it offline. 

Alternatively, if you don‟t have a connection to your system yet, 
then you can create a configuration from scratch. 

In either case, it is vital that your system configuration matches 
that of your physical hardware in order for the system to 
operate correctly. 

Let‟s look at each approach. 
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Downloading a Configuration 

If you have established a connection between your AdminHD 
computer and the system, then the easiest way to create a new 
configuration is to download the existing data and update it! 

Note that when you download the configuration, you will 
download the current data (stored in online memory). 
Therefore, to download the cold start configuration, reset the 
system by performing a cold start. 

Then follow the same instructions as you did to check your 
network connection: 

1. Close your current AdminHD session by selecting File -
> Close from the main menus. 

2. Open a New configuration by selecting File -> New and 
choose your system from the drop-down menu: 

 mc² console – to open a mc²56, 66 or 90 configuration 

 Nova73 HD – to open a Nova73 configuration 

 Nova73 DSHS HD – to open a “dual self healing star” 

configuration. 

When connecting to mxGUI, choose the correct option for your 
mxGUI emulation. For example, if mxGUI is running in mc256 
mode, select the mc2 console option. 

Warning 

Please note that configurations created for one type of system 
are not compatible with another, and you CANNOT change the 

mode later. So make sure you select the correct system for 
your installation! 

3. Click on the Download button from the Toolbar, or select 
Remote -> Download all data to remote HD from the 
main menus: 
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A pop-up appears asking you to confirm the TCP/IP address of 
the system from which you wish to download: 

4. Enter the TCP/IP address of the system you wish to 
connect to. 

The default TCP/IP address is automatically entered so you will 
only need to edit it if your system has a different IP address. 

To connect to the local Control System of mxGUI, enter 
192.168.56.101 – this is the virtual IP address of mxGUI. 

Note that the „Remote connection‟ pop-up will vary depending 
on your product.  

5. Then click Connect. 

AdminHD now downloads the configuration from the system. 

When the download is complete the „Remote Log‟ report that 
the download has been successful, and any open windows 
such as the „Core Browser‟ update with the new system: 

If there is a problem with the download, check your connections 
and the TCP/IP settings. Or try disabling your computer‟s 
firewall.  

 

 

 

 



 
AdminHD 
Getting Started: System Configuration 

124/ 303 V4.10/2 mc266 MKII Technical Manual 

Creating a New Configuration 

If you do not have a connection to the system, then you will 
need to create a new configuration from scratch as follows: 

1. From the File menu, select New: 

2. Choose one of the options from the drop-down menu: 

 mc² console – to create a mc²56, 66 or 90 configuration 

 Nova73 HD – to create a Nova73 configuration 

 Nova73 DSHS HD – to create a “dual self healing star” 

configuration. 

When creating a new configuration to run within mxGUI, choose 
the correct option for your mxGUI emulation. For example, to 
create a configuration to run in mc256 mode, select the mc2 
console option. 

Warning 

Please note that configurations created for one type of system 
are not compatible with another, and you CANNOT change the 
mode later. So make sure you select the correct system for 
your installation! 

After creating the new configuration, you will see the entry 
System within the ‘Core Browser’ window and confirmation of 
the AdminHD mode in the status bar: 
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Defining the System 

The AdminHD configuration defines the hardware components 
of your system. We will assume that you are building a new 
configuration from scratch, but the same principles apply to 
updating an existing configuration. 

When building a new configuration you will need to add the 
system components in the following order: 

 Add the HD Core. 

 Fit Modules to the Core. 

 Define the Module Ports. 

 Add a DALLIS or Tie-Line. 

 Fit Cards to your DALLIS units. 

Warning 

Before you begin, make sure that you have the specification of 
your physical installation to hand as it is important that all the 
components you specify match that of your physical installation.  

If they don‟t and you need to modify them later, you can only do 
this by deleting and adding the component. This will mean that 
you will lose any sub components and parameters which you 
may have programmed! 

Adding a HD Core 

The first step in any system configuration is to add the HD 
Core: 

1. Select the System entry in the „Core Browser‟ and right-
click. 

A drop-down menu appears listing the available options: 
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Depending on your AdminHD mode, you can select from the 
following HD Core types: 

 HD Core 3k (48kHz) – 3k capacity MKI router operating 

at sampling frequencies up to 48kHz. 

 HD Core 1.5k (96kHz) – 1.5k capacity MKI router 

operating at sampling frequencies up to 96kHz.  

 HD Core 8k (48kHz) - 8k capacity MKI router operating 

at sampling frequencies up to 48kHz. 

 HD Core 4k (96kHz) – 4k capacity MKI router operating 

at sampling frequencies up to 96kHz. 

 HD Core MK2 (48kHz) – 8k capacity MKII router 

operating at sampling frequencies up to 48kHz. 

 HD Core MK2 (96kHz) – 8k capacity MKII router 

operating at sampling frequencies up to 96kHz. 

2. Select the required Core capacity and maximum system 

clock frequency by making a selection. 

Warning 

The HD Core selection defines the Router module which in 
turn defines the functionality of the system. Once you have 
defined the Core, you CANNOT change the Router module type 

at a later stage. So make sure you select the correct option for 
your installation. 

The Core is added to the System tree.  

You will also see any default Core components appear within 
the „Core Browser‟ – for example, the Router module, main 
PSU and Redundant PSU. 

Depending on the settings within the Extras -> Preferences -> 
Common pop-up, the „Graphic View‟ will also automatically 
appear. See Page 227 for details. 
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Fitting Modules to the Core 

Next, fit modules to the core using the ‟Graphic View‟ as 
follows: 

1. Point your mouse over a card slot – e.g. Slot 2. 

The slot is outlined in orange. 

2. And right-click. 

A drop-down menu of module options appears.   

3. Make a selection from the list and remember to fit 
modules exactly as they installed within the HD Core. 

Note that the available options depend on the selected slot, 
your AdminHD mode, and the current capacity of the Core. 
Options not available for the selected slot are greyed out. 

For specific details on each module, please refer to its data 
sheet. See Appendix A for details. 

The fitted module appears within the ‘Graphic View’ and ‘Core 
Browser’: 
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Fitting a Redundant Router Module 

In addition to fitting DSP and I/O modules, you can also add a 
redundant router module: 

1. Point your mouse over the redundant router module slot. 

The slot is outlined in orange. 

2. And right-click: 

3. Select the available option. 

The redundant router module appears within the ‘Graphic View’ 
and ‘Core Browser’: 

Note that you can also add or remove a redundant router 
module from the „Core Browser‟: 

Or, from the Core‟s „Parameter Box‟, see Page 192 for details. 

To configure a redundant MKII Router Module (980/33), select 
the HD Core 8k (48kHz), or HD Core 4k (96kHz), option. 
Although the graphical overview of AdminHD shows a Mk I 
Router Module, this configuration also support MKII cards. 
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Defining the Ports 

Each module can now be opened within the „Core Browser‟ to 
view its ports. The „port‟ represents an interface type. For 
example, on a 981/02 AES card, Port 1 provides access to 64 
channels of AES inputs and outputs, while Port 2 accesses the 
MADI interface on the card. 

Depending on the type of port, you can either open it within the 
„Core Browser‟ to gain access to signals – for example, in the 
case of an AES Port: 

Or, you will need to define where/how the port is connected – in 
the case of a MADI or ATM Port: 

Note that: 

 DSP modules do not have audio ports. 

 Ports may be used for redundancy, see Page 136. 
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Adding a DALLIS or a Tie-Line 

In the case of a MADI or ATM port, you must define how the 
port will be used. You can choose between the following 
options: 

 Define a Tie-Line – a multi-channel connection. 

 Define a DALLIS – a connection to a DALLIS unit. 

Note that each of these options is known as a „Super-Device‟ 
within AdminHD. 

1. Select the appropriate port (e.g. Module 2 Port 2 MADI) 
and right-click: 

2. Make a selection – for example, Define Tie-line (64 

channels) 

The tie-line signals are added to the configuration, and can be 
accessed from the ‘Core Browser. 

3. Alternatively, select a DALLIS – e.g. DALLIS 3RU (80 

channels): 

The DALLIS is added to the configuration: 
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Fitting Cards to a DALLIS 

You can now fit cards to the DALLIS using the ‟Graphic View‟: 

1. Point your mouse over a card slot – e.g. Slot 1. 

The slot is outlined in orange. 

2. And right-click. 

A drop-down menu of card options appears:   

3. Make a selection from the list and remember to fit 
modules exactly as they installed within the DALLIS. 

Note that the available options depend on the selected slot and 
the current capacity of the DALLIS; options which are 
unavailable are greyed out. 

The card appears within the ‘Graphic View’ and its signals are 
added to the ‘Core Browser’: 

 

 

 



 
AdminHD 
Getting Started: System Configuration 

132/ 303 V4.10/2 mc266 MKII Technical Manual 

Copying DALLIS Cards 

If you are fitting several cards of the same type to a DALLIS, 
then you can copy and paste a card as follows: 

1. Point your mouse back over the card slot – e.g. Slot 1 - 
and right-click. 

This time the additional options of Copy and Cut appear at the 
bottom of the drop-down menu:   

2. Select Copy. 

The card is copied to AdminHD’s clipboard; the address of the 
card is shown in the status bar at the bottom of the display. 

3. Now select the card slot where you wish to copy to: 

4. Right-click and select Paste. 

The card is pasted into the configuration. 

5. Repeat steps 3 and 4 to quickly assign the same card to 
a number of slots. 

Note that the Paste function only becomes available when you 
select a valid destination. If the DALLIS runs out of capacity, 
then you will not be able to Paste the card. 

You can check how many audio channels are left for 
configuration in the title bar of the DALLIS. 

 

 

 

 

 



 
AdminHD 

Getting Started: System Configuration 

mc266 MKII Technical Manual V4.10/2 133/ 303 

Copying DALLIS Units or Tie-Lines 

If you have several DALLIS units with a similar card 
configuration, then you can use the Copy and Paste functions 
to copy a complete DALLIS. 

1. Select the DALLIS you wish to copy from the „Core 

Browser‟ and right-click: 

2. Select Copy DALLIS from the drop-down menu. 

The DALLIS is copied to AdminHD’s clipboard; the address of 
the DALLIS is shown in the status bar at the bottom of the 
display: 

3. Now select the Port where you wish to copy to: 

4. Right-click and select Paste DALLIS. 

The DALLIS is pasted into the configuration. 

Note that the Paste function only becomes available when you 
select a valid destination – in our example, an unassigned 
MADI port.  
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Deleting Components 

Depending on the component, it can be deleted or changed 
either from the „Core Browser‟ or „Graphic View‟. 

Warning 

Deleting or changing a component will delete any sub 
components and parameters. 

To delete a Core, or a Tie-Line or DALLIS, then: 

1. Select the component – for example DALLIS – within 
the „Core Browser‟ and right-click: 

2. Select Delete DALLIS from the drop-down menu. 

3. Confirm the deletion. 

The DALLIS is deleted from the configuration. 

To change or delete a Module or a DALLIS card: 

1. Point your mouse over the module or card slot within the 
„Graphic View‟. 

The slot is outlined in orange. 

2. And right-click: 

3. Select the empty option to remove the module. 

4. Or select a different module. 

5. Confirm the change. 

The Module and any connected components are deleted from 
the system. 
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Fibre Redundancy 

The type of master board fitted to your DALLIS is automatically 
defined by the type of Module which you fitted to the Core 
earlier.  

For example, if you fitted a 981/32 (2 x 2 MMF) MADI Module to 
your Core, and then connect this to a DALLIS, then the DALLIS 
is automatically fitted with a redundant fibre master board: 

However, if the connection to the DALLIS is added from a 
981/31 (2 MMF) Module, then the DALLIS is fitted with a single 
fibre master board: 

 

Just remember to always specify the type of Module and 
DALLIS which is fitted to your system and you can‟t go wrong! 
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Port Redundancy 

Alternatively, your system may employ port redundancy, where 
each master board within the DALLIS connects to a different 
port (preferably on a different Module) within the HD Core: 

Let‟s take an example, where the main connection to a DALLIS 
is from Module 4 Port 1. We have a spare port on Module 8 
Port 1 which we now want to use for the redundant connection: 

1. Select Module 4 Port 1 and double-click to open its 
„Parameter Box‟: 
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2. Tick the Is redundant box. 

The following pop-up will appear: 

3. Select the redundant port – in our example, Module 8 
Port 1 and click OK. 

The ports are now linked as indicated in the ‘Core Browser’: 

In addition, the „Parameter Box‟ for Module 4 Port 1 shows the 
address of the linked port within the Corresponding port box. 
This is described as a system address: 
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4. In addition, if you now select the DALLIS and look at its 
„Graphic View‟, you will see that a redundant master 
board has been fitted: 

You can configure the redundant port from the DALLIS „Graphic 
View‟ shown above: 

5. Right-click on the redundant board slot and select or 
unselect available to add or remove the link to the 
redundant port. 
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Port DSP Resources 

When you define a Tie-line or DALLIS which is 60-channels or 
less, you automatically configure an amount of DSP resource: 

This is DSP which is located on the port (i.e. within the HD Core 
module), and can be used to create additional mix matrices – 
e.g. 4x4 or 8x8. 

The selection of your Super-Device defines how many channels 
of DSP Resource are left for configuration. In our example, a 
52-channel DALLIS leaves two blocks of DSP Resources (4-
channels and 8-channels). 

To configure the application of the DSP Resources: 

1. Select the DSP Resources - e.g. DSP Resources (4 
channels) - and right-click: 

A drop-down menu appears listing the available options: 

2. Make your selection from the following: 

 Define Listen stereo – used for stereo monitoring in the 

mc266.  

 Define Matrix (4 * 4) – This option creates a summing 

matrix with 4 inputs and 4 outputs. 

Alternatively, if you select DSP Resources (8 channels) then 
the following options become available: 

 Define Listen surround – used for surround monitoring 

in the mc266.  

 Define Matrix (8 * 8) – This option creates a summing 

matrix with 8 inputs and 8 outputs. 

For details on the matrix summing capabilities, please refer to 
the data sheet for the DALLIS card. See Appendix A. 

 

 



 
AdminHD 
Getting Started: System Configuration 

140/ 303 V4.10/2 mc266 MKII Technical Manual 

Editing Parameters 

Having defined the hardware of your system, you can now 
adjust the default system and/or signal parameters: 

 Signal Parameters – for each individual signal you can 

edit the Lawo system address (HLSD), signal name, 
signal label, I/O DSP and silence detect settings, and 
Group/Map settings (for use with external controller 
systems).  

 System Parameters – you can also set system wide 

parameters such as the sampling frequency of the HD 
Core, analogue and digital reference levels and 
synchronisation options. 

Whether you want to change the operating frequency of the HD 
Core or rename a signal, the operation is essentially the same: 

1. Double-click on the component within the „Core Browser‟ 
to open its „Parameter Box‟ – for example, Signal In 1: 

2. Select the parameter page using the tabs at the top of 
the „Parameter Box‟ – for example, Signal, DSP, Map. 

3. Enter your new parameter or enable a check box. 

Note that grey parameter fields are for information purposes 
only and cannot be modified. White parameter fields and check 
boxes can be edited and saved within the configuration. 

You can find full details on all parameter options on Page 191. 
In this section, we will cover some common applications. 
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Signal Names and Labels 

For each individual signal, you can edit the: 

 Signal Name – this is the system name of the signal 

and should be unique. It can only be defined by 
AdminHD and should be used to describe the physical 
location of the signal. 

 Signal label – this is the default user label. Note that the 

signal label can be changed later, either within the GUI‟s 
Signal List display, or within AdminHD‟s „Connect 

Manager‟ window. However, it is a good idea to 
programme a default label as this is what the system will 
reset to after a cold start. 

Note that both the Signal Name and Signal Label are limited to 
a maximum of 8 characters. 

Editing a Signal Name or Label 

To edit a name or label: 

1. Open up the branches of the „Core Browser‟ so that you 
can see the signal you wish to edit. 

If you‟ve got the „Graphic View‟ open, then simply click on the 
card to navigate to the correct group of signals. Or, you can use 
the following short cuts on your computer keyboard to navigate 
through the system tree: 

 Up arrow = up 

 Down arrow = down 

 Left arrow opens a branch 

 Right arrow closes a branch 
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2. Double-click on the first signal you wish to rename – for 
example, Signal In 1. 

The ‘Parameter Box’ opens: 

3. Click in the Signal label field and type in the new name. 

4. Press Enter to confirm the name. 

Editing a Range of Signal Names or Labels 

Once the „Parameter Box‟ is open you can use the PAGE UP or 
PAGE DOWN keys on your computer keyboard to navigate up 
or down the system tree while retaining the selected field. This 
allows you to quickly step through and name a range of signals. 

Alternatively, if you want to name a range of signals with the 
same suffix – for example, PRES_1, PRES_2, PRES_3, etc. 
then you can use AdminHD‟s automatic naming feature: 

1. Name the first signal as above – for example, PRES_1: 
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2. Now press CTRL + SHIFT + PAGE DOWN on your 
computer keyboard. 

AdminHD steps down to the next signal in the system tree and 
automatically increments the name to PRES_2: 

3. Repeat step 2 for all signals you wish to name in the 
range. 

For details on other Signal Parameters, see Page 200. 
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System Parameters 

In addition to signal parameters, there are a number of system-
wide options: 

TCP/IP Address Configuration  

This parameter sets the TCP/IP address for your system and is 
used whenever you make a connection – for example, to 
upload or download data, or to run online. 

When you select your AdminHD mode, the default IP address is 
automatically entered for your system, so you will only need to 
edit these parameters if you are not using the default. 

To connect to the local Control System of mxGUI, enter 
192.168.56.101 – this is the virtual IP address of mxGUI. 

Note that the IP address parameters vary depending on your 
AdminHD mode. Our example shows a Nova73 system which 
communicates directly with the HD Core Router module. For 
details on mc2 consoles, see Page 212, or for a Nova73 DSHS 
system, see Page 207. 

1. Double-click on the Core within the „Core Browser‟ to 
open its „Parameter Box‟ and go to the Data page. 

2. Tick the Router module box to enable communication 

to the HD Core. 

3. Enter the IP address of the HD Core‟s main router 
module in the IP address router module field. 

The default IP address is shown opposite. 

4. If the HD Core is fitted with a redundant router module, 
then enter its IP address within the IP address 
redundant router module field. 
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Multi-channel Sync 

The system allows you to sync the HD Core to a multi-channel 
sync source.  

Note that for mc2 consoles, the system‟s sync options may be 
adjusted from the console‟s System Settings display. For the 

Nova73 this sync option must be set within the AdminHD 
configuration. 

1. Double-click on the Core within the „Core Browser‟ to 
open its „Parameter Box‟ and go to the Data page: 

2. Click on the Enable sync port box. 

A pop-up appears where you can select the multi-channel sync 
source: 

3. Select your sync source – for example, Module 4 Port 1 
MADI - and click on OK. 

The source is set and displayed within the Multi-channel sync 
port box as a system address – for example:  

For more details on synchronisation, please see Chapter 2: 
Installation. 
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Operating Levels 

You can use AdminHD to specify the operating levels for your 
system. 

Note that for mc2 consoles, these levels may be adjusted from 
the console‟s System Settings display. For the Nova73 these 

levels must be set within the AdminHD configuration. 

There are three level settings which interact to define the 
internal and analogue-to-digital operating levels of the system 
according to the following equation: 

 Analog full-scale level = Reference level + 
Headroom 

 Analog full-scale level (dBU) – This is the analogue 

level which you wish to correspond to digital full scale 
level (0dBFS). You can select from 12, 15, 18, 21 or 24 
dBU. 

 Reference Level (dBU) - This is the internal system 

reference level and sets the 0dB operating point for the 
system. The maximum reference level is 24dBU. 

 Headroom (dB) - This is the amount of internal 

headroom. 

Normal settings for EBU operation are: Analog full-scale level = 
+15dBU and Reference Level = +6dBU. Therefore, the 
Headroom = +9dB. 

Normal settings for US operation are: Analog full-scale level = 
+22dBU and Reference Level = +4 dBU. Therefore, the 
Headroom = +18 dB. 

Note that your system may be fitted with fixed level DALLIS 
analogue I/O boards. You may set the operating levels as you 
wish. However, if you were to set a Reference Level of say +24 
dBU, there may be clipping at a fixed level +15dBU analogue 
output board. 
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To set the levels for the system: 

1. Double-click on the Core within the „Core Browser‟ to 
open its „Parameter Box‟ and go to the System settings 
page: 

2. Select the Analog full-scale level from the drop-down 
menu options. 

3. Then select your Reference level by clicking on the up 
and down arrows. 

The resultant Headroom is calculated automatically. 
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Internal Sampling Frequency 

The HD Core supports internal sampling frequencies up to 
96kHz.  However, to operate at 96kHz the capacity of the Core 
is divided in half.  

Since this affects the components of the system, the maximum 
required sampling frequency (48kHz or 96kHz) must be defined 
at the beginning of the configuration, and is set when you define 
your type of Core, see Page 125. 

Having defined the maximum sampling frequency, you may 
then choose from the following options: 

 For higher capacity/lower sampling frequency HD Cores, 
you may operate at 44.1kHz or 48kHz. 

 For lower capacity/higher sampling frequency HD Cores, 
you may operate at 44.1kHz, 48kHz, 88.2kHz or 96kHz. 

Note that for mc2 consoles, the system‟s sample rate may be 
adjusted from the console‟s System Settings display. For the 
Nova73 the sample rate must be set within the AdminHD 
configuration. 

1. Double-click on the Core within the „Core Browser‟ to 
open its „Parameter Box‟ and go to the System settings 
page: 

2. Select the Sampling frequency (kHz) from the drop-

down menu options.  

The available options are defined by your choice of HD Core. 
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3rd Party Control Systems (Mapping Tables) 

Within your system, each signal may be given a mapping 
address so that it may be mapped to an external controller. For 
example, to be controlled by a 3rd party system such as the 
Thomson Jupiter, Broadcast Solutions VSM, BBC Colledia, etc. 

The control protocol used is Lawo‟s Remote MNOPL. This is a 
freely available protocol implemented by several manufacturers 
of leading control systems. If your preferred supplier does not 
support the protocol, then please ask them to contact Lawo for 
further details. 

Within AdminHD, up to 16 different mapping tables can be 
defined so that different control systems can be supported.  

Configure each mapping table (1 to 16) for each of your 
external control systems as follows: 

1. Double-click on the Core within the „Core Browser‟ to 
open its „Parameter Box‟ and go to the Map page: 

2. For your chosen mapping table (01 to 16), in the 
unknown signal address box, enter the address which 
will be submitted to the external control system when a 
signal is disconnected. 

3. In the no signal address box, enter the address which 
will be submitted to the external control system when an 
undefined source is connected to a defined destination. 

Refer to your external control system‟s documentation for 
details on how to enter these addresses. Our example shows 
the addresses for a Lawo zirkon control system. 

4. Now double-click on the first signal which you wish to 

map to the controller. 

This will open the signal’s ‘Parameter Box’. 

5. And select the Map page: 
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6. For your chosen mapping table (01 to 16), assign the 
Mapping table address for the selected signal. 

The format of the address will be specified by your external 
control system. 

7. Repeat for all other signals within the system which you 
wish to make available to the external controller. 

8. You can get an overview of the assignments within each 
mapping table by selecting Extras -> Show Mapping 
Table   -> Show mapping table x from the main menus 

9. For example, Mapping table 1 is assigned for control 
from a Lawo zirkon system: 
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Checking Your Configuration 

Having completed your configuration, it is a good idea to check 
it for programming errors. This will avoid any problems later 
when you upload to the system. 

1. Select Extras -> Check Configuration from the main 
menus, or press CTRL + K on your computer keyboard. 

AdminHD analyses your configuration. 

The configuration is checked for the following errors: 

 Signal HLSD Conflicts – if two signals have the same 

HLSD. 

 HLSD Syntax – if there is an invalid HLSD in the 

configuration. 

 Signal Name Conflicts – if two signals have the same 

name. 

 Mapping Table Address Conflicts – if you have 
assigned the same mapping table address to different 
signals. 

The result of the check is displayed within the status bar of the 
display: 

Saving Your Configuration 

While programming, you should always save your configuration 
regularly. 

Save 

If this is a new unsaved configuration, then save it for the first 
time as follows: 

1. Click on the Save button within the Toolbar, or select 
File -> Save from the main menus: 
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A ‘Save As’ file selection box appears: 

2. Select the directory in which you wish to save the file 
and enter a filename. 

You can specify a default directory for your configuration files 
within the Extras -> Preferences menu, see Page 227 for 
details. 

3. Click Save. 

The configuration is stored as a .csv file and the name and path 
are shown in the ‘’Operating Console’ title bar. 

4. From hereon, you can save any subsequent changes 
instantly by clicking on the Save button. 

Save As 

Alternatively, if you are editing an existing file, you may wish to 
save your changes under a different name. 

Repeat as above but select File -> Save As from the main 
menus. 
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Uploading a Configuration 

With your configuration saved as a .csv file on your AdminHD 
computer, you can upload it to the system at any time. 
Remember that you can upload to either the cold start data or 
online memory. 

Note that you must be running in online mode in order to upload 
a configuration to the system. This is to prevent any accidental 
uploads! 

When uploading to mxGUI, you should treat the mxGUI Control 
System like any real mc2 or Nova73. In other words, you must 
be running in online mode. And to see the affects of changing 
the cold start configuration, you must cold start mxGUI.  

Upload to the Cold Start Data 

For permanent changes to the configuration, you should upload 
the configuration to the cold start data. There are three stages 
to the process: 

 Export the system configuration as a cold start file 
(config.tcl). 

 Upload the cold start file to the system. 

 Cold start the system. 

Proceed as follows: 

1. If not already open, open your configuration into the 
AdminHD session. 

2. To export the configuration, select the File -> Export file 

-> Core cold start config (config.tcl) option from the main 
menu bar: 
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A ‘Save As’ file selection box appears: 

3. Select the directory on your AdminHD PC where you 
wish to store the file and click Save. 

DO NOT rename the file; it must be named config.tcl in order 
to be read by the system. 

You can specify a default directory for your configuration files 
within the Extras -> Preferences menu, see Page 227 for 

details. 

The system configuration is stored as a cold start file on your 
computer.  

4. Next, connect and configure your computer so that it is 

communicating with the system as described on Page 
118. 

5. And enable online mode, by clicking on the Online 
button from the Toolbar or selecting Remote -> Online 
to remote system from the main menus: 

ControlHD connects to and synchronises with the system and 
the online status is displayed in the Status bar. 

Once online, any changes you make will action changes within 
the system. If there is a problem communicating with the 
system, then the connection will time out after about 10 
seconds. Check your connections and TCP/IP settings.  
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6. Now upload the file by selecting Remote -> Upload file -
> Core cold start config (config.tcl): 

7. And, select the file you wish to upload: 

The file is uploaded to the system.  

8. You can check whether the file has uploaded 

successfully within the „Remote Log‟. 

9. Finally, cold start the system to see the changes. 

Note that when you perform a cold start, you will lose any online 
data within the system.  
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Upload a Cold Start Configuration (Redundant Control 
Systems) 

If your system is fitted with a redundant Control System, then 
both main and redundant Control Systems must hold the same 
information and mirror each other. 

User data (productions and warm start data) are always 
mirrored to facilitate auto takeover. However, the cold start 
configuration is only synchronised when the Control System 
boots up. This has implications if you wish to upload a new cold 
start configuration: 

Let‟s take an example where your main Control System is 
called A and redundant Control System is called B. If you 
upload your new configuration or software to Control System A 
and then cold start it, the following will occur: 

 The system responds to the cold start of the main 
Control System by automatically switching to the 
redundant Control System (B). 

 At the end of the cold start, data from the active Control 
System (B) is copied back to the redundant Control 
System (A). In other words, your new data is 
overwritten! 

To avoid this, and upload a new configuration successfully: 

1. Disable the redundant Control System. 

This can be achieved by releasing the locking catches which 
are fitted to the top and bottom of the redundant Router Module 
(see opposite). This unlocks the module from the HD Core and 
automatically disables it. Note that it is not necessary to pull out 
or remove the module.  

2. Now upload your new AdminHD configuration to the 
active Control System and cold start. 

The system restarts using the new configuration data. 

3. Once the main Control System is running the updated 
configuration, lock the redundant Router Module back 
into place to reactivate it. 

The redundant Router Module boots up, and all data from the 
main Control System is copied to it, ensuring that both modules 
are running the new data. 

4. Cold start the system once more, and check the new 
configuration. 

During steps 2 and 4 the system can be cold started by 
selecting the Prepare Coldstart option from the System 
Settings display, and then powering off and on the main PSUs 
of the HD Core. 

Remember you will lose any online data when you cold start the 
Control System.  
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Upload to the Online Configuration 

For temporary updates to the configuration, you can upload to 
the online memory. This allows you to update the configuration 
without restarting the system. 

1. If not already open, open your configuration into the 

AdminHD session. 

2. Connect and configure your computer so that it is 
communicating with the system as described on Page 
118. 

3. Click on the Upload button from the main Toolbar or 
select Remote -> Upload all data to remote HD from 
the main menus: 

Note that you must be running in online mode to perform the 
Upload. 

AdminHD now connects to the system and compares the 
existing system configuration to the one open within AdminHD: 
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When the analysis is complete, the following window appears: 

This list allows you to review the changes which you are about 
to make BEFORE you continue with the Upload. 

4. Read through the list and click on Confirm to continue 
or Cancel to abort the Upload: 

When the configuration upload is complete, the system updates 
to reflect the changes.  

The „Remote Log‟ within AdminHD will also report the success 
of the Upload. 

 

 

Congratulations - you have successfully programmed and 
uploaded your first AdminHD configuration! If you would like 
more details on configuration parameters, then please see 
Page 191.  

For an overview of all AdminHD‟s menu options and Toolbars, 
see the Quick Reference Guide on Page 233. 

The next few sections deal with configuring Signal Lists, using 
AdminHD for Online Control and System 
Diagnostics/Documentation. 
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Signal Lists 

A signal list is an AdminHD file which orders the source and 
destination signals within your system configuration into 
Directories and Subdirectories. 

A signal list can be exported (as a gui_config.tcl file) and 
uploaded to the system to define the Signal List display:  

Note that the gui_config.tcl can ONLY be uploaded to the cold 
start data. Therefore, to modify the configuration of the Signal 
List display you must be prepared to modify the cold start 

configuration and perform a system cold start. 

In AdminHD or ControlHD, a signal list can also be opened 
within the „Connect Manager‟ in order to view signals in custom 
named Directories and Subdirectories, or to limit the signals to 
a subset of the matrix. 

Just as with the system configuration, it is much easier to edit 
an existing signal list. So, if you can connect to your system, 
download its signal list and then edit it offline. 

Alternatively, if you don‟t have a connection to your system, 
then you can create a signal list from scratch. 

For details on using the „Signal List Editor‟ to create or edit a 
signal list, please see Page 163. First, we will deal with 
uploading and downloading files to/from the control system. 
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Downloading a Signal List from the Console  

If you are modifying a signal list, it is good practice to download 
the existing signal list to your AdminHD computer: 

1. Connect and configure your computer so that it is 
communicating with the control system as described on 
Page 118. 

2. Open the „Signal List Editor‟ window by clicking on the 
appropriate button from the Toolbar, pressing Ctrl + 
SHIFT + S on your computer keyboard, or selecting the 
Window -> Signal list editor option from the main 
menu bar. 

AdminHD automatically creates a new „empty‟ signal list: 

It is a good idea to open the „Remote Log‟ so that you can 
monitor the progress of the download. 

3. From the „Signal List Editor‟ Toolbar click on the 
Download GUI Signal List Config button to download 
the current signal list from the system to your AdminHD 
computer:  

The ‘Remote Log’ will show the progress of the download, and 
when complete, the ‘Signal List Editor’ updates: 

You can now use this window to make changes to the list as 
described on Page 163. 
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Uploading a Signal List to the Console 

Having edited the signal list, it can be uploaded to the system‟s 
cold start data. There are three stages: 

 Export the signal list from the „Signal List Editor‟ as a 
cold start file (gui_config.tcl) 

 Upload the cold start file to the system. 

 Cold start the system. 

Proceed as follows: 

1. Export the signal list by clicking on the Export config 
button from the „Signal List Editor‟ Toolbar: 

2. Select the directory on your AdminHD PC where you 
wish to store the file and click Save: 

The signal list is stored as a cold start file on your computer.  

DO NOT rename the file; it must be named gui_config.tcl in 
order to be read by the system. 
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3. Next, connect and configure your computer so that it is 
communicating with the system as described on Page 
118. 

It is a good idea to open the „Remote Log‟ so that you can 
monitor the progress of the upload. 

4. Now upload the file by selecting Remote -> Upload file -
> GUI cold start config (gui_config.tcl): 

5. And, select the file you wish to upload: 

The file is uploaded to the system.  

6. You can check whether the file has uploaded 
successfully within the „Remote Log‟: 

7. Finally, cold start the control system. 

Note that when you perform a cold start, you will lose any warm 
start data within the system. Therefore, make sure that you 
have saved the current user data in a production, and any warm 
start configuration updates within AdminHD BEFORE you 

perform this operation! 

Also note that if you have a redundant Control System fitted, 
you will need to disable it in order to update the cold start 
configuration. See Page 156. 
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The ‘Signal List Editor’ 

The „Signal List Editor‟ can be used to create, edit, upload and 
download signal lists. 

1. To show or hide the „Signal List Editor‟, click on the 
appropriate button from the Toolbar, press Ctrl + SHIFT 
+ S on your computer keyboard, or select the Window -
> Signal list editor option from the main menu bar. 

AdminHD analyses your current configuration and then opens 
the ‘Signal List Editor’ window: 

Note that AdminHD creates a new „empty‟ signal list each time 
you open the „Signal List Editor‟. If you wish to edit an existing 
signal list, you will need to open a file (see Page 166) or 
download a signal list from the system (see Page 160). 

The „Signal List Editor‟ is divided into two pages – Source and 
Destination. 

2. Click on the Source or Destination tabs at the top of 
the window to change between pages: 
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Within each page, there are three columns: 

1 Directories & 
signals 

This column displays the configured 
signal list.  

Signals are organised into directories and 
subdirectories which may be added and 
named as you wish. 

2 Signal list This column lists all the signals within 
your current AdminHD configuration. The 
list follows the tree-like structure of the 
configuration using default names.  

The names describe the system 
component as follows – for example, 
Mo1Po1DAL52: 

 Mo1 – indicates the HD Core 

Module (e. g. Module 1) 

 Po1 – indicates the port on the 

Module ( e. g. Port 1) 

 DAL52 - indicates the device on 

the port (e. g. DALLIS Device with 
52 channels) 

3 Selected 
signals 

This column displays signals selected 
from the Signal list and is used to add 

signals to each subdirectory.  

The „Signal List Editor‟ also has its own Toolbar, below 
Directories & Signals, which access all the signal list functions. 
For a quick guide to the „Signal List Editor‟ Toolbar, see Page 
233. 
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3. Use the + and – signs to open and close branches of the 
Directories & signals column to interrogate the 
configured signal list: 

 4. Use the + and – signs to open and close branches of the 
Signal list column to interrogate the available signals. 

Signals shown in red are added to a subdirectory; those in 
black have not been added to a subdirectory. 

Locating a Signal within the ‘Signal List Editor’ 

To quickly locate the hardware position of a signal: 

1. Select the signal from the Directories & signals column. 

2. Click on the Locate button from the „Signal Editor‟ 
Toolbar: 

The Signal list opens to show the hardware location of the 
signal. 
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Creating a New Signal List 

A new signal list is created each time you open the „Signal List 
Editor‟ window. However, if you already have a signal list open 
and want to create a new one, then: 

1. Click on the New Signal List Config button within the 
„Signal List Editor‟ Toolbar. 

A new list is created: 

You will see a new signal list in the Directories & Signals 
column including an unnamed directory (New dir_0001) and 
subdirectory (New subdir_0001) to get you started. 

Note that the signal list above is for a mc2 configuration, and 
therefore includes some default directories, such as Bus Out, 
Direct Out and Insert Send, which hold the console‟s DSP 

signals. You can define which DSP signals are included in the 
„Signal List‟ when it opens, within the Extras -> Preferences 
menu described on Page 227. These signals are not available 
when running in Nova73 or Nova73 DSHS mode. 

In the Signal List column, you will see all the signals available 
within your system configuration. 

Opening an Existing Signal List 

Alternatively, you may wish to edit or add to an existing signal 
list: 

1. Click on the Open Signal List Config button within the 
„Signal List Editor‟ Toolbar. 

2. Select a file (.slx) and click on OK.  

Note that if you try and open a signal list which contains signals 
not supported in the current AdminHD configuration, then some 
parts of the signal list may not load. 

If you are running online, then you can download the current 
signal list from the system using the download GUI signal list 
config button. See Page 161 for details. 
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Editing a Signal List 

You can generate a signal list automatically from the 
configuration, see Page 175. However, it is more likely that you 
will want to create and configure your own directories and 
subdirectories. 

The signal list is edited as follows: 

Note that you can only add signals to a subdirectory, and not a 
directory. 

Also note that you can add a signal to more than one 
subdirectory if you wish. For example, you might place the test 
tone in subdirectories called “Service” and “Line-up”. Signals 
highlighted in red in the Signal list column have already been 
added to a directory.  

Remember to define both source and destination signals using 
the Source and Destination tabs at the top of the editor 
window. 

Let‟s look at these operations in more detail: 
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Adding a Directory or Subdirectory 

To add a new directory or subdirectory: 

1. Select the position in the Directories & signals column 
where you wish to add the new directory or subdirectory 
– for example, select Stageboxes: 

2. Right-click and select Create new directory. 

The new directory or subdirectory is added to the signal list 
below your selection. 

Renaming a Directory or Subdirectory 

You can rename it as follows: 

1. Double-click on the name of the directory or subdirectory. 

The name is highlighted: 

2. Type in the new name on your computer keyboard and 
press Enter. 
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Adding Signals to a Subdirectory 

Having created and named your directories and subdirectories, 
next add your signals: 

1. First select the subdirectory from the Directories & 
signals column – for example, Stagebox1. 

The name is highlighted. 

2. Next, use the Signal list column to select the signals 
you wish to add – you can select an individual signal, or 
a complete card, as shown below: 

The selected signals are shown in the Selected signals 
column. 

3. Then add all the signals in one operation by clicking on 
the Add chosen signals button: 

This adds all of the selected signals to the selected 
subdirectory. The selected signals turn red to indicate that they 
are now used within a subdirectory. 

 

 

 



 
AdminHD 
The ‘Signal List Editor’ 

170/ 303 V4.10/2 mc266 MKII Technical Manual 

When adding signals, there are a few tips and tricks you can 
use to edit your selections: 

1. To select all the signals from a card, click on the card 
within the Signal List column. 

2. To select a range of signals or cards, select the first 
signal; then press and hold the Shift button on your 
computer keyboard and select the next signal. This 
selects all signals within the range, or all cards within the 
range: 

3. To select non-consecutive signals or cards, press and 
hold the Ctrl button on your computer keyboard and 
then make your selections. As long as hold the Ctrl 

button, your selections are accumulated within the 
Selected signals list: 
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4. If you add the wrong signal to the Selected signals 
column, you can remove it by selecting the signal and 
clicking on the Remove chosen signal button: 

Deleting Signals, Subdirectories & Directories 

Once you have added signals into the Directories & signals 

column, you can delete them, or delete a complete directory or 
subdirectory, as follows: 

1. Select the signal or directory or subdirectory from the 
Directories & signals column: 

2. Right-click and select Delete. 

3. Confirm by clicking Yes. 

The selected signals are deleted from the signal list. 

Note that deleting a subdirectory deletes all signals within it. 
And, deleting a directory deletes all subdirectories within it. 
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Editing the Position of Signals, Subdirectories & 
Directories 

You can alter the position of a signal, subdirectory or directory 
within the signal list as follows: 

1. Select the signal or directory or subdirectory from the 
Directories & signals column – for example, Stagebox 
2: 

2. Right-click and select Move up or Move down. 

The selection moves accordingly. 
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Copy, Cut and Paste 

In addition, you can use the copy, cut and paste functions to 
quickly edit your signal list. For example, to copy or cut a 
subdirectory from one directory to another: 

1. Select the directory or subdirectory you wish to copy or 
cut from the Directories & signals column – for 
example, Stagebox 2: 

2. Right-click and select Copy or Cut. 

The selected subdirectory is copied into the programme’s 
clipboard. 

3. Now select the directory where you want to paste the 
selection – for example, StageboxB: 

4. Right-click and select Paste. 

The selected subdirectory is pasted accordingly. 
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Saving a Signal List 

Having configured your signal list, you should now save it on 
your AdminHD computer. This will allow you to import it into the 
„Connect Manager‟ or edit the list at a future date. 

Signal lists are saved as .slx files on your computer. As they 
relate to the system configuration (.csv file), they should be 
stored in the same directory on your computer.  

You have two options when saving the signal list: 

Save 

If this is a new unsaved signal list, then save it for the first time 
as follows: 

1. Click on the Save Signal List Config button within the 

„Signal List Editor‟ Toolbar. 

2. Select the directory in which you wish to save the file. 

3. Click Save. 

The signal list is stored with the filename signallist.slx and the 
file path is shown in the ‘Signal List Editor’ title bar: 

4. From hereon, you can save any subsequent changes 
instantly by clicking on the Save button. 

Save As 

Alternatively, if you are working on an existing file, you may 
wish to save the file under a different name. 

Repeat as above but click on the Save As button within the 
„Signal List Editor‟ Toolbar. 

If you are going to store multiple signal lists within the same 
directory, then rename the file – for example, AudioControl.slx. 
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Generating a Signal List Automatically from 
the Configuration 

In order to generate a signal list quickly, you can use the 
Generate automatic tree view from config function. 

This will automatically add all the directories, subdirectories and 
signals as they are displayed within the Signals List column to 
the Directories & Signals: 

This hardware-based list is especially useful for system 
technicians. It provides a clearly structured signal list including 
all available signals within the system. 

1. To create the list, click on the Generate automatic tree 
view from config button from the „Signal List Editor‟ 
Toolbar. 

The directories are created and get a hardware-based default 
name.  

These names describe the system component as follows – for 
example, Mo1Po1DAL52: 

 Mo1 – indicates the HD Core Module (e. g. Module 1) 

 Po1 – indicates the port on the Module ( e. g. Port 1) 

 DAL52- indicates the device on the port (e. g. DALLIS 

Device with 52 channels) 

Note that you can click on the Generate automatic tree view 
from config button as many times as you wish. 
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Updating the ‘Signal List Editor’ 

Each time you open the „Signal List Editor‟ window, AdminHD 
analyses your system configuration and reads in the available 
signals. If you later add a new component or card to your 
configuration, then you will need to update the „Signal List 
Editor‟ before you can access the new signals from the Signals 
List column: 

To update „Signal List Editor‟: 

1. Click on the Update hardware signal config button.  

The Signal list column updates with the new card. 
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Online Control – The ‘Connect Manager’ 

The „Connect Manager‟ is used to control settings within your 
system when running online: 

 Set Matrix crosspoints – connections from any input to 

any output. 

 Edit signal labels – online renaming of signal labels. 

 Control I/O parameters – for example, to adjust 

microphone preamp gain, subsonic filter switching, etc. 

 Save and recall snapshots – to reset any number of 

signals, with partial or global recalls. A snapshot stores 
connections to or from a signal, the signal‟s label and 
I/O parameter values. 

These operations are identical for AdminHD and ControlHD, so 
please see the “ControlHD Operator‟s Manual” for full details. 

This section deals with „Connect Manager‟ functions useful only 
for AdminHD users. 
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Updating the ‘Connect Manager’ 

If you add a new component or card to your system 
configuration, then you will need to update the „Connect 
Manager‟ before you can access the new signals. 

Note that you will only need to use this option if you are making 
programming changes to the configuration and using the 
„Connect Manager‟ at the same time. 

To update „Connect Manager‟: 

1. Click on the Update hardware config button.  

The Source and Destination signals columns update with the 
new signals. 
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Exporting a Connection List  

You can export a list of all connections within the „Connect 
Manager‟ so that it can be opened in a 3rd party editor, such as 
MS Excel. For example, in a mc2 installation you may wish to 
check which connections are made without disturbing the 
console operator. 

To export the connection list: 

1. Click on the Export button from the „Connect Manager‟ 
toolbar: 

Note that the button only becomes available once there is a 
connection made. 

2. Select a directory and enter a filename, and click Save: 

The connection list is stored as a .csv file on your computer. 

3. Now use an editor, such as MS Excel, to open the file: 

You can format the data as you wish within the editor. 
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System Diagnostics 

In this section, you learn about the tools for diagnosing the 
system and the AdminHD software: 

 System Diagnosis online 

 The „Remote Log‟  

 The System Message Log 

 System Version Check 

Online System Diagnostics 

When online, AdminHD can be used to monitor the status of the 
hardware within the system. 

Note that this feature is also available in ControlHD. 

If you are not already online, then proceed as follows: 

1. First connect and configure your computer so that it is 
communicating with the system as described on Page 
118. 

2. Open a New configuration by selecting File -> New and 
choose your system from the drop-down menu: 

 Nova73 HD – to open a Nova73 configuration 

 mc²66 HD – to open a mc² configuration 

 Nova73 DSHS HD – to open a “dual self healing star” 

configuration. 

3. Next click on the Download button from the Toolbar, or 
select Remote -> Download all data to remote HD 
from the main menus, to download the system 
configuration: 
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4. Enter the TCP/IP address of the system and click 
Connect: 

AdminHD downloads the configuration from the system into 
your AdminHD session. 

Note that instead of downloading, you could open a 
configuration from your AdminHD computer. However, it is 
always best to download from the system if possible so that 
your AdminHD configuration matches that within the system. 

Also note that you cannot download a configuration if you are 
already online. So, if this is the case, disable online mode and 
then download the configuration. 

5. Having downloaded the system configuration to 
AdminHD, go online by selecting Remote -> Online to 
remote system from the main menus: 

6. And confirm the IP address for the connection by 
clicking Connect: 

AdminHD connects to the system and the online or offline 
status is displayed in the Status bar. 

If there is a problem communicating with the system, then the 
connection will time out after about 10 seconds. Check your 
connections and TCP/IP settings. 

7. If you select Remote -> Reconnect mode, then 
AdminHD will automatically attempt to reconnect to the 
system if Network communication is interrupted. 
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Diagnosing Faulty Components 

Once online, you can use the „Core Browser‟ and „Graphic 
View‟ windows to monitor the actual status of hardware 
components within your system: 

All components are monitored, including the status of the HD 
Core, DALLIS units and their PSUs. 

Components which are operating normally are coloured green 
within the „Core Browser‟. 

Faulty components are highlighted in red within the „Core 
Browser‟. 

1. Click on the faulty component within the „Core Browser‟ 
and the „Graphic View‟ window updates to show the 
position of the component within the frame. 

2. Check your connections and if necessary replace the 
card. 

When the card is operating correctly, the component is 
displayed in green within the ‘Core Browser’. 
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The ‘Remote Log’ 

The „Remote Log‟ records all the messages generated by 
AdminHD, and the system if it is online. You may want to view 
or save the „Remote Log‟ to help diagnose system errors or 
errors within the operation of AdminHD. 

Recording System Errors 

Messages from the system are only logged when the system is 
online so if you want to use the „Remote Log‟ to help fault find 
the system, enable Remote -> Online to remote system. 

Saving the Remote Log 

The contents of the „Remote Log‟ are not saved automatically 
and will be lost when you exit the programme or clear the log. 

To save the contents of the „Remote Log‟: 

1. Open up the „Remote Log‟ window and right-click 
anywhere within it: 

2. From the drop-down menu, select Export content… 

Alternatively, you can select File -> Export File -> Remote Log 
from the main menus: 
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A ‘Save As’ file selection box appears: 

3. Select the directory in which you wish to save the file 
and enter a filename: 

You can specify a default directory for your log files within the 
Extras -> Preferences menu, see Page 227 for details. 

4. Click Save. 

The log is stored as a plain text file and can be opened by any 
common text editor. 

Clearing the Remote Log 

To get a better overview of a problem you may wish to clear the 
contents of the „Remote Log‟: 

1. Open up the „Remote Log‟ window and right-click 

anywhere within it: 

2. From the drop-down menu, select Clear content… 

The contents of the ‘Remote Log’ are deleted. 

If you are not sure whether you will need the „Remote Log‟ 
entries later for reference purposes, you should save the 
contents of the window before you clear you log. 
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The System Message Log 

In addition to AdminHD‟s Remote log, the system itself 
generates and stores error messages. These can be 
downloaded from the system and saved on your computer as a 
text file.  

1. Make sure that you are connected to your system. 

2. Select Remote -> Download file -> System log 

messages from the main menu bar: 

A ‘Save As’ file selection box appears: 

3. Select the directory in which you wish to save the file 

and enter a filename: 

You can specify default directories for your log files within the 
Extras -> Preferences menu, see Page 227 for details. 

4. Click Save. 

5. AdminHD now opens a connection to your system and 
downloads the log file. 

The log is stored as a plain text file and can be opened by any 
common text editor. 

 

 

 



 
AdminHD 
System Diagnostics 

186/ 303 V4.10/2 mc266 MKII Technical Manual 

System Version Check  

When new software features are released for your system, then 
a new version of AdminHD is issued to enable their 
configuration. If you are not sure whether the version of 
AdminHD on your computer matches that installed on the 
system, then you can ask the programme to check the versions 
each time you make an online connection. This option is 
particularly useful if you are dealing with multiple systems 
running different versions of software. 

1. Select Extras -> Preferences from the main menus: 

2. And select the Remote Communication page: 

3. If you want AdminHD to check the version while 
connecting then untick the box and click OK. 
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Documenting Your System 

AdminHD provides two tools to help you document your system 
once you have programmed your configuration: 

 Copy Image  

 Export a Component List 

Copy Image/Write Image to File 

You can save the „Graphic View‟ of system components such 
as the HD Core and DALLIS units to help document your 
system. 

In mc266 mode, you can also save the „Console Panel‟ which 
shows the layout of the control surface.  

Saving the ‘Graphic View’ 

1. Open the „Graphic View‟ window by clicking on the 
appropriate button from the Toolbar or pressing Ctrl + 
SHIFT + F on your computer keyboard. 

2. Point your mouse over the frame of the unit. 

The unit is outlined in orange. 

3. Now right-click. 

A pop-up menu opens: 

4. If you select copy image to clipboard, then the graphic 
is saved to your computer‟s clipboard. 

5. If you select write image to file, then a dialogue window 
opens. Enter a file name and click on Save. 

The file is saved to your computer as a .png image file. 
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Saving the ‘Console Panel’ 

Repeat as for the „Graphic View‟ but this time within the 
„Console Panel‟ window: 

1. Open the „Console Panel‟ window by clicking on the 
appropriate button from the Toolbar or pressing Ctrl + 
SHIFT + O on your computer keyboard. 

2. Point your mouse over the console frame and right-click 
to access the pop-up menu: 

 

 

 



 
AdminHD 

Documenting Your System 

mc266 MKII Technical Manual V4.10/2 189/ 303 

Export a Component List  

You can export a component parts list so that it can be opened 
in a 3rd party editor, such as MS Excel. 

1. Open your configuration and select File -> Export file -> 
Component list: 

2. Select a directory and enter a filename, and click Save: 

The system list is stored as a .csv file on your computer. 
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3. Now use an editor, such as MS Excel, to open the file: 

You can now format this data as you wish within the editor. 
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System Configuration 

This section covers all system configuration parameters 
common to all HD Core systems (Nova73, Nova73DSHS and 
mc2). Dual self-healing star and mc2 users should also refer to 
Pages 207 and 212 respectively. 

We will assume that you have read the “Getting Started: 
Configuration” section on Page 121.  

The individual components are covered according to their 
hierarchical order within the „Core Browser‟. For more details on 
parameter functions, please consult the relevant data sheet for 
the component. 

System 

Each configuration consists of a single system which contains 
all the hardware components for your installation. 

Open the System „Parameter Box‟ to edit its parameters: 

ID Usually all Lawo projects receive a project ID, 
made up of 6 integers. You can log your 
project ID here; you may be asked for it when 
servicing your product. 

System 
alias 

Here you can enter a reference name for the 
system. For example, if you work on multiple 
configuration files, it can be useful to name 
components within AdminHD.  

Alias names are only used within AdminHD 
and are not transferred to the system.  

Both these fields can be left blank if you wish. 
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Core 

Within each System, you may add a type of HD Core.  

Note that in Nova73 or mc266 mode, each system consists of a 
single Core. In Nova73 DSHS mode, you can add up to two 
Cores representing one side of the dual self-healing „star‟. 

Open the Core „Parameter Box‟ to edit its parameters. There 
are three pages of parameters for the core: 

Core Parameters: Data 

Core alias Enter a reference name for the core or leave 
this field blank. 

Alias names are only used within AdminHD 
and are not transferred to the system.  

Router model 
number  

Router 
module type 

These fields are for information purposes only 
and cannot be edited.  

They show the serial number and type of the 
core‟s Router module.  

To change these parameters, you must delete 
the Core and add a different core type from the 
„Core Browser‟. 
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Router 
module 

Tick this box to enable network communication 
to the HD Core Router module. 

IP address 
router module 

This box defines the IP address of the HD 
Core‟s router module. Note that the IP 
addresses required depend on your AdminHD 
mode. Our example shows a Nova73. For more 
details see Page 144. 

Redundant 
router module  

Tick the redundant router module box to add 
a redundant router module to the HD Core.  

See Page 128 for details. 

IP address 
redundant 
router module 

This box defines the IP address for the 
redundant module. 

Black Burst 
synchronise 
switching 

Tick this box to configure the system to switch 
matrix cross points synchronous to an 
external black & burst sync. 

Internal sync 
activates 
alarm 

Tick this box and an alarm will be issued 
when the system switches to internal sync.  

For example, if the system is referenced to 
external sync, then set this box to trigger the 
global alarm if the external sync source fails 
and the system switches to internal sync. 

Enable sync 
port 

Tick this box to enable the multi-channel sync 
port. You will be prompted to select the multi-
channel sync source, see Page 145 for 
details. 

Multi-channel 
sync port 

This box displays the multi-channel sync port 
selection as a system address – for example:  
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Core Parameters: System Settings 

Analog full-
scale level 
(dBU) 

This option sets the analog level which you 
wish to correspond to digital full scale level 
(0dBFS). You can select from 12, 15, 18, 21 or 
24 dBU. 

Reference 
Level (dBU) 

This option sets the internal system reference 
level. The maximum reference level is 24dBU. 

Headroom 
(dB) 

The resultant headroom is calculated 
automatically according to the equation: 

Analog full-scale level = Reference level + 
Headroom 

For more details on levels, see Page 146. 

Sampling 
Frequency 

This option sets the internal sampling 
frequency of the HD Core. Note that the 
available options depend on your choice of HD 
Core. For more details, see Page148. 

Disable Global 
Alarm 

Tick this box is you wish to disable the Global 
Alarm. See Chapter 2: Installation for more 
details. 
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Core Parameters: Map 

These parameters are for use with an external controller system. 
See Page 149.  

For each mapping table (1 to 16) you can enter: 

Unknown 
signal address 

This is the address which will be submitted to 
the external control system when a signal is 
disconnected. 

No signal 
address 

This is the address which will be submitted to 
the external control system when an undefined 
source is connected to a defined destination. 
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Modules 

Each Core can be fitted with Modules. Open the Module 
„Parameter Box‟ to edit its parameters: 

Module 
alias 

Enter a reference name for the module. 

Alias names are only used within AdminHD 
and are not transferred to the system. 

Slot number This field is for information purposes only and 
cannot be edited. It shows the slot number 
within the Core. 

Module 
model 
number  

Module type 

These fields are for information purposes only 
and cannot be edited.  

They show the serial number and type of 
module.  

Config-ID For the 983/03 Matrix DSP 48 Module only. 

Defines the mode of the Matrix DSP Board. 

See Page 218. 
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Ports 

Each I/O Module can be opened to view its I/O Ports.  

Note that DSP modules do not have audio ports, with the 
exception of the 983/06 card. 

Open the Port „Parameter Box‟ to edit its parameters: 

Port Number 

Interface Type 

These fields are for information purposes only 
and cannot be edited.  

The Port Number indicates the logical number 

of the port. See Appendix C for details. 

The Interface Type is defined by the Module 
selection: 

 MADI - multi-channel format according 

to the AES-10 standard. 

 ATM - data rate 155 Mbit/s, multi-

channel format with 80 audio channels 
according to the Lawo standard. 

 AES3 – stereo format according to the 

AES-3 standard. 

 DSP – internal digital signal processing. 

Is redundant Tick this box to enable port redundancy. You 
will be prompted to select the redundant port, 
see Page 136 for details. 

Corresponding 
port 

This box displays the redundant port as a 
system address – for example:  
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Super-Device 

Below the Port, you will find the type of Super-Device: 

Open the „Parameter Box‟ to edit its parameters: 

Super-
device alias 

Enter a reference name for the tie-line 
connection. 

Alias names are only used within AdminHD 
and are not transferred to the system. 

Type This field is for information purposes only and 
cannot be edited. It describes the type of 
connection from: 

 I/O - an I/O connection such as that on 

the 981/02 AES module. 

 DSP – internal DSP such as that on the 

983/06 DSP IOSONO module. 

 Tie-Line – multi-channel connection 

within a MADI or ATM module. 

 DALLIS - multi-channel connection to 

an external DALLIS unit. 

In addition for a DALLIS you can view the Model number of 
the unit and the number of Audio channels left (i.e. the 
number of „unused‟ channels which could be used by further 
plug-in cards.): 
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Cards 

Within each DALLIS you can fit I/O plug-in cards. Open the 
Card „Parameter Box‟ to edit its parameters: 

Device alias Enter a reference name for the card. 

Alias names are only used within AdminHD 
and are not transferred to the system. 

Model 
number  

Typename 

Slot number 

Interface 
type 

These fields are for information purposes only 
and cannot be edited.  

They show the serial number and type of card, 
the slot position within the DALLIS frame and 
the Interface type.  

Monitoring 
device 

For the 942/02 or 942/12 cards only. Tick this 
box if the card is to be used for monitoring. 
This releases the card from the system level. 

For SDI and HD SDI cards you will find additional options to 
configure the cards. Please refer to the relevant data sheets for 
details: 
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Signals 

At the lowest level of the system tree are the signals 
themselves.  

Note that depending on the type of signal, there may be up to 
three pages of parameters. Also that the parameters vary 
depending on whether you select a Signal In or Signal Out: 

Signal In: Signal 

HLSD High Level Signal Definition – this is the 
system address for the signal which MUST be 

unique in order for the system to operate 
correctly.  

For normal operation, you should not modify 
this address from its default. If you do, you 
may end up with conflicting addresses.  

For applications where you have say two identical but 
independent studios and you wish to be able to transfer 
snapshots from one to another in order to reset signal routing 
and parameters, you can programme signals to have the same 
HLSD. This will allow snapshots from one studio to be recalled 
to the other studio and reset the routing in an identical manner. 
Note that to use this feature, the systems cannot be networked. 

Signal name This is the system name of the signal. It can 
only be defined by AdminHD and should be 
used to describe the physical location of the 
signal. 

Signal label This is the default user label. Note that the 
signal label can be changed later, either within 
the Signal List display, or within AdminHD‟s 
„Connect Manager‟ window. However, it is a 
good idea to programme a default label as this 
is what the system will reset to after a cold 
start. 

See Page 141 for details. 
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Group This is the group name for the signal which can 
be used when interfacing to an external 
controller system. Please consult your control 
system documentation for details on how to 
implement the group name. 

SRC For AES cards with SRC only.  

Untick this box to bypass the sample rate 
converter. 
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Signal Out: Signal 

For signal outputs, you can define the same parameters as 
described for the signal inputs. 

In addition, for digital I/O cards with SRC (Sample Rate 
Conversion) you will find the following options: 

Sampling 
frequency 

Select the sampling frequency for the output 
from the available options. 

Word length 
(bit) 

Set the word length for the output – e.g. 16-bit, 
20-bit or 24-bit. 

SRC This field cannot be modified but shows the 
status of the output sample rate converter. To 
bypass the SRC, you must set the Sampling 
frequency to System and the Word length to 
24. 

For SDI and HD SDI cards you will find additional Signal In and 
Signal Out options. Please refer to the relevant data sheets for 
details: 
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DSP 

These parameters adjust the DSP on the I/O card and the 
Silence Detect alarm feature.  

Note that not all cards support these features.  

 I/O DSP: Inputs 

I/O-DSP Tick this box to enable the I/O DSP. Once 
enabled, the following parameters become 
available: 

Offset (dB) 

Digital gain 
(dB) 

Enter an offset and/or digital gain value in dB. 
The resultant gain (Offset + Digital gain) is 
applied to the signal within the I/O card, and 
therefore affects all signal destinations. 

Two separate parameters (Offset and Digital 
gain) are provided so that you may easily apply 
a „permanent‟ and a „temporary‟ gain change. 
For example, if you need to compensate for a 
low level line within the installation, then use 
the Offset parameter to apply this „permanent‟ 
change. In addition, within today‟s production 
you may need to compensate for a badly 
recorded signal; for this „temporary‟ 
adjustment, use the Digital gain. At the end of 
the production, you can easily reset the Digital 
gain to 0 dB while keeping the Offset gain 
intact. 

Note that for Dolby E operation the I/O DSP MUST be disabled 
(unticked) for signals to be routed transparently. 
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 I/O DSP: Outputs 

For an output signal you have access to the following additional 
options. There are for use with stereo signals: 

Mono matrix Tick this box to enable the mono matrix 
settings and link the output signal to its 
odd/even partner. 

When the mono matrix is enabled, you can 
then adjust the following parameters: 

Mono matrix 
mode 

The mode can be set to: 

 Channel mix – sums the left and right 
inputs and routes the mono sum to both 
left and right outputs.  

 Channel swap – routes the left input to 
the right output and vice versa. 

 Left to both – routes the left input to 
both outputs. 

 Right to both – routes the right input to 
both outputs. 

Mono 
attenuation 
left channel 
(dB) 

When working in Channel mix mode, you can 
set attenuation (e.g. -3dB) to compensate for 
the mono sum. This is applied to the left output 
signal. 
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 Silence Detect: 

Silence 
Detect 

Tick this box to enable the Silence Detect 
alarm function. Once enabled, if the signal falls 
below the Threshold level then an alarm is 
issued via Lawo‟s Remote MNOPL protocol. 

Stereo link 
for Silence 
Detect 

Tick this box to link the left and right sides of a 
stereo input or output for „Silence Detection‟. 
When linked, the Silence Detect alarm is only 
issued if both signals below the Threshold 

level. 

Only odd and even adjacent signals may be 
linked. 

Threshold 
(dBFS) 

Set the threshold below which the Silence 
Detect alarm will be triggered. The level can 
be adjusted in 0.25dB and is referenced to 
digital full scale level. 

Attack Time 
(sec) 

This sets the length of time for which the signal 
must fall below the Threshold level before the 
Silence Detect alarm is activated. The time is 
set in steps of 1 second. 

Release 
Time (sec) 

This sets the length of time for which the signal 
must remain below the Threshold level before 
the Silence Detect alarm is cancelled. The 

time is set in steps of 1 second. 
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Map 

These parameters set the signal‟s address for mapping tables 1 
to 16, so that it can be controlled by a 3rd party system as the 
Thomson Jupiter, Broadcast Solutions VSM, BBC Colledia, etc. 
See Page 149 for more details. 
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Nova73 Dual Self-Healing Star 
Configuration 

This section covers additional notes for Nova73DSHS users. 

The configuration of a Nova73 DSHS system should be 
approached in the same way as for any other HD Core system. 
Bear in mind the following: 

Warning 

Within a Dual Self Healing Star system, the two „stars‟ MUST 
be configured identically: 

Use AdminHD to programme one „star‟ – the active one. The 
same configuration can then be uploaded to both the active and 
passive „stars‟.  
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Creating a New Configuration 

When you create a new configuration within AdminHD, make 
sure that you select the Nova73 DSHS mode: 

You CANNOT change mode later. 

The selection of this mode will allow you to configure the correct 
options for a DSHS system, including the ability to add two HD 
Cores, and set the default IP address for the DSHS matrix 
server. 
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Nova73DSHS TCP/IP Address Configuration 

Within a DSHS system, your AdminHD computer must 
communicate with the matrix control server for the „star‟. 

You can only communicate with one „star‟ at a time, so to 
change connection from the active to the passive „star‟, you will 
need to know the IP addresses of each control server: 

The IP address for the system can be modified in the Data 
page of the Core „Parameter Box‟: 

1. Tick the Router module box to enable communication 
to the HD Core. 

2. Enter the IP address of the HD Core‟s main router 
module in the IP address router module field. 

The default IP addresses are shown opposite. 

3. If the HD Core is fitted with a redundant router module, 
then enter its IP address within the IP address 
redundant router module field. 

Updating the Online Configuration 

To avoid problems with the operation of the system, it is 
important that you update the online configuration of the system 
in the following order: 

1. First, connect your AdminHD computer to the active „star‟ 
and download the existing configuration. 

2. Edit the system configuration. 

3. Upload the new configuration to the active „star‟. 

The configuration is uploaded to the active star and then 
distributed to the passive „star‟ automatically by the system.  

Warning 

This may cause audio drop-outs within the modules or DALLIS 
units affected by the update. Therefore, any hardware which is 
to be updated should be isolated before performing the upload. 
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Updating the Cold Start Configuration 

When making changes to the cold star configuration of the 
system, proceed in the following order: 

1. Download the cold start configuration (config.tcl) from 
the active „star‟ into AdminHD. 

2. Edit the system configuration. 

3. Export a new config.tcl file. 

4. Upload the config.tcl file to the active „star‟. 

5. Close the AdminHD application and then restart it for 
connection to the passive „star‟. 

6.  Upload the config.tcl file to the passive „star‟. 

7. Now cold start the complete system. 

Note that when you perform a cold start, you will lose any warm 
start data within the system.  
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Dual Self-Healing Star Active to Passive 
Switchover 

When AdminHD is connected to either the active or passive 
„star‟ it is possible to manually switch between the two DSHS 
„stars‟: 

1. Select Remote -> DSHS -> Show DSHS Frame… from 
the main menus: 

A dialogue window opens: 

2. Click on the Switch button to change the status of the 

two „stars‟. 

The active ‘star’ becomes passive and the passive one 
becomes active.  

The Double star status LED describes the current status of the 

DSHS: 

 Green = the connected star is the active star. 

 Yellow = the connected star is the passive star. 

 Red = the connected star has no link with another star. 
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mc
2
 Configuration 

This section covers additional configuration notes for mc256, 
mc266 and mc290 users.  

Creating a New Configuration 

For any mc2 console, when you create a new configuration 
within AdminHD, select the mc² console mode: 

You CANNOT change mode later. 

The selection of this mode configures the correct options for a 
mc266 system and sets the default IP address for the 66‟s 
control system. 

When configuring a mc256 or mc290 system, remember to edit 
the default IP address to that of your console‟s control system 
(see the next page). 
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TCP/IP Address Configuration 

For a mc2 console, your AdminHD computer must communicate 
with the console‟s Control System.  

When you select the mc² console mode, the default IP address 
for a mc266 Control System is automatically entered, so you will 
only need to alter this if you are configuring a mc256, mc290 or 
have multiple consoles on the same network. 

The IP address can be modified in the Data page of the Core 
„Parameter Box‟: 

1. Enter the IP address of the console control system in the 
IP address control system field. 

The default IP addresses are as follows: 

 192.169.102.65 – mc266 

 192.169.102.56 – mc256 

 192.169.102.90 – mc290 

Note that if a redundant Control System is fitted, then its IP 
address is automatically set 1 digit higher. 

2. Tick the Router module box to enable communication 

to the HD Core. 

3. Enter the IP address of the HD Core‟s main router 
module in the IP address router module field. 

4. If the HD Core is fitted with a redundant router module, 
then enter its IP address within the IP address 
redundant router module field. 

The default IP addresses for a mc266 system are shown 
opposite. 
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Configuration of the mc
2
66 Surface 

For the Classic or Top1 mc266 system, you can use the 
„Console Panel‟ window to configure the surface of the console 
(see below).  

The surface of the MKII mc266, mc256 or mc290 is factory-
configured by the console_config.tcl file. If the configuration 
changes – for example, you add or remove a panel – then 
please contact the Lawo service department for details on how 
to edit this file. 

Note that from Version 4.10 software onwards, a “restart after 
crash” strategy is implemented for all GUI and Channel display 
applications. To support this feature, it is necessary that the 
console configuration matches the hardware exactly (correct 
location of GUI_SCREEN and CHANNELDISPLAY_SCREEN). 
If not, then the logfile will be filled with restart messages and the 
system may slow down considerably. 

The ‘Console Panel’ Window (Classic or Top1)  

1. To show or hide the „Console Panel‟ window, click on 
the appropriate button from the Toolbar, press Ctrl + 
SHIFT + 0 on your computer keyboard, or select the 
Window -> Console Frame option from the main menu 
bar: 

2. Select the console frame size from the drop-down menu 
(e.g. 24+8+24). 

The window updates accordingly. 
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3. If your console frame is larger than the fader panels 
fitted, then right-click on the fader panel you wish to 
remove and deselect the Assign fader panel to slot 
option: 

The display updates to show the blank fader panel: 

4. You can save changes to the „Console Panel‟ 
configuration within AdminHD by selecting File -> Save 
or File -> Save As. 

The ‘Console Panel’ configuration is stored with the rest of the 
system configuration within the config.csv file. 

Now upload the changes to the console control system as 
follows: 
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1. To export the configuration, click on the Export config 
button at the top right of the „Console Panel‟ window: 

2. Select the directory on your AdminHD PC where you 
wish to store the file and click Save: 

The control surface configuration is stored as a cold start file on 
your computer.  

DO NOT rename the file; it must be named console_config.tcl 
in order to be read by the system. 

3. Next, connect and configure your computer so that it is 
communicating with the mc266 system as described on 
Page 118. 

It is a good idea to open the „Remote Log‟ so that you can 
monitor the progress of the upload. 

4. Now upload the file by selecting Remote -> Upload file -
> Console cold start config (console_config.tcl): 
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5. And, select the file you wish to upload: 

The file is uploaded to the system.  

6. You can check whether the file has uploaded 

successfully within the „Remote Log‟: 

7. Finally, cold start the mc266 control system as described 
in Chapter 4. 

Note that when you perform a cold start, you will lose any warm 
start data within the system. Therefore, make sure that you 
have saved the current user data in a production, and any warm 
start configuration updates within AdminHD BEFORE you 
perform this operation! 
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mxDSP Configuration 

This section covers additional notes for the mxDSP card 
(983/03-007). 

Physically, a mxDSP card is identical to a normal channel DSP 
card (983/03) and occupies one slot within the HD Core. Any 
number of cards may be configured for mxDSP operation, 
providing a pool of DSP resource which can be applied to signal 
paths within the routing matrix. For example, to apply fixed DSP 
settings to line arrays.  

Several configuration options are supported, providing up to 
192 DSP chains plus a 64 x 64 mixing matrix per card. The 
DSP chains are configured from various elements including 
level, mute, delay, EQ, etc. The number of DSP chains, and 
their signal flow, is determined by the Config-ID for the module: 
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Once configured, operators may adjust DSP parameters from 
the mxDSP Settings display. Note that the 64 x 64 mixing 
matrix cannot be controlled from the console GUI. 

To configure a DSP card for mxDSP operation, the following 
steps are required: 

1. Edit and upload a new system configuration (config.tcl) 
using AdminHD. 

2. Edit and upload a new Signal List (gui_config.tcl) using 

AdminHD. 

3. Cold start the system so that the new system 
configuration is active. 

4. Update the firmware on the mxDSP card via a Telnet 

session. 

Before you begin, download the current system configuration 
and Signal List from the system you wish to update. This 
ensures that you are editing the latest configuration. 
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System Configuration 

To add a mxDSP card to the system configuration: 

1. Select the slot and change the module type to 983/03-
007 mxDSP: 

2. Open the module „Parameters Box‟ and choose an 
option from the Config-ID menu: 

These options determine the number, and signal flow, of the 
DSP chains (see next page). 

3. Save and upload the system configuration (config.tcl) to 

the system‟s cold start data. 
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Config-ID Options 

The Config-ID defines the signal flow of the DSP chains, and 
whether the card supports the 64 x 64 mixing matrix shown 
below: 

 Standby 

Select this option to run the mxDSP module in standby mode. 
Use this mode to configure a redundant mxDSP card. 

 Playout (no PPM) 

This option provides 184 channels of DSP only (no mixing 
matrix): 
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 Universal 

This option provides 154 channels of DSP plus the 64 x 64 
mixing matrix: 

 Universal (no PPM) 

This option provides 154 channels of DSP plus the 64 x 64 
mixing matrix: 
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 Line Control 

This option provides 184 channels of DSP plus the 64 x 64 
mixing matrix: 

 

 Line Control (no PPM) 

This option provides 184 channels of DSP, as above, but with 
less system resources, similar to Universal (no PPM). 
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Signal List Configuration 

In order for the DSP chains to appear within from the Signal 
List display, the mxDSP card must be added to the Signal List 

configuration (gui_config.tcl). 

Make sure that you have downloaded the current Signal List 
from the system to the Signal List Editor. And that you have 
added the mxDSP card to the AdminHD configuration: 

1. Click on the Update hardware signal config button. 

The mxDSP signals from the newly configured card are added 
to the existing Signal List: 

2. You can organise the signals, and name and label them, 
in the usual manner. 

3. Save and upload the new signal list configuration 
(gui_config.tcl) to the system‟s cold start data. 

4. Cold start the system. 

The new system configuration and signal list should now be 
active. You can check this by opening the mxDSP Settings 
and Signal List displays. 
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Updating the Firmware 

Before the mxDSP card will operate correctly, its software must 
be updated. You can update the software automatically by 
opening a Telnet session to the control system. 

We recommend using Tera Term Pro Web 3.1.3, a free telnet 
client for windows, which can be downloaded from 
http://www.ayera.com/teraterm/ 

1. Open the Tera Term Pro telnet client.  

To configure the IP Address of your console open TCP/IP from 
the Setup menu, and add the TCP/IP address of your control 
system to the host list: 

2. Now set up a new telnet connection using File -> New 
connection. 

3. Enter the login name: root  and the password: hong  

Tera Term PRO opens a telnet session to the control system. 
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4. Open the mcx shell programme by typing mcxsh 

5. Then type the command mcx_software_auto_update 

The software on each card is automatically updated according 
to the system configuration: 

The mxDSP card is now ready for operation. 
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AdminHD Preferences 

This section deals with AdminHD‟s Preferences.  

1. Click on Extras -> Preferences from the main menu bar 
or press CTRL + P: 

The ‘Preferences’ pop-up appears: 

2. Use the tabs at the top of the pop-up to select a page. 

3. Select or unselect a preference. 

4. After changing a preference, click OK. 

Note that most preferences do not take affect until you next 
start the programme or open the relevant window. 

Also note that your Preferences are stored with the setup files 
for the ControlHD software. Therefore, they will remain as you 
last set them each time you start the programme. 

Also, if you are switching between both AdminHD and 
ControlHD on your computer, note that the preferences will 
affect both versions of the programme. 

There are six pages of options. Let‟s work through them: 
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Common 

The first page deals with common programme options: 

 Disable graphic frame pop-up after creating new 
hardware – tick this box if you wish to stop AdminHD 

automatically displaying the „Graphic View‟ when new 
hardware is added to the configuration. 

 Display large graphics (for extended screens) – 

select this option if you are working with a larger screen 
(e.g. 21”). The graphics are doubled in size. 

 Disable auto reconnect – tick this box if you wish to 

prevent AdminHD automatically reconnecting to the 
system if Network communication is interrupted. 

Start up 

This page deals with start-up options: 

 Hide Core Browser – tick this box if you do not want 

the „Core Browser‟ window to appear automatically 
when you open or create a new configuration.  

 Show remote log – tick this box if you do want the 

„Remote log‟ window to appear automatically when you 
open or create a new configuration. 
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Directories 

This page allows you to specify a default directory which will 
open whenever you save or open an AdminHD/ControlHD file 
type: 

1. Click on the folder next to the entry you want to specify – 
Config files, Remote log files, etc.: 

A file dialogue box for the selection of the path is displayed: 

2. Select the folder where you usually want to save your 
files and click on Open. 

The file dialogue is closed and the path displayed in the 
Preferences pop-up. 
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3. Repeat for all the file types: 

 Config files – AdminHD configuration files (.csv). 

 Remote log files – „Remote log‟ text files. 

 Coldstart config files – config.tcl files. 

 Core log message files – System log text files. 

 Snapshot files – „Connect Manager‟ snapshots. 

The default directory paths are set and will be used each time 
you save, open, export or download that type of file. 

Remote Communication 

This preference selects whether AdminHD checks the system 
version when connecting to it. This option is particularly useful if 
you are dealing with multiple systems running different versions 
of software. See Page 186 for details. 
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Connect Manager 

These preferences affect what happens when the „Connect 
Manager‟ window is opened: 

 Auto load connect manager in ControlHD mode – 

when ticked, the „Connect Manager‟ will automatically 
open when you open or download a configuration in 
ControlHD. This option does not affect AdminHD. 

 Auto switch to remote online mode – when ticked, 

AdminHD will automatically select online mode when 
you open the „Connect Manager‟. 

 Disable online overwrite lock – tick this box if you 

want overwrite lock to be disabled each time you open 
the „Connect Manager‟. 

 Enable connect/disconnect easy step mode – tick 
this box if you want easy step mode to be enabled each 
time you open the „Connect Manager‟. 

 Auto load config file after startup – when ticked, 

AdminHD will load a signal list when you open the 
„Connect Manager‟. The signal list is selected by clicking 
on the file open icon and making a selection from the 
pop-up. 

The default options are shown above. For more details on the 
best way to configure these preferences for online control, 
please see the ControlHD Operator‟s Manual. 
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Signal List Editor 

These preferences affect how the „Signal List Editor‟ creates 
new signal lists. The default preference options are shown 
above. 

The first two options affect mc2 systems only. 

With the default preferences, a new signal list for a mc2 system 
looks as follows: 

1. Tick the Enable physical Inputs/Monitors in DSP 
profile if you wish AdminHD to add the console‟s input 
channel and monitor channel signals to the Destination 
directories within the signal list. 

2. Remove the tick against the Disable A/B of 
Inputs/Monitors in DSP profile if you wish AdminHD to 
add the A and B input channel and monitor channel 
signals to the Destination directories within the signal 

list. 

For example: 

The third option - Show foreign signals if already in matrix 
list – may affect mc2, Nova73 or DSHS, and applies if the 
system is networked.  
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AdminHD Quick Reference Guide 

The Operating Console: 

1 Main Menus AdminHD provides 5 main menu options: 
File, Remote, Extras, Window and ?. 

2 Toolbar Many functions may be quickly accessed 
by clicking on buttons from the Toolbar. 

3 Sub Window 
Area 

Beneath the Toolbar is the main area of 
the Operating Console in which you can 
open a variety of sub windows such as 
the „Core Browser‟. 

4 Status Bar At the very bottom of the display you will 
see the Status Bar. This shows status 
information relating to the programme and 
operation such as the AdminHD mode 
and online/offline status. 

  

 



 
AdminHD 
AdminHD Quick Reference Guide 

234/ 303 V4.10/2 mc266 MKII Technical Manual 

The 5 Main Menus 

File 

Click on File to access the following menu options: 

 New – create a new configuration file. 

 Open – open an existing configuration file from your 

computer. 

 Open recent – lists the most recent files opened by the 

AdminHD programme. 

 Close – closes the current configuration session. 

 Save – saves the current configuration file. 

 Save As – saves the current configuration to a new 

filename. 

 Export file – options for exporting files: 

o Core cold start config (config.tcl) – see Page 153. 

o Component List – see Page 189. 

o BFE controller – this is a project-specific feature. 

o Remote Log – see Page 183. 

 Exit – click on Exit to close the AdminHD programme. 

Remote 

Click on Remote to access the following menu options: 

 Online/offline to remote system – enables or disables 

the online connection to the system, see Page 180. 

 Reconnect mode – when enabled, as shown opposite, 

AdminHD automatically attempts to reconnect to the 
system if Network communication is interrupted. 

 DSHS – accesses the dual self-healing star switchover 

option, see Page 207. 

 Upload all data to remote HD – uploads the AdminHD 

configuration to the system‟s warm start data. 

 Upload file – access to the cold start configuration 

upload options.  

 Download all data from remote HD – downloads the 

system configuration into your current AdminHD 
session. 

 Download file – downloads the system‟s .tcl files onto 

your AdminHD computer for backup purposes.  

 Reset system (cold send) – when working online, you 

can cold start the system from your AdminHD computer 
using this option. 
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Extras  

Click on Extras to access the following menu options: 

 Show mapping table – opens an overview of the 

mapping tables 1 to 16, see Page 149. 

 Check configuration – checks the AdminHD 

configuration for programming errors, see Page 151. 

 Preferences – selects the Preferences pop-up as 

described on Page 227. 

Window  

Click on Window to access any of the seven sub windows: 

 ?  

Select About from the Help menu for information about the 
version of your AdminHD software: 
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The Main Toolbar: 

1 

 

Open - open an existing configuration file (.csv) 

from your computer. 

2 

 

Save – save the current AdminHD session (as 
a .csv file) on your computer. 

3 

 

Download – download the system 

configuration into your current AdminHD 
session. 

4 

 

Upload – upload the AdminHD configuration to 
the system‟s warm start data. 

5 

 

Online to remote system – turn online mode 
on or off.  

6 

 

Preferences – access the Preferences pop-up, 
see Page 227. 

The remaining Toolbar buttons open or close the sub windows: 

7 

 

Core Browser - here you can navigate around 

the system and add system components. 

8 

 

Parameter Box - this window is used to display 
or enter settings for the component or signal 
selected within the „Core Browser‟. 

9 

 

Graphic View - this window shows a graphical 

representation of the hardware component 
selected within the „Core Browser‟. 

10 

 

Console Panel – only available in mc266 mode, 
this window is used to configure the console 
control surface. 

11 

 

Signal List – here you can create signal lists 
for use with the „Connect Manager‟ or mc2. 

12 

 

Connect Manager – online control to set matrix 

cross points, edit signal labels, control I/O 
parameters or save/recall snapshots. 

13 

 

Remote Log - this window logs all the 
messages generated by AdminHD or the HD 
Core. 
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The Core Browser Toolbar 

At the top of the „Core Browser‟ is its Toolbar: 

1 

 

Collapse all subnodes - click to hide all sub 
entries within the selected branch. 

2 

 

Expand all subnodes - click to show all sub 
entries within the selected branch. 

3 

 

Copy - click to copy the selected component 
and its sub entries. 

4 

 

Cut - click to cut the selected component and 
its sub entries. 

5 

 

Paste - click to paste the copied component, 
with sub entries, to the selected branch of the 
system.  

6 

 

Delete - click to delete the selected component 

and its sub entries.  

 

The Signal List Editor Toolbar 

At the top of the „Signal List Editor‟ is its Toolbar: 

1 

 

New - creates a new signal list. 

2 

 

Open - opens an existing signal list from your 

AdminHD computer. 

3 

 

Save – saves the current signal list 
configuration on your computer. 

4 

 

Save As – saves the current signal list under a 

new name on your computer. 

5 

 

Export – exports the current signal list 
configuration as a gui_config.tcl file and stores 
it on your computer. 
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6 

 

 

Download – downloads the signal list from a 
mc2 system to your computer. Only available in 
mc266 mode and if the system is online. 

7 

 

Copy – copies the current selection from the 
Directories & signals column.  

8 

 

Cut – cuts the current selection from the 
Directories & signals column. 

9 

 

Paste - click to paste selections to a directory in 
the Directories & signals column. 

10 

 

Move node(s) up – click to move the position 
of a signal or directory in the Directories & 
signals column. 

11 

 

Move node(s) down – click to move the 

position of a signal or directory in the 
Directories & signals column. 

12 

 

Add new directory/subdirectory – click to add 
a new entry to the Directories & signals 
column. 

13 

 

Delete - click to delete the selections within the 
Directories & signals column.  

14 

 

 

Locate signal – select a signal within the 
Directories & signals column and then click to 
locate its position within the Signal list. 

15 

 

 

Generate automatic tree view – click to 
automatically add directories, subdirectories 
and their signals from the Signal list into the 
Directories & signals column. 

16 

 

 

Update hardware signal config – click to 
update the Signal list if you make changes to 
the system configuration while working with the 
„Signal List Editor‟. 
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The Connect Manager Toolbar 

At the top of the „Connect Manager‟ is its Toolbar: 

1 

 

Open - opens a signal list from your AdminHD 
computer. 

2 

 

Export – exports a list of all connections as a 
.csv file and stores it on your computer. 

3 

 

 

Update hardware config – click to update the 

Source and Destination signals if you make 
changes to the system configuration. 

4 

 

Connect – click to connect the selected source 
to the selected destination. 

5 

 

Disconnect – click to disconnect the selected 
source from the selected destination. 

6 

 

Overwrite Lock – when enabled, a 
confirmation pop-up will appear each time you 
attempt to connect or disconnect signals.  

7 

 

Easy Step Mode – when enabled, the Connect 
Manager automatically steps down to the next 
source/destination after a connect is made. 

8 

 

Special User Label Edit Mode – when 

enabled, you can edit signal labels 
incrementally (e.g. PRES_01, PRES_02, 
PRES_03, etc.) by typing in the first label and 
then pressing return. 

9 

 

Clear all snapshot flags – click to clear all 
snapshot selection flags (blue flags). 
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Chapter 4: Service and Maintenance 

Introduction 

This chapter covers system servicing and maintenance, 
including details on software diagnostics tools and hardware 
servicing. At the end of the chapter you will also find a Trouble 
Shooting section to help fault find any problems. 

Software Versions 

Numbering 

From version 4.0.2.2 onwards, all Lawo products have adopted 
a consistent software release numbering system to indicate 
networking compatibility: 

The first three digits of the software revision number must be 
identical to ensure networking compatibility. 

For example, a Nova73 running Version 4.0.2.2 can be 
networked to a mc266 running Version 4.0.2.4. However, if the 
software revisions were 4.0.2.2 and 4.0.4.0, then they are not 
network compatible. 

Upgrading or Downgrading Software 

Please note the following: 

 If you are upgrading to software > V4.8.0.0 from a lower 
revision, then you will need to adjust the bay server 
rotary switch settings. See Page 278. This is also true if 
you wish to downgrade to software < V4.8.0.0 from a 
higher revision. 

 If you downgrade to software < V4.10.0.0 from a console 
with new fader software, then turn off the control surface 
before performing the upgrade. 
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Software Diagnostics and Maintenance 
Tools 

AdminHD/ControlHD System Diagnosis 

You can use the following windows within AdminHD or 
ControlHD to diagnose errors within your system remotely from 
a PC: 

 Graphic View – when running online, the Graphic View 

window updates to reflect hardware errors within the 
system: 

 

 Remote Log – this window will log all the messages 

generated by the programme or HD Core during online 
communication: 

For more details, please refer to Chapter 3: AdminHD. 
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mc
2
66 Console Diagnostics 

Ethernet Monitoring 

If the Ethernet connection between the control surface and 
Router Module fails, then the operator is presented with an 
error message: 

If the system is fitted with a redundant Router Module, then you 
can switch to the redundant Control System as follows:  

1. Click on the message and a confirmation pop-up 
appears: 

2. Select Yes to switch to the redundant control system or 
No to cancel. 

Selecting Yes causes an interruption to the audio. 

If you select No, then you MUST fix the problem with the 
connection before you can regain control of the audio. 

For more details on Control System redundancy, see Page 262. 
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The Signal Settings Display 

The Signal Settings display provides a graphical overview of 
the hardware contained within your system, and serves to 
provide a diagnostics tool in the unlikely event of a component 
failure. 

1. Press the SIGNAL button, located on the SCREEN 
CONTROL panel, to view the Signal Settings display: 

The two “trees” on the left of the display show the location of a 
signal within the Signal List (top) and its physical location in 
the System (bottom). Whenever a signal is selected from the 
Signal List, the System tree follows, and vice versa.  

You can open or close branches of the Signal List or System 

tree by clicking on the arrows or double-clicking on a 
directory/component name. 

As you select signals, a graphical representation appears in the 
middle of the display – in our example, we can see the DALLIS 
where our mic signal is connected.  

If all is well with the system hardware, then the components are 
coloured grey. However, if there is a problem, the component 
will be highlighted in red, and you will see a red/white cross 
next to the component name in the system tree. 
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When you select an individual signal a number of parameter 
tabs appear at the bottom of the display – in our example, 
General, Source, Mic/Line, Input DSP and General: 

Note that the parameter tabs depend on the type of signal 
selected. 

2. Select a tab to access I/O parameters for the selected 
signal. 

When working with the System Settings display you can resize 
the different areas by clicking and dragging the grey separator 
bars - for example, during normal operation you might hide the 
System tree until it is needed. If information within an area is 

hidden, then left/right or up/down scroll bars will automatically 
appear. 
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Diagnosing System Errors 

In the unlikely event of a component failure, a hazard warning 
flag appears in the title bar of the centre control screen. Note 
that this flag will appear at the top of any SCREEN CONTROL 
display, so you don‟t need to be viewing the Signal Settings to 

monitor your system hardware:  

1. Press the SIGNAL button, located on the SCREEN 
CONTROL panel, to view the Signal Settings display: 

A red/white cross and highlighted card reveal the problem. 

2. If the fault is hidden within the System tree, follow the 
red warning flags and open each branch of the tree to 
find the problem – in our example, a DALLIS card: 

If you open the DALLIS card further, you will see grey/white 
crosses beside Signal In 1, Signal In 2, etc. These show that 
the AES signals are no longer available: 

3. Check and replace the card if necessary.  

Once all components are connected and working correctly, the 
red/white crosses disappear from the System Settings display 
and the hazard warning flag is cleared. 
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The System Tree 

The System tree can be opened as follows: 

1. Close and then reopen the System to see all the Cores 
contained within your system network – e.g. Core 1: 

2. Open Core 1 to see all the Modules fitted to the core, 
and its power supplies – PSU 1 and PSU 2: 

3. And open a Module to view its ports and then any 
DALLIS units connected to those ports: 
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PSU Alarm (Desk PSUs) 

From Version 4.8 software onwards, the console GUI offers 
status monitoring for the console‟s external PSU(s). 

Note that if you have upgraded from an earlier software release 
to V4.8, then you will need to modify your hardware in order to 
support this feature, see Page 278. 

The status of each external PSU is represented by a symbol 
which appears at the bottom right of every console display: 

The symbols indicate: 

 Green Circle – the PSU is working fine. 

 Yellow triangle with an exclamation mark – the PSU 

is working fine, but there was a fault in the past which 
has now been cleared. Click on the icon to reset it. 

 Red circle with an exclamation mark – there is a fault. 

Hover over a symbol to reveal more information: 

In the mc266, the bay server to the right of the GUI display 
usually contains the direct connection to the console‟s external 
PSU. In our example, this is bay 4 (shown above). 

Depending on the frame size, more than one external PSU may 
be required, and additional symbols will monitor their status. 

Note that within the text on the GUI display, bays are counted 
from BAY 1 upwards. However, internally bays are addressed 
from 0. This means that BAY 1 on the GUI relates to an internal 
Bay Server address of 0, BAY 2 to an internal address of 1, and 
so on. 

See Page 278 for more details on Bay Server addressing. 
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System Information via Web Browser 

The Control System includes an integrated web server allowing 
status information to be monitored via a web page running on a 
service computer. 

Accessing the System Information Pages 

1. Connect your service computer either directly to the 
Control System, or via a Network Switch, using the 
instructions provided on Page 73. 

2. Configure the TCP/IP settings on your service computer. 

3. Once a connection is established, type the following into 
any normal web browser: 

http://192.168.102.65 where 192.168.102.65 is the IP address 
of the mc2 Control System. 

This opens the System Overview page within the browser: 

4. To automatically refresh any page turn on the Auto 
Refresh option at the top right of the screen. 

5. Use the navigation buttons on the left to access the 
following pages: 

 Global Alarm 

This page lists all errors which have triggered the Global Alarm. 
Every error has an explicit ID, description and time stamp. 
These errors are stored within the file: /var/log/alarm.log. 

 

 

http://192.168.102.65/


 
Service and Maintenance 

Software Diagnostics and Maintenance Tools 

mc266 MKII Technical Manual V4.10/2 249/ 303 

 Device Availability 

 Silence Detects Page 
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System Shutdown and Restart 

Shutting down the System 

The system should be shut down by powering down the 
external PSU unit(s) for the control surface and the power to the 
HD Core. 

Warning 

NEVER disconnect Harting power connectors from the control 
surface before switching off the external PSU. 

Note that the console control system is located within the 
Router Module of the HD Core. Therefore, it is here where your 
data is stored.  

Following switch-off, power is provided to the control system for 
a further 18 seconds in order to save all current settings to flash 
memory. This is called the console‟s warm start data. You will 
hear eight tones signaling that the shutdown operation has 
been successfully completed. The system is shutdown when 
the blue LED of the trackball is off. 

You may switch off the power to other system components – 
the DALLIS units - at any time.  

Starting the system 

To start the system, turn on the external PSU unit(s) and HD 
Core. Note that you may power the console and HD Core 
before other interfaces if desired. This enables you to begin 
setting up the console before your remote Stageboxes are 
connected. 

During the restart, the Central Control Screen displays the 
status during boot-up. If the system is set to warm start, then all 
of your previous settings (the warm start data) are recalled from 
the system‟s flash memory ensuring that the console comes 
back as it was last used. This procedure is called a warm start 
and ensures fast recovery from a loss of power. 

Note that you can set the system to cold start on start up by 
selecting the Force Cold Start option from the System 
Settings display. See Page 253 for details. 
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Data Storage 

The Control System reads and stores data to/from Flashcard. 
Two separate flashcards are used to keep the console‟s 
application software (System Flashcard) separate from any 
user data (Data Flashcard): 

This allows you to boot the system either with or without loading 
your user data, known as a warm start or a cold start 
respectively:  

Warm Start Data 

Following a warm start, the following settings are restored: 

 Matrix crosspoints. 

 The console‟s DSP configuration. 

 All configuration settings changed online by 
AdminHD/ControlHD. 

 The console‟s complete settings. 

 All DSP settings (EQs, dynamics, etc.). 

 All I/O parameters (e.g. gains of microphone preamps, 
SRC on/off, etc.) 
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Cold Start Data  

Following a cold start: 

 All matrix connections are cleared. 

 A default DSP-configuration is loaded. 

 All configuration files return to the defaults (i.e. do not 
include online updates). 

 The control surface will appear blank (no channel 
assignments). 

 All DSP settings are set to default values. 

 All I/O-parameters are set to default values 
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Performing a Restart 

The Control System can be restarted by powering off, and then 
on, the main PSUs on the rear of the HD Core. 

1. Power down the HD Core and wait until you hear the 
eight tones signalling that the shutdown operation has 
been successfully completed.  

The system is shutdown when the blue LED of the trackball is 
off. 

2. Then power on the core and the console control system 
will restart. 

Note that the system can be set to either warm or cold start 
from the Global options in the System Settings display: 

 If the Prepare Coldstart option is unchecked 

(recommended), then at the end of the next restart the 
console will load the last valid warm start data ensuring 
that the console comes back as it was last used. 

 Check the Prepare Coldstart option and the next time 

the system restarts it will do so without loading any user 
data. Use this option if there is a problem with your user 
data, or if you wish to clear all user data from the 
system. 

Note that you can also activate this option by pressing the 
Prepare Coldstart button on the HD Core Router Module. 
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Restarting the TFT display Bay Server 

Each TFT display on the mc266 has its own Ethernet Bay 
Server which can be restarted from the front panel. 

1. Using a pointed object, press the recessed button at the 
bottom of the display: 

The bay server restarts as indicated: 

Once the restart is complete, the selected display is reinstated: 
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Service Commands 

In addition to „user‟ level diagnostics, there a number of „service‟ 
level commands which may be used to perform lower level 
operations to the mc266 control system. These include: 

 Logfiles – can be used to view the logfiles of the control 

system. 

Starting a Telnet Session/Control System Log-
in 

You can run any of these commands remotely from your 
service PC via the system network. First open a Telnet session 
to the control system shell programme as follows: 

1. On your computer, select START -> Run…  

2. Type cmd in the Run window followed by OK: 

This opens a DOS command prompt window: 

3. Type telnet 192.168.102.65 and press enter. 

4. Next log-in to the mc266 control system by typing: 

Login:  root 

Password: hong 
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A log-in prompt appears showing the version of the shell 
programme: 

Viewing Logfiles 

The logfiles of the control system are stored in ,,/var/log and 
called “messages” and “messages.old”.  

1. To open the log, type: 

tail –n100 –f /var/log/messages 

where n is the number of old message lines which will be 
printed, and f sets the tail command to show all following log 
entries while the log is opened: 

tail -n 100 -f /var/log/messages 

Command option parameter option directory 

2. To close the active log, press CTRL + C. 
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HD Core 

Replacing the Fans 

Each of the 5 fans located at the rear of the HD Core frame can 
be replaced individually during operation: 

1. Unplug the 4-pin connector from the frame as shown 

above. 

2. Loosen the screws and remove the fan from the frame. 

3. Insert the replacement and fasten the screws to secure. 

4. Plug the 4-pin connector into the coupler of the frame. 

 

ScrewScrew

Screw Screw

Connector
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Replacing a Power Supply Unit 

Depending on your system specification, the HD Core may be 
delivered with single or dual redundant power supply units 
(PSUs). The PSUs are hot pluggable and can be replaced from 
the front of the frame as follows: 

1. Switch off the PSU you wish to replace: 

When two supplies are fitted, this will not affect the operation of 
the system. 

2. Disconnect the mains from either the PSU 1 or PSU 2 
IEC mains connector as appropriate. 

3. Unfasten the four screws and, using the handle 

provided, pull out the PSU. 

4. Before fitting the replacement PSU make sure that it is 
switched off. 

5. Insert the new PSU and slide it into position until it locks 
into place. 

6. Secure the unit by fastening the four screws. 

7. Re-apply the mains to the PSU IEC mains connector 

and switch on! 

Warning 

For air conditioning reasons, a HD Core in operation requires 
both PSU slots to be occupied. If you do not wish to have a 
redundant PSU, then please insert a dummy housing 
(Type 980/21). 
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HD Core Router Module (MKII) 

The mc266 requires the MKII Router Module (980/33) to be 
fitted to the HD Core. The module provides the following front 
panel connections and functions: 

ACTIVE LED Flashes green when the control system is 
running. The ACTIVE LEDs across all 

modules should flash in sync with each other. 
If an LED is out of sync, then the module is 
not synchronised to the rest of the system. 

STANDBY 
LED 

Illuminates in yellow when the module is 
running in redundant mode.  

CHARGE 
LED 

Illuminates when the backup power unit is 
charging. Off = unit is fully charged. 

ALARM LED Illuminates in red when the global alarm is 
triggered. See Chapter 4 for more details. 

SYNC LEDs These four LEDs indicate the current sync 
source (flashing green) and available 
redundant sync sources (solid green). 

PREPARE 
COLDSTART 

Press this button (the LED illuminates) to 
prepare a cold start. Having activated the 
button, the system will cold start on the next 
power cycle or restart. 

LAMP TEST Press this button to test all the LED lamps 
within the HD Core modules. 

MODULE 
TAKEOVER  

Press this button to force a takeover from the 
Active Router Module. (Functions only when 
two Router Modules are fitted.) 

ETHERNET A 

ETHERNET B 

Connects to the mc266 control surface. 

Connects to a system network or external PC 
for configuration, maintenance or control. 

Both connections are RJ45. 

The ACTIVITY LEDs flash green when data 
is being transferred. 

POWER 
Button 

This recessed button will power on or off the 
module (and Control System).  

Note that this button should only be used as 
a last resort if all other restart methods fail. 
Please see Page 250 for recommended 
shutdown and restart procedures. 
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Replacing the Router Module 

Follow the same procedure used to mount plug-in I/O cards as 
described in Chapter 2. 

Warning 

If only one Router Module is fitted to the HD Core, then to 
replace the board you will need to shutdown the system. 

Replacing the System or User Data Flashcard  

If you have a backup image copy of the System Flashcard or 
Data Flashcard then they can be replaced as follows: 

Note that you must power off the HD Core in order to replace a 
Flashcard.  

The Flashcards are located on the MKII Router Module within 
the HD Core.  

1. First power off the HD Core and remove the Router 
Module as described in Chapter 2 (Mount plug-in I/O 
cards). 

You will see the System and Data Flashcards slotted into the 
Control System: 

2. Remove the appropriate card and slide in your 
replacement. 

3. Replace the Router Module and power on. 
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I/O and DSP Modules 

At the front of the HD Core, you will find the plug-in modules 
description and part numbers silk screened onto the top and 
bottom of every I/O board. 

Use the part numbers to locate the relevant data sheets for card 
specifications and further information. 

Module Status LEDs 

The front of each module contains a number of useful status 
LEDs: 

 ACTIVE – This LED shows that the module‟s internal 
control system is running. The ACTIVE LEDs across all 
modules should flash in sync with each other when the 
system is running correctly. If an LED is out of sync, 
then the module is not synchronised to the rest of the 
system. Check that the module is fitted correctly and if 
the symptom persists replace the module. 

 Module Specific LEDs – Some modules include 

additional status LEDs. For details on these functions 
please consult the relevant data sheet. 

Replacing a Module 

Follow the same procedure used to mount plug-in I/O modules 
as described in Chapter 2. 
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Redundant Control System 

By fitting a redundant Router Module to the HD Core, a 
redundant Control System is added. If the main Control System 
fails, then the redundant Control System will automatically take 
over in the event of a software or hardware error. 

Connections 

Ethernet connections from both the main and redundant Router 
Modules are required (ETHERNET A to the console surface; 
ETHERNET B to the control network): 

 Ethernet A – connects to the mc2 control surface: 

 Ethernet B – connects to the system network or 

external PC for configuration, maintenance or remote 
control. 
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Automatic Takeover 

If the main Control System fails, then the redundant Control 
System will automatically take over.  

The redundant Control System is automatically activated if, 
internally, a loss of connection is noticed by the redundant 
system. This could be due to a software failure, hardware error 
or reboot of the main Control System.  

Note that if the Ethernet connection between the control surface 
and Router Module fails, then an automatic takeover does not 
occur, as the failure may be deliberate (e.g. you disconnect the 
Ethernet cable). 

Instead the operator is presented with an error message: 

1. Click on the message and a confirmation pop-up 

appears: 

2. Select Yes to switch to the redundant control system or 
No to cancel. 

Selecting Yes causes an interruption to the audio. 

If you select No, then you MUST fix the problem with the 

connection before you can regain control of the audio. 
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Manual Takeover 

You can force a manual takeover at any time from the System 
Settings display: 

1. Select the Global Topic and then select the 
Redundancy takeover option. 

A confirmation dialogue box appears: 

2. Select Yes to confirm or No to cancel the operation. 

Selecting Yes switches to the redundant Control System. 

Alternatively, press the Module Takeover button on the front of 
the redundant Router Module to force a takeover. 
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Updating the Configuration or Software 

For redundancy to work, both main and redundant Control 
Systems must hold identical information and mirror each other.  

User data (productions and warm start data) are mirrored at all 
times. However, the cold start configuration and system 
software are only synchronised when the Control System boots 
up. This has implications if you wish to upload a new AdminHD 
configuration or update system software: 

Let‟s take an example where your main Control System is 
called A and redundant Control System is called B. If you 
upload your new configuration or software to Control System A 
and then cold start it, the following will occur: 

 The system responds to the cold start of the main 
Control System by automatically switching to the 
redundant Control System (B). 

 At the end of the cold start, data from the active Control 
System (B) is copied back to the redundant Control 
System (A). In other words, your new data is 
overwritten! 

To avoid this, and upload a new configuration or update 
software successfully: 

1. Disable the redundant Control System. 

This can be achieved by releasing the locking catches which 
are fitted to the top and bottom of the redundant Router Module 
(see opposite). This unlocks the module from the HD Core and 
automatically disables it. Note that it is not necessary to pull out 
or remove the module.  

2. Now upload your new AdminHD configuration or 
software to the active Control System and cold start. 

The system restarts using the new configuration data. 

3. Once the main Control System is running the updated 
configuration/software, lock the redundant Router 
Module back into place to reactivate it. 

The redundant Router Module boots up, and all data from the 
main Control System is copied to it, ensuring that both modules 
are running the new data. 

4. Cold start the system once more, and check the new 
configuration/software. 

During steps 2 and 4 the system can be cold started by 
selecting the Prepare Coldstart option from the System 
Settings display, and then powering off and on the main PSUs 
of the HD Core. 
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DALLIS 

Replacing a Power Supply Unit 

Depending on your system specification, each DALLIS may be 
delivered with single or dual redundant power supply units 
(PSUs). The PSUs are hot pluggable and can be replaced as 
follows: 

1. On the rear of the DALLIS, disconnect the mains from 
either the PSU 1 or PSU 2 IEC mains connector as 

appropriate. 

2. Unfasten the two screws on the right hand side of the 
hinged PSU cage door (marked by the arrows below): 

Pull the door open to access the PSU docking bays: 
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3. Unfasten the metal catch which holds the PSUs in place 
by pushing on the catch as shown below: 

4. Remove the relevant power supply unit and replace with 
the spare. 

5. Fasten the catch back into place. 

6. Replace the cage door and fasten the two screws. 

7. Re-apply the mains to the PSU IEC mains connector. 
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DALLIS Master Board 

A choice of DALLIS Master boards are available determining 
the type of connection to the HD Core (MADI or ATM, 
multimode or single mode fibre) and whether the connection 
has redundancy. All versions of the board provide similar 
functions: 

ACTIVE 
LED 

Flashes green when the card‟s internal control 
system is running. The ACTIVE LEDs across all 
cards should flash in sync with each other. If an 
LED is out of sync, then the card is not 
synchronised to the rest of the system. 

WCLK OK Illuminates in green when the system is receiving 
a valid Wordclock sync signal. 

POWER 
OK 

Illuminates in solid green when the DALLIS PSU 
is running normally. If the LED flashes, then there 
is a PSU error. 

ALARM Illuminates in red when any of the following error 
conditions are triggered: PSU error; internal 
health state error; sync error; MADI (or ATM) link 
error; rack configuration error. 

WCLK The DALLIS may be synchronised to an external 
wordclock reference connected to the WCLK 

BNC.   

MADI or 
ATM Ports  

A range of the DALLIS master board options are 
available: 

 947/05 (shown opposite) – Provides a 
single MADI port connection using 
multimode fibre. 

 947/07 – Provides one main (MADI A) 
plus one redundant (MADI B) port using 
multimode fibre. 

 947/15 – Provides a single MADI port 
connection using single mode fibre. 

 947/03 – Provides a single ATM port 
connection using multimode fibre. 

On some cards, LEDs show the status of the 
signals arriving at the connection. 

CTRL 
(RS422) 

Serial connection to PC for updating system 
firmware. 
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Replacing the Master Board 

Follow the same procedure used to mount plug-in I/O cards as 
described in Chapter 2. 

Replacing the Lithium Battery 

The master board in the DALLIS is fitted with a lithium battery. 
This battery guarantees that your data remain saved also when 
the system is switched off. As a precaution we recommend that 
the battery is replaced after about eight years of operation. 
Please send the master board to your local service 
representative to perform this procedure. 

Only service staff may replace batteries. 

Warning 

If only one Master Board is fitted to the DALLIS, then replacing 
the board will stop and reboot the DALLIS causing an 
interruption in audio from that unit. 
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I/O Cards 

At the front of the DALLIS, you will find the plug-in card 
description and part numbers silk screened onto the top and 
bottom of every I/O card. 

Use the part numbers to locate the relevant data sheets for card 
specifications and further information. 

I/O Card Status LEDs 

The front of each I/O card contains a number of useful status 
LEDs: 

 ACTIVE – This LED shows that the card‟s internal 

control system is running. The ACTIVE LEDs across all 
cards should flash in sync with each other when the 
system is running correctly. If an LED is out of sync, 
then the card is not synchronised to the rest of the 
system. Check that the card is fitted correctly and if the 
symptom persists replace the card. 

 Card Specific LEDs – Some cards, for example, the 

Phantom Power card, include additional status LEDs. 
For details on these functions please consult the 
relevant data sheet. 

Replacing an I/O Card 

Follow the same procedure used to mount plug-in I/O cards as 
described in Chapter 2. 
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Console Power Supply Unit 

PSU Status LEDs 

Internally, the console‟s external PSU is equipped with three 
power supplies running in parallel. For correct operation, only 
two supplies are required; the third is for redundancy. If more 
than one of the internal supplies fails, then the complete PSU 
rack must be replaced. Please send the defective rack to Lawo 
for repair. 

LEDs on the front panel show the status of each internal supply 
and the two mains connections: 

 MAINS PRIMARY and BACKUP – illuminate in green 

when the mains power connected to each supply is ok. If 
a connection fails, then the LED goes out. 

 PSU 1 to 3 – illuminate in green when each internal 

power supply is ok. If a supply fails then the LED goes 
out. 

 ERROR – this LED will flash (red) if: 

o one or more of the mains inputs fail. Only one mains 
input is required to operate the system. 

o one or more of the internal PSUs fail. For correct 
operation, only two supplies are required; the third is 
for redundancy. 

 HIGH TEMPERATURE – illuminates if the internal 

temperature exceeds 56 C. The fan is active until the 

temperature falls below 42 C. 
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Control Surface 

Within each channel or centre section (GUI) bay, individual 
panels connect via USB to an Ethernet Bay Server. Each Bay 
Server then connects back to the Control System within the HD 
Core via Ethernet in a „star‟-like architecture. Point-to-point 
connections provide fault tolerance, and allow any bay or panel 
to be isolated from the rest of the console: 

Please see Page 254 for details on how to restart a Bay Server. 
This may be necessary if the Ethernet connection to the Control 
System is interrupted. 
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Calibrating the Touch-screen 

You can calibrate the touch-screen for the mc266. You will need 
to open a Telnet session and connect to the central GUI control 
system to do this. We recommend using Tera Term Pro Web 
3.1.3, a free telnet client for windows, which can be downloaded 
from http://www.ayera.com/teraterm/ 

1. Open the Tera Term Pro telnet client.  

To configure the IP Address of your console open TCP/IP from 
the Setup menu, and add the TCP/IP address of your console 
control system to the host list: 

The default TCP/IP address of a mc256 control system is 
192.168.102.56. 

2. Now set up a new telnet connection using File -> New 
connection. 

 

 

http://www.ayera.com/teraterm/
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3. Enter the login name: root  and the password: hong  

Tera Term PRO opens a telnet session to the console’s control 
system: 

To calibrate the touch-screen, you need to connect to the 
central GUI control system (GUI_0). 

4. To find out its IP address, type ipinfo and press Enter. 

The IP addresses of all GUI and decentral bays are displayed:  

Find the IP address for the GUI_0 control system – in our 
example, it is 192.168.105.100. 
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Now connect to the thaddaeus_GUI_0 control system: 

5. Type telnet 192.168.105.100 (the IP address of the 
GUI_0 control system) and press Enter. 

6. Login by typing login: root and password: hong: 

7. Next type calibrateTouchscreen and press Enter. 

The calibration options appear as shown above. 

8. Select either a simple or more complex calibration and 
follow the instructions. 

9. Option 3 will test the calibration. 
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Replacing a Control Surface Panel 

Each panel is hot-pluggable making it easy to service. To 
replace a panel: 

1. Unfasten the panel screws and gently lift the panel using 
the pullers provided: 

2. Remove the USB and power connectors taking notes on 
where each one should be fitted. 

3. Carefully remove the panel. 

Check that the rotary switch settings on your replacement panel 
are correct (see below). 

4. Insert your replacement. 

5. Reconnect the panel. 

 If the console is turned on, the panel will boot within a couple of 
seconds. 

Control Surface Panel Rotary Switch Settings 

Each control surface panel has a rotary switch with two 
settings: 

 Function - this setting determines the function of the 

panel. For example whether it is a fader panel, free 
control (FC) panel, etc. 

 Address – this setting determines the panel index and 

is set according to the frame layout of your console. 

When replacing a control surface panel, check that both the 
function and address setting are correct for the panel type (see 
next page). 
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 Central USB Control Panel Rotary Switch Settings 

  mc²66MKII 

Address 0 

function 0 

 Main Fader USB Control Panel Rotary Switch 
Settings 

n = number of decentral bays 

  mc²66MKII 

Address  n 

function  8 

 Decentral USB Control Panel Rotary Switch 
Settings 

  mc²66MKII 

Address 0 

function 0 
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Bay Server Rotary Switch Settings 

Every Bay Server has a rotary switch with two settings: 

 Function - this setting determines whether the Bay 

Server is a channel or centre section (GUI) bay.  

 Address – this setting determines the Bay Servers‟ 

index, and is set according to the frame layout of your 
console.  

The “address” setting is counted from left to right across the 
console starting at 0.  

You may need to adjust the bay server rotary switch settings if 
you are upgrading or downgrading to or from Version 4.8 
software or adding an extender bay. 

 Upgrading to V4.8 Software 

From Version 4.8 software onwards, the function settings for 
bays with a direct PSU connection differ to those with no 
connection. This change was made to support the PSU 
monitoring feature described on Page 245. Therefore, if you 
upgrade or downgrade software, or change the power 
connections within your console, you will need to modify the 
Bay Server switch settings. 

Please note the following: 

 You only need to change the Bay Server switch settings 
if you have upgraded from an earlier release. All 
consoles shipped with Version 4.8 or later have their 
rotary switches set correctly when they leave the factory. 

 Only perform this procedure after installing the Version 

4.8 release of software. 

 If you wish to revert back to an earlier software release, 
then all changes made to the hardware must be 
reversed to avoid conflicts. 
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In the mc266, the Bay Server to the right of the GUI display 
usually contains the direct connection to the external PSU. If 
more than one external PSU is supplied, then check the Harting 
connectors on the frame. 

Follow the instructions on Page 266 to remove the TFT screen 
in order to access the Bay Server Rotary Switch: 

The following table shows the settings required for channel and 
GUI bays with or without a direct PSU connection, when 
running software versions before or after 4.8: 

 Adding an Extender Bay 

The “address” setting is counted from left to right across the 
console starting at 0.  

Extender bays are considered as further bays. If an extender is 
added to left, then the “address” settings of the main frame 
must be shifted upwards. If the extender is added to the right, 
then its address can be counted upwards from the main frame. 

 

For more details on Bay Server or Control Panel rotary switch 
settings, please refer to the separate documentation: 

“TD_address_configuration_bay_server_control_panels”. 
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Trouble-shooting 

This section includes a series of typical problems and tips to 
help you fault find the mc266 system. 

 The console will not boot or does not boot 
correctly 

1. Power off the HD Core and wait for the system to 
shutdown. 

The system has completed its shutdown when the blue LED of 
the trackball is off. 

2. Power on to try a warm start. 

3. If this is unsuccessful prepare a coldstart, either from the 
System Settings display (Global options) if accessible, 
or by pressing the Prepare Coldstart button on the HD 
Core Router Module. Power off and on again (waiting for 
the system to shutdown in between) to perform a cold 
start. 

If the console now boots correctly, then your warm start user 
data is corrupt. Check your production data by loading a 
Production. If there is a problem with the production data, then 
you may need to replace the Data Flashcard (see Page 260.) 

4. If this is still unsuccessful, then you should try replacing 
the System Flashcard with a backup copy as described 
on Page 260. 

 The console boots up but I have no audio. 

1. Check the console‟s System Settings display to see if 
there any reported errors. 

If the system looks ok then: 

2. Check the fibre connections between the HD Core I/O 

module and any DALLIS units. 

3. Check that all the ACTIVE LEDs on modules within the 
HD Core, and cards within the DALLIS, are green and 
flashing synchronously at around 100Hz.  

If not, try re-plugging the card or module to reboot it. 

4. If everything still looks ok, then try reloading the DSP 
configuration from the console‟s DSP Config display. 
(Please see the Operator‟s Manual for details.) 
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 One of the control surface panels is not working. 

1. Carefully lift out the panel, and check the connections. 

2. Try disconnecting the USB and power connectors to the 
panel, and then reconnecting the USB and power. 

Try this a few times to see if the panel will boot. If not, then the 
panel may be faulty so please contact your local service 
representative. 

 The graphics on the TFT displays freezes 
temporarily 

This may occur if the load on the CPU exceeds 95% - for 
example, during a production load. Audio processing is 
unaffected, and therefore the behaviour should be ignored. 
Once the production has loaded, and the CPU returns to normal 
levels of operation, all graphics should update correctly. 

 The graphics on a TFT display freezes or looks odd 

If a Bay Server looses its Ethernet connection to the Control 
System, then it may need to be reset.  

1. Follow the procedure described on Page 254 to reset 
the Bay Server. 

 The Network connection between my AdminHD or 
mxGUI PC and the control system is not working. 

Try a PING command from your PC as follows: 

The PING command is a built-in Windows function and allows 
you to test whether you have a valid network connection to and 
from the system (or any other networked device). 

With your PC connected to the system network, proceed as 
follows: 

1. On your computer, select START -> Run…  

2. Type cmd in the Run window followed by OK: 
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This opens the DOS command prompt window similar to that 
shown below: 

3. Now type the following (assuming that the IP Address of 
the control system is still set to its factory default): 

ping 192.168.102.67 

4. Press ENTER  on your computer keyboard: 

Windows will now try to establish communication: 

 If the ping command fails, then you will receive 
something similar to that below: 

This tells you that your PC is not communicating with the 
master board via the network connection. Check your physical 
connections, and also the IP settings on your computer. 
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 If the ping command is successful, then the result will be 
as follows: 

This tells you that a valid network connection is established 
between your computer and IP device. 

If you do not receive an answer from the system then check 
your connections and TCP/IP settings. 

You can find information of changing IP settings within 
Windows from 
www.practicallynetworked.com/sharing/troubleshoot. 

 

 

http://www.practicallynetworked.com/sharing/troubleshoot
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Technical Data 

For technical details on system components, please refer to the relevant data sheets. The 
following part numbers will help you locate data sheets for the principle components: 

System Component  Part Number 

Control Panels: Centre Section Screen Control 962/10 

 Central Audio Lower  962/11 

 Central Audio Upper  962/12 

 FC Preset  962/13 

 Main Fader Panel 962/32 

User Panels: Centre Section 40 Keys 962/14 

 8 Rotary Controls 962/15 

 Talkback 962/16 

 Machine Remote 962/17 

 Automation 962/18 

 80 Keys 962/19 

Control Panels: Channel Bay FC Panel 962-20 

 Fader Panel 962-21 

 Channel Display 962-22 

mc266 PSU External PSU unit 962/04 

DALLIS Unit Frames: 3RU DALLIS Frame 940/03 

 6RU DALLIS Frame 940/06 

HD Core Frame 10RY HD Core Frame 980/02 

Part numbers for the HD Core Module options and DALLIS I/O interfaces can be found in 
Appendices A and B. 
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GNU Public License 

The following modules are used in the HD Core: 

 Box Nova 73 

Linux Kernel 2.6 x  

μCLinux 2.4 x x 

netsnmp x x 

busy box x x 

TCL x x 

xFree86 x  

The GPL source code contained in this product is available at Lawo service department. If 
you would like a copy of the GPL source code in this product on a CD, please send €9,90 to 
Lawo for the cost of preparing and mailing the CD to you. 
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Appendix A: HD Core Module Options 

The following HD Core plug-in modules are supported in this release of software: 

Central Router Modules 

980/33 ROUTER 
MKII 

Routing Matrix 8k², 8192 crosspoint, integrated control system 

I/O Modules 

981/02 AES3 32 in- and outputs AES/EBU (via a rear connector panel); 

1 Port MADI (optical) 

981/31 MADI 2 ports MADI (optical) 

981/32 MADI 2 double ports MADI (optical, connection of redundant fibre) 

981/36 6 double ports MADI (optical, connection of redundant fibre) 

981/38 8 ports MADI (optical) 

981/41 MADI 2 ports MADI (optical, single mode fibre) 

981/53 ATM 3 ports ATM (optical) 

981/56 ATM 6 double ports ATM (optical, connection of redundant fibre) 

DSP Modules 

983/02 24 channels for mixing consoles mc² series 

983/03 24/48 channels for the mixing console mc²series or matrix DSP board 
(depending on the configuration) 

 

For module specifications, please refer to the relevant data sheet. Details on the I/O Module 
connections follow in Appendix B. 
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Appendix B: HD Core Module Connector Panels 

When mounting AES modules and connector panels, note that the BNC or D-Sub Connector 
panel always corresponds to the AES module which is right-aligned with the Connector panel 
slot (looking from the front of the HD Core). 

For example, if you want to use the top left back panel for a D-Sub Connector Panel, then 
you must use the 2nd module slot for the AES board.  

If you want to use the top left back panel for a BNC Connector Panel, then you must use the 
4th module slot for the AES board.  

If you use a mixture of connector panels, then follow the right-align rule – for example. if the 
1st and 2nd connector panels are D-Sub and the 3rd is BNC, the AES modules must be 
mounted in slot 2 (D-Sub1), slot 4 (D-Sub2) and slot 8 (BNC). 



 
 
Appendix B: HD Core Module Connector Panels 

288/ 303 V4.10/2 mc266 MKII Technical Manual 

980/14 Connector Panel D-Sub 

 Connector panel to be mounted at the rear of the frame type 980/02 

 Signal supply by plug-in card at the front (seen from the front: on the slot right-aligned 
to the connector panel): 

o Plug-in card 981/02 for realising the AES3 interfaces (transformer coupled) 

 Outputs: 4 plugs D-Sub 25-pin, each with 8 balanced contacts 110  

 Inputs: 4 plug sockets D-Sub 25-pin, each with 8 balanced contacts 110  

 

 

Inputs 1…8Outputs 1…8

Outputs 9…16

Outputs 17…24

Outputs 25…32

Inputs 9…16

Inputs 17…24

Inputs 25…32
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980/15 Connector Panel BNC 

 Connector panel to be mounted at the rear of the frame type 980/02 

 Signal supply by plug-in card at the front (seen from the front: on the slot right-aligned 
to the connector panel): 

o Plug-in card 981/02 for realising the AES3 interfaces (transformer coupled) 

 Outputs: 32 BNC connector, un-balanced contacts 75  

 Inputs: 32 BNC connector, un-balanced contacts 75  

 

Connector Panel

980/ 15 BNC

AES3

(unbalanced, 75 Ohm)

1

9

17

25

8

16

24

32

1

9

17

25

8

16

24

32

Inputs

Outputs

Inputs 1…8

Outputs 1…8

Outputs 9…16

Outputs 17…24

Outputs 25…32

Inputs 9…16

Inputs 17…24

Inputs 25…32

1          2           3          4

5         6          7          8

9        10         11        12

13       14        15        16

17        18        19        20

21       22        23        24

25        26        27        28

29       30        31        32
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Appendix C: DALLIS Interface Options 

Card Description Fibre Ports Part No. 

Master Board MADI Multimode Fibre (MMF)  1 port 947/05 

Master Board MADI Multimode Fibre (MMF) 2 ports  947/07 

Master Board MADI Single mode Fibre (SMF)  1 ports  947/15 

Master Board ATM Multimode Fibre (MMF)  1 ports  947/03 

Card Description Part Number & Connector Type Inputs Outputs 

D-Sub XLR BNC 

Mic / Line 
(transformer) 

941/52 941/62 - 4 mono - 

Line in 
(transformer) 

941/02, 04, 
06 

941/12, 14, 
16 

- 4 mono - 

Line out 
(transformer) 

942/02, 04, 
06 

942/12, 14, 
16 

- - 4 mono 

Mic / Line  

(electric.-balanced) 

941/51 - - 8 mono - 

Line in  

(electric.-balanced) 

941/84 - - 8 mono - 

Line in/out  

(electric.-balanced) 

941/83 - - 8 mono 8 mono 

Line out  

(electric.-balanced) 

942/84 - - - 8 mono 

Headphones 942/61 - - - 4 stereo 

AES3 in (with 
SRC) 

943/02, 84 943/12 - 4 stereo - 

AES3 in/out  (with 
SRC in) 

943/52 - 943/72 4 stereo 4 stereo 

AES3 in/out  

(with SRC in/out) 

943/54 - 943/74 4 stereo 4 stereo 

AES3 out 944/01 944/11 - - 4 stereo 

SDI  

(embedded audio) 

946/09 - BNC 1 SD SDI 

(video) 

1 SD SDI 

(video) 

HD/SD SDI 

(embedded audio) 

946/13 – BNC 1 HD/SD 
SDI 

(video) 

1 HD/SD 
SDI 

(video) 
For card specifications, please refer to the relevant data sheet. 



 
 

Appendix D: DSP Configurations 

mc266 MKII Technical Manual V4.10/2 291/ 303 

Appendix D: DSP Configurations 

Up to 8 DSP modules may be fitted to the HD Core to provide DSP resources for the mc266 
console. These DSP resources are allocated using DSP configurations, selected from the 
console‟s DSP Configuration display:  

Please note that the variation with 1 DSP board includes: 1 x stereo PFL; 1 x  stereo AFL. 

All other variations include: 2 x stereo PFL; 1 x  stereo AFL; 1 x surround AFL (7.1). 
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Glossary 

48kHz or 44.1kHz See Sample Rate. 

Access On the mc266 console, much of the channel parameter operation 
is performed by assigning a fader strip to the Central Control 
Section. This is otherwise known as putting a source „in access‟.  

AdminHD Lawo‟s configuration and control software for HD Core systems. 

ATM Asynchronous Transfer Mode (Packing of signals in small 
portions; commonly used and highly standardised network 
protocol). 

Attack Time In the context of dynamics processing (compressor, limiter, gate 
or expander), the attack time defines the duration over which an 
input signal is measured. The longer the attack time, the slower 
the processor will react. For example, when using a gate, a fast 
attack time causes the gate to open quickly when signal exceeds 
the gate threshold. 

Aux  Auxiliary 

An Aux is a general purpose mono, stereo or multi-channel 
summing bus which can be used for a variety of applications such 
as sending to outboard effects devices. 

Aux Send Auxiliary Send 

Source channels feed onto each aux via their Aux Send. The aux 
send from each channel can be either pre or post fader and has 
variable level control. 

Aux Master Auxiliary Master 

The Aux Master is a master source channel used to control the 
level and processing of the Aux output. The direct output of the 
Aux Master is the signal routed to the outboard effects send. 

Aux Return Auxiliary Return 

The Aux Return is the name given to the return channel from the 
outboard effects device. This channel controls the level and 
processing of the effect as it is summed into the rest of the mix.  

Band Pass Filter See Filters. 

Balance Balance is applied to the input of a stereo channel and is the ratio 
between the left and right input levels. When Balance is set to its 
default value, the level of left and right inputs are equally 
weighted. 

Bargraph An optical display instrument in the shape of a LED bar for 
displaying signal level. 
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Clean Feed See Mix Minus. 

Compressor A dynamics processor used to smooth out uneven signal levels. 
For example, when a presenter shouts and then whispers, they 
are producing sound which has a wide dynamic range; one 
moment it is very loud and the next very quiet. This can mean 
that if we listened to this signal on our radio without compression, 
we would forever be turning the level up and down! A compressor 
smoothes the signal such very loud audio is reduced in level and 
very quiet audio is increased in level. This results in smaller 
dynamic range ideal for radio transmission.  

Configuration The system configuration is a file created by the AdminHD 
software. The file may be exported and uploaded to the system‟s 
cold start data where it will load following a cold start. Or, the file 
may be uploaded to the system‟s warm start data where it is then 
loaded every time the system reboots or powers on. The 
configuration defines key elements of the system such as the 
hardware components, and default signal parameters. 

ControlHD Lawo‟s control software for HD Core systems. 

DALLIS Lawo‟s modular I/O interfacing system based on 19” frames using 
plug-in cards for different interfaces. 

dB deciBel  

A unit of transmission giving the ratio of two powers.  

The number of bels is the logarithm to the base 10 of the ratio of 
the two powers. One decibel equals one tenth of a bel. 

dBU dBU is used to describe levels within the analogue domain, and is 
a measure of absolute voltage level based on 0dBU = 0.775 Volts 
(RMS). dBU is often used to indicate nominal broadcast operating 
levels. For example, in the EBU normal broadcasting level = 
+6dBU.  

dBFs dB Full Scale 

dBFs is used to describe levels within the digital domain. 0dBFs 
describes the system‟s internal clipping point; this is the 
maximum level which may be handled by the system without 
signal distortion. For example, your system may be set for 
+18dBU = 0dBFs. If your normal broadcast level is +6dBU then 
this leaves an operating headroom of 12dB. 

Delay The signal output from a delay module is x ms behind the signal 
input to the module. Delay is often applied to audio sources 
whose video has undergone digital video processing; delay is 
required such the audio remains in sync with the video. 
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Direct Out Direct Output 

The direct output of a channel is the output of the individual 
source. Direct Outputs are often used to provide a record or 
„snoop‟ feed of a single source, and may be taken from various 
points within signal flow: pre fader, post fader, etc. 

Drop-out Interruption of the audio signal caused by an error in the signal 
transfer or recording. 

DSP Digital Signal Processing 

Digital signal processing (DSP) is the study of signals in a digital 
representation and the processing methods of these signals. 

Dynamics Dynamics is the collective terms given to audio processing which 
responds to changes in signal level. For example, a Compressor, 
Limiter, Gate or Expander. 

EQ Equaliser. 

An equaliser is a processor which changes the frequency 
characteristics of a signal, for example to increase the amount of 
treble or bass components in the signal. 

Expander A dynamics processor used to magnify changes in the dynamic 
range of the input signal. For example, to reduce noise in speech 
pauses. See also Compressor.  

Fader A potentiometer used to adjust the gain of a signal. 

Filters Filters are equaliser sections which are used to cut out or reduce 
specific frequency bands within the signal. For example, a Low 
Pass Filter cuts out high frequencies so will result in less treble to 
the sound. A High Pass Filter cuts out low frequencies, for 
example you may use this to remove unwanted low frequencies 
like hum or rumble. A Band Pass Filter cuts out both high and low 
frequencies allowing frequency components within the band to 
pass through the signal; for example, you may use this type of 
filter to create a telephone effect on a normal voice. 

Gain Adjusting the gain of a signal results in a change in the perceived 
level or amplitude. An increase in gain (positive values) results in 
amplification and a reduction in gain (negative values) in 
attenuation. 

Gate A dynamics processor used to remove unwanted signals below a 
certain threshold level. For example, if a gate is applied to a 
presenter‟s microphone source, then when they speak signal 
level exceeds the gate threshold and the gate opens, while if they 
make a low level sound, like shuffling in their seat, the gate 
remains closed. The result is that only the signal we want to hear 
is output from the source channel! 

GPI General Purpose Interface – inputs (e.g. optocoupler) and outputs 
(e.g. relay) for logical signals with two states. 
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HD Core Core of the system (Lawo core includes the routing matrix, I/O 
modules and DSP). 

Headroom The amount of operating level which is in reserve between normal 
operating level and 0dBFs. 

High Pass Filter See Filters. 

Insert Point A connection point within the source channel which interrupts the 
signal flow and routes out to a piece of external equipment and 
returns back to the source channel.  

Insert send = route out from the source channel to the external 
device. 

Insert return = input to the source channel from the external 
device. 

Limiter A dynamics processor used to stop signals exceeding a certain 
threshold level. For example, you may place a limiter across the 
main output of the programme to prevent a sudden increase in 
level exceeding the clipping point of your transmission feed and 
causing signal distortion. 

Low Pass Filter See Filters. 

MADI Multi-channel Audio Interface; digital interface for combining 
audio signals of 56 or 64 channels. 

Mix Minus 

 

Mix Minus, Clean Feed and N-1 are all terms used to describe a 
feed which is created from a number of channels minus a 
particular channel or channels. For example, to provide telephone 
hybrids with a feed of the programme minus the incoming phone 
call. 

Monitor Term used to describe the outputs and functionality of feeds to 
loudspeakers or headphones for the purpose of listening to a mix. 

ms milliseconds 

Unit of time measurement. 

M-S Middle and Side Stereo 

Used to describe an arrangement of two coincident microphones, 
one pointing to the front (Middle) and the other (bidirectional) at 
right angles providing a Side signal. The mc266 provides M-S to 
X-Y decoding to turn the Middle and Side signal into normal Left 
and Right stereo.  

mxGUI Lawo‟s control software for mc2 and Nova73 systems. The 
software runs GUI displays from an external PC and can be used 
either online or offline. 

Nova73 A stand alone routing matrix with networking capabilities; the 
name given to the HD Core unit without a console control surface. 
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N-1 See Mix Minus. 

On-Air Term used to indicate that a radio or TV programme is being 
broadcast. 

Overload Occurs when the signal level is too large for the system, resulting 
in signal distortion. 

Panning Used to control the left/right position of a mono source when 
routed to a stereo or multi-channel output. For example, if a 
source is panned left, then you will all signal from the source is 
routed to the left side of the summing bus. If a source is panned 
centre, equal levels are applied to the left and right sides of the 
summing bus, etc. 

PFL Pre Fade Listen 

Used to listen to signals before the application of fader level. 
Provides a way of listening to a source when the fader is closed 
to check its signal before the fader is opened to route it onto the 
programme output. 

Phantom Power This is the power supply required when working with condenser 
microphones. The console supplies 48V to the microphone via 
the audio connector. 

Programme The main output of a live broadcast console. This is the mix which 
feeds the transmission chain. 

Ratio In the context of a compressor or expander, the ratio defines how 
much compression or expansion is applied. For example, the 
higher the compressor ratio, the more signal levels above the 
compressor threshold will be compressed. 

Release Time In the context of dynamics processing (compressor, limiter, gate 
or expander), the release time defines the time taken for the 
action of the processor to subside. For example, when using a 
gate, a short release time will cause the gate to close quickly after 
signal falls below the gate threshold. 

Roll-off Frequency See Shelving EQ. 

Routing Signal Routing 

Term used to describe the connection made between an input 
and output. 

RS422 Type of serial interface used to communicate with external 
devices. 

RU Rack Units ⇒ 44,45 mm respectively 1,75 inch 
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Sample Rate The speed at which the internal processing of the system takes 
samples respective to values from a continuous, analogue audio 
signal to make a discrete, digital one. For example, when running 
at 48kHz, incoming analogue audio is sampled at a rate of 48000 
values per second. 

Shelving EQ A shelving equaliser band is used to increase or decrease high or 
low frequency components of a signal. The slope of the shelf 
defines how steeply the gain increase/decrease is applied. The 
roll-off frequency defines the frequency at which signal level is 
reduced by 3dB.  

Slope See Shelving EQ. 

SMPTE Abbreviation for Society of Motion Picture and Television 
Engineers 
Standardised protocol for the synchronisation of audio and video 
technology ⇒- timecode. 

SRC Sample Rate Converter. 

Sum  Summing Bus 

The result of several audio signals mixed together within the 
console.  

Within the mc266, the name given to the main output busses 
(programme busses). 

Telephone Hybrid Device which deals with bi-directional signals to/from a 2-wire 
phone line. One line provides an incoming feed from the phone 
line (e.g. the guests voice), and the other sends signal back to the 
receiver (e.g. the mix minus feed). 

Threshold In the context of dynamics processing (compressor, limiter, gate 
or expander), the threshold defines the signal level at which the 
processor starts to act. For example, the gate threshold sets the 
level at which the gate will open and then close. 
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Index Directory 

? menu .................................................. 236 
3rd Party Control Systems ...................... 31 
44.1kHz .................. See Sampling Frequency 
48kHz...................... See Sampling Frequency 
88.2kHz .................. See Sampling Frequency 
96kHz...................... See Sampling Frequency 

A 

Admin HD 
arranging the sub windows ............... 109 
basic operation ................................. 102 
checking your configuration .............. 152 
computer TCP/IP Address ................ 119 
configuration parameters .................. 192 
Connect Manager ............................. 178 
connecting to the system .................. 118 
copy/paste components.................... 132 
Core Browser .................................... 105 
defining the system ........................... 125 
deleting components ........................ 135 
documenting your system ................ 188 
downloading a configuration ............. 122 
downloading a signal list................... 161 
editing parameters ............................ 141 
exporting a component list ............... 190 
exporting a configuration (cold start) 154 
exporting a connection list ................ 180 
fibre redundancy ............................... 136 
files & organisation ........................... 113 
Graphic View .................................... 110 
mapping tables ................................. 150 
mc2 configuration .............................. 213 
multi-channel sync ............................ 146 
Nova73DSHS configuration ............. 208 
operating levels ................................. 147 
overview .............................................. 87 
Parameter Box .................................. 111 
port redundancy ................................ 137 
preferences ....................................... 228 
Remote Log .............................. 112, 184 
sampling frequency .......................... 149 
saving your configuration.................. 152 
Signal List Editor ............................... 160 
signal names & labels ....................... 142 
software installation ............................ 96 
system diagnostics ........................... 181 
system requirements .......................... 96 
system TCP/IP Address ................... 145 
system version check ....................... 187 
the operating console ....................... 107 

the System ........................................ 104 
uploading a configuration (cold start) 154 
uploading a configuration (warm start)

 ....................................................... 158 
uploading a signal list ........................ 162 

AES3-id sync .......................................... 78 
Air Conditioning 

Console PSU ....................................... 68 
Console Surface.................................. 61 
DALLIS ................................................ 47 
HD Core .............................................. 37 

ALARM 
contacts ............................................... 82 

ALARM FORCE M2 ................................ 84 
Analog full-scale level ........................... 147 

B 

Battery Replacement ............................ 270 
Bay Server ............................................ 279 
Black Burst ............................................ 194 

C 

Card Parameters .................................. 200 
Cold Start .............................................. 251 
config.bfe .............................................. 116 
config.csv ...................................... 115, 152 
config.tcl .................................. 89, 114, 154 
Config-ID ............................................... 197 
Configuration - Admin HD....................... 20 
Connect Manager ................................. 178 
Connecting the System .......................... 72 
connectionlist.csv .................................. 116 
Console PSU 

air conditioning .................................... 68 
dimensions .......................................... 68 
grounding ............................................ 69 
installation ........................................... 68 
power ................................................... 70 
service ............................................... 272 
weight .................................................. 68 

Console Surface 
air conditioning .................................... 61 
dimensions .......................................... 60 
installation ........................................... 57 
keyboard driver installation ................. 65 
weight .................................................. 60 

Console Surface Redundancy ................ 29 
console_config.tcl ................................. 114 
Control HD ............................ See Admin HD 
Control Surface 
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systems overview ............................... 11 
Control Surface - panel replacement ... 277 
Control System 

flashcard replacement ...................... 261 
Copy Image .......................................... 188 
Core alias ............................................. 193 
Core Browser........................................ 105 
Core Parameters .................................. 193 

D 

DALLIS 
Admin HD.......................... 104, 130, 199 
air conditioning .................................... 47 
card installation ................................... 54 
card replacement ...................... 270, 271 
dimensions .......................................... 47 
electrical voltage ................................. 53 
frame installation................................. 47 
grounding ............................................ 51 
master board battery replacement ... 270 
power .................................................. 52 
service ............................................... 267 
systems overview ............................... 16 
weight .................................................. 47 

Data Recovery ........................................ 26 
Defective Parts - returns policy ................ 6 
Device alias .......................................... 200 
Diagnosing System Errors ................... 246 
Dimensions and Weight 

Console PSU ...................................... 68 
Console Surface ................................. 60 
DALLIS ................................................ 47 
HD Core .............................................. 36 

Download all data from remote HD ...... 235 
Download file ........................................ 235 
DSHS .................................................... 235 
DSP Redundancy ................................... 28 
Dual Self-Healing Star Active to Passive 

Switchover ........................................ 212 
Dual star topology .................................. 24 

E 

EBU ...................................................... 147 
Electrical Voltage 

Console ............................................... 71 
DALLIS ................................................ 53 
HD Core .............................................. 41 

Ethernet .................................................. 73 
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